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Introduction 

Chapter 1 
Introduction 

Welcome to TEMPRA SHOW and the world of multimedia! You can now orchestrate 
stunning multimedia presentations on your desktop PC (286 or higher). TEMPRA SHOW 
supports a comprehensive range of graphic image files, audio and graphics hardware, including 
sound boards, CD ROM, MIDI, animated .FLC or .FLI files, and video digitizing cards. 

TEMPRA SHOW is the desktop video/multimedia presentation companion to TEMPRA PRO 
and TEMPRA GIF imaging software. Your presentations can contain images created from an 
unlimited number of sources. Of course, TEMPRA PRO and TEMPRA GIF are the ideal 
sources. Images can be created, scanned, or video captured in TEMPRAPRO or GIF. TEMPRA 
SHOW allows you to put these images into motion, add sound, and place your text messages 
into a final interactive presentation or desktop video production. 

TEMPRA SHOW and Multimedia------
TEMPRA SHOW is a desktop video/multimedia development system and a menu-driven 
storyboard editor for presentations. This exciting new medium has been built to give you the 
power to express your thoughts in a simple and flexible manner. As a word processor is to 
scripts, TEMPRA SHOW is to multimedia with a full range of editing options. 

Mathematica, Inc. 1-1 
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TEMPRA SHOW lets you combine your images and computer graphics to 
create your own still-frame presentations (Sequences) with animation, 
titles, text, audio, and a variety of special effects. The presentations are 
made from a series of events. The events occur one after another, until there 
is an opportunity for user interaction. 

You also have the ability to use TEMPRA SHOW to allow interactivity 
between the viewer and the computer with the menu and button events and 
various hot keys. The viewer can make choices to direct themselves through 
your material using a keyboard, touch screen, or the mouse. 

The presentations created with the TEMPRA SHOW can be played back 
with a royalty free runtime executable module called TSHOWRUN or 
output to video for tape distribution. Use the Demo Builder to build the 
playback disks. The license to distribute complete multimedia presenta­
tions is included with your purchase of TEMPRA SHOW. You or your 
company may make copies of the presentation created with our software to 
distribute them for showing other PCs. If you use a third-party duplication 
service, you need an additional license. Call Mathematica, Inc. for details. 
Under no circumstances can you make copies of the TEMPRA SHOW 
authoring system for distribution to others. 

TEMPRA SHOW and Other Uses--
TEMPRA SHOW is for making your ideas clear to others. It is a software 
program that gives you the ability to get your message across to your 
audience by the use of images, sound, and text. No matter what you have to 
say TEMPRA SHOW helps you say it. Here are a few of the uses for 
TEMPRA SHOW: 

TEMPRA SHOW is used to make PC based "slide shows." Show your 
.PCX files on the screen with many special effects using the Screen Event. 
You can add text to the pictures, with the Text Event. You can add animation 
with the Sprite Event, or audio with the Audio Event. You can step through 
the slides by pressing keys, or automatically based on times. You can go 
forward and reverse through the slides, with [F9] and [FlO]. 

TEMPRA SHOW Reference 
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TEMPRA SHOW is used to prototype, or mock up, other programs. By 
using the interactive Button Event, you can let your users choose what they 
see next as 80 column text or graphics. IBMPRA SHOW is powerful 
enough to use in prototyping interactive video training. 

TEMPRA SHOW is used for promotional diskettes. You can send PC 
disks in the mail to market your product. IBMPRA SHOW can help you get 
your point across quickly and powerfully with the Demo Builder feature. 

TEMPRA SHOW is used to create interactive displays. Trade shows or 
store displays are more attractive if the user can make the choice he wants 
from a screen he sees. The branching features and touch screen compatibil­
ity make this an easy thing to do with IBMPRA SHOW. 

TEMPRA SHOW is a video titling system. When used in combination 
with a VGA to video output board you can record IBMPRASHOW text and 
titles on video tape. Please notice the Ticker effect in the Video Event that 
lets you run your text across the screen like a ticker tape. Some video boards 
allow you to put the titles over video coming through the computer. 
IBMPRA SHOW is a titling system with animation, and audio so it is a 
video production environment. 

TEMPRA SHOW is a DOS shell program. You've seen DOS menu 
systems for PC users who want to start programs without seeing the DOS 
prompt. IBMPRA SHOW can start any program and run it, if the program 
takes less than 500k to run. IBMPRA SHOW starts other programs from 
the graphics screen, so you can point to an icon for the program with the 
Button Event and run the program with the System Event. 

The uses for TEMPRA SHOW are too numerous to list here. If you need 
to express an idea IBMPRA SHOW is here to help you do this in the most 
powerful way you can imagine. Though you may feel adventurous and want 
to jump right into the program, please take the time to look through this 
section to give yourself a good feel for TEMPRA SHOW, and then do the 
tutorial at the end of this book before you start building your own 
presentations. 
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For preferred technical sup· 
port, become a member of 
our Multimedia Player Pro· 
gram. Call Mathematica for 
details. 
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System Requirements _____ _ 
To use TEMPRA SHOW, you must have: 

• An IBM compatible computer with an Intel 80286 (IBM AT) or better 
processor. 

• We recommend using Super VGA or better (640x480, 256-color, 
32,000-color, or 16.7 million-color) systems to run TEMPRA SHOW. 
It does, however, support EGA, CGA, and VGA graphics. 

• At least 540K of main memory. 

• DOS 3.0 or higher. 

• About 5.5 megabytes of disk space for TEMPRA SHOW program 
files plus space for any shows you create. 

• TEMPRA SHOW uses expanded memory that complies with the 
Lotus-Intel-Microsoft standard (LIM spec 4.0 or better). The more 
expanded memory you have, the faster your presentations run. If you 
don't have a memory manager on your computer, TEMPRA SHOW 
won't use the memory above 540K. TEMPRA SHOW supports the 
Windows Himem memory manager. 

Technical Support ______ _ 
Mathematica, Inc. provides technical support from 9 a.m. to 5 p.m. (EST) 
on normal business days. Our technical support phone number is 813-682-
1130. We are not open on weekends or holidays. An online HELP file is 
available in TEMPRA SHOW; you may want to consult this file before 
calling technical support 

TEMPRA SHOW is installed on your computer's hard disk by using the 
install utility supplied by Mathematica, Inc. 

1. Type CD\ and press the [Enter] key. This puts you in the root directory. 

TEMPRA SHOW Reference 



Mathematica, Inc. 

Introduction 

2. Place the disk marked "TEMPRA SHOW Disk I" into your A: drive 
(or B: drive). 

3. Type A: INSTALL (or B: INSTALL) and press [Enter]. This starts 
the installation procedure. 

4. Screen 1.0 briefs you on the installation procedure. Press any key to 
continue after you've read the instructions. You can cancel the instal­
lation at any time by pressing the [Esc] key. 

5. Screen 2.0 shows your system configuration, the DOS (Disk Operating 
System) version, EMM (Extended Memory Manager) version, EMM 
available and installed, RAM (Random Access Memory) available and 
free, and the input drive. Press [Enter] to accept the default. 

6. Screen 3.0 asks on which disk drive you wish to install IBMPRA 
SHOW. The default is the C: drive. You can change to another drive, 
or press [Enter] to accept the default. 

7. Screen 4.0 asks you to confirm the directory for IBMPRA SHOW. The 
default is the IBMPRA directory. We recommend using this default if 
you use or plan to use any of the IBMPRA image editing programs. 
This allows quick transfer between the IBMPRA products. Press 
[Enter] to accept the default. 

8. Screen 5.0 describes the video modes. Screen 5. 1 allows you to select 
your startup video mode. You should pick the screen resolution and 
color depth settings compatible to your video display card. If the 
computer doesn't support it, IBMPRA SHOW goes to the next lower 
resolution. If you 're not sure which display to choose, select 640x480 
256 colors. 

9. Screen 6.0 looks for the text editor you will use. The default is 
1EX1EDIT, which is a text editor supplied with IBMPRA SHOW. 
Press [Enter] to accept the default. If you choose another text editor, 
it must be a DOS application that supports ASCII text exports. Type in 
the first eight letters of the word processor (if you choose one other 
than the default). Press [Enter] to accept your selection. DOS 5.0 
owners can use the Edit program. 

10. Screen 6.1 is related to the previous one and confirms the directory of 
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the text editor you want to use. The default is the\ TEMPRA directory, 
where the TEMPRA SHOW text editor is located Press [Enter] to 
accept. 

11. We have provided a means for you to run existing programs that you 
already own from within TEMPRA SHOW (i.e., communications 
programs. In screen 7.0, you can set up this program to appear as a 
button on the TEMPRA SHOW graphic menu. The default is no 
program, so you would type in the first eight letters of the program 
you want to use. The word you type will appear on a button in 
TEMPRA SHOW that you can select. For instance, if you have a video 
capture card and want to use our TEMPRA Turbo Charger movie 
feature to bring video .FLC or .FLI files into TEMPRA SHOW, you 
could set the program to include a button for TURBO MOVIE on the 
graphic menu. If you have this feature, type in the empty box and press 
[Enter]. Screen 7.1 appears for you to enter the directory for the 
program you want to use. TEMPRA SHOW needs this information to 
create a batch file so you can transfer back and forth between the 
programs. 

12. Screen 8.0 asks if you want to view the READ.ME file after installa­
tion. Press [Enter] to accept the default to read it. The installation 
process begins, and the files are extracted on to the hard disk. 

13. After the files have been extracted, a screen appears asking if you want 
your AUTOEXEC.BAT (auto execute batch) and CONFIG.SYS (con­
figuration system) files automatically updated. Unless you 're familiar 
with DOS commands, press [Enter] to automatically update. If you 
want to change them yourself, the the Appendix 1 has descriptions of 
the environmental variables for TEMPRA SHOW. After the 
AUTOEXEC.BATandCONFIG.SYSfilesareupdated,theREAD.ME 
files appears. Installation is completed. 

14. To start TEMPRA SHOW with the changes you've set, first reboot your 
computer by pressing the Reset button or by pressing [Ctrl], [Alt], 
[Del] keys simultaneously. If you have a Video Blaster card, you need 
to run VBLSTDRV.COM before starting TEMPRA SHOW. To load 
the Video Blaster driver, type CD\ VBLASTER and then [Enter]. Then 
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type VBLSTDRV and press [Enter]. (Y oumustperform this step every 
time you reboot to run TEMPRA SHOW with the Video Blaster card.) 

15. Go to the TEMPRA directory by typing CD\ TEMPRA and pressing 
[Enter]. Start TEMPRA SHOW by typing TSHOW and pressing 
[Enter]. 

When you've completed the installation, place the disks in a safe location 
to prevent damage. 

Setting Environmental Variables __ 
When you installed TEMPRA SHOW, you were asked if you wanted to 
change your AUTOEXEC.BAT and CONFIG.SYS files. If you did, your 
path statement was changed to include the TEMPRA SHOW directory. 
TEMPRA SHOW also added some SET statements to your 
AUTOEXEC.BA T files. These SET statements create DOS environment 
variables. TEMPRA SHOW uses the DOS environment variables to 
establish its configuration every time you start TEMPRA SHOW. If you 
want to change these variables, check your DOS manual and see the 
troubleshooting section for a detailed description of the variables. 

Windows 3.013.1 Users ____ _ 
The program disk includes two files to aid installation under Windows 3.0 
and 3.1: TSHOW.PIF and TSHOW.ICO. TSHOW.PIF is the program 
information file, which specifies the required and desired memory to run 
TEMPRA SHOW under Windows. TSHOW.ICO is the TEMPRA SHOW 
Windows icon. You need a 386/SX PC or better to run TEMPRA SHOW 
under Windows. 

1. Open your Windows Program Manager. 

2. Select File from the command line. 

3. Select New from the pop-up menu. 

4. Select Program Item from the New Program Object menu. 

5. In the Program Item Properties menu, type TEMPRA SHOW as the 
description and c: \ TEMPRA \TS HOW. EXE as the command. 
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6. Select the Change Icon button. Type c: \ TEMPRA \ TSHOW. ICO 
Select OK twice to save the icon. 

7. The TEMPRA SHOW icon appears in the Windows screen group. You 
can select the icon to start TEMPRA SHOW from Windows. 

Using the Mouse _______ _ 
TEMPRA SHOW is designed to work with a two- or three-button mouse. 

The left button is the Select button. The right button is the Cancel button. 
Select ·'']'~{~\ We use these terms frequently in this manual. If you are new to the 

''''· ... / ··:::::: ~:=:%;:: ) computer and mouse operation, please review your mouse reference 
4fl,f:irnit:t .. ·· t_;· manual. We recommend proficiency at using a mouse to use this 

,f::,:,:,:,:,:,:,:,:,:,~~,,.,,,,,,,,.,.,,,,.. Cancel . . . 
~Jtl@W'' · . · program to its full potential, although you don'thave to have a mouse 

"'%jf to use TEMPRA SHOW. 

Using the Keyboard-------
You can use certain keys on the keyboard to perform mouse tasks. The table 

at the end of Appendix 2 describes the keys and functions they 
/.:~~$.Ji~· -·:~ft~;-;,i perform if pressed when you use the graphic interface 

:<,c-i~=ii%Ggg;m~t~:; ... ,.,.,
7
.".L ;i. ,, :,"t~_4f (Graphic) or text-based interface (Workform) . 

.......... ~:.;·:·:::~:=;:~::z::::~:3::;1 

Some of the most common keystrokes used are the [Esc] , F3, F5, and F6 
keys. 

[Esc] Stops a sequence in between lines. 

[F3] Using the mouse, place the cursor over the field on the event 
controller you wish to edit and press [F3] , not the mouse button. 
You can now type directly into the field the necessary information 
without calling on the menus for that event. 

[FS] Press this key to play a single line in the sequence. 

[F6] Press this key to start and play the sequence from the current line 
to the end of the sequence. 
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Menu 
Conventions 

TEMPRA SHOW has an intuitive GUI that sets it apart from other multimedia programs. This 
chapter describes the terminology and conventions used in the TEMPRA SHOW graphic 
interface. 

Terminology ____________ _ 
Throughout this manual, conventions and functions are described in terms of making presen­
tations. These descriptions contain words and phrases unique to the TEMPRA SHOW 
authoring system. The following list of terms and definitions should assist you in creating 
presentations. 

TEMPRA SHOW is a line based authoring system. A line is a single command telling 
TEMPRA SHOW what to do, when to do it, and how to do it. Each line is made up of an event 
type and its related fields. Every time you create a line, you are asked to choose from a variety 
of events. An event might be a graphic, audio, background, video, text, or other selections. The 
related fields for each event include its file, speed, position, color size and other discriminating 
information relevant to specific fields. 
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Several lines together are called a sequence. Essentially, a sequence is your 
presentation. The default setting of a sequence in TEMPRA SHOW is 500 
lines. If you want to create a sequence that exceeds 500 lines, you can chain 
multiple sequences together so they will run as one sequence. At the end of 
the chapter is a study in line construction that illustrates TEMPRA SHOW's 
intuitive sequence authoring system. We recommend that you become 
familiar with how TEMPRA SHOW operates by reviewing this section. 

Graphic User Interface (GUI) 
The graphic environment of TEMPRA SHOW consists of a Menu Bar 
running across the top of your screen and an Event Controller running 
across the bottom of your screen. 

Menu Bar 

~~···---~UTOR -·· ········ 
The Menu Bar allows you to work with disk files, exit TEMPRA SHOW, 
and move to other programs such as TEMPRA GIF or TEMPRA PRO. It 
also allows you to use the on-line help system. The following buttons 
(selectable areas) make up the Menu Bar: 

Exit 
The Exit button (or [Ctrl]-Q) takes you out of the TEMPRA SHOW 
program. Before you exit to DOS, you are asked if you want to save 
the current sequence, then you are asked to confirm the exit to DOS. 

Use the mouse to select the buttons. 

Remove Menu 
fji1 The Remove Menu button removes the graphic menus from the top 
~ and bottom of the screen so you can see the entire viewing area of 

your sequence on the screen. To return to the menus, press the 
Cancel button on the mouse. Each popup menu has a Remove Menu button. 

TEMPRA SHOW Reference 
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The Clear button clears images from the screen and changes the 
screen to black. Clearing does not affect your line or event in 
anyway, but lets you sample different effects without having to 

replay the lines up to that point. This is very useful when you are testing 
various wipes or speeds on the same image. 

Title 

ITLITOR mm OO ''O''mm : oo mOOOOOO,OOOJl ~~1;.::~ 
creating or editing. By selecting the area inside the box with the mouse, you 
can rename your sequence. If you want to save the sequence under the new 
name, you must select Save Sequence from the Disk menu. Your old 
sequence will not be erased. 

Disk 
The Disk button opens a menu containing various disk 
functions, such as loading and saving sequences, Demo 
Builder, and other disk-related functions. 

New Sequence 
This menu option lets you start and name a new sequence. If you are already 
working from a sequence and select New Sequence, you are asked to name 
it. If you do not choose a name, TEMPRA SHOW clears all the lines of your 
previous sequence. To avoid confusion and lost sequences, always give a 
new sequence a unique name. 

Load Sequence 
This menu provides a list of all the sequences that are available to load and 
run. The files are automatically saved in the <SEQ> sub-directory. The path 
to locate other sequences can be changed by using the Path menu. 
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Save Sequence 
This command saves your sequence to the hard drive in the <SEQ> sub­
directory. If a sequence with the same name already exists in the directory, 
you are asked if you really want to write over the sequence. If you select 
Rename, you are prompted for a new name. Both the previous version and 
the new version are saved to disk. 

Rename Sequence 
This feature allows you to rename a sequence at any point. The previous 
version is not erased unless you give it the same name. 

View Directory 
Selecting this option lets you view the path of the current directory. 

Delete File 
This deletes any file you specify. 

Print Sequence 
This feature allows you to output your sequence in a number of forms. 
LPTl and LPT2 provide access to hard copy versions like a script. Printing 
to video allows you to print your sequence to any SONY video recording 
device that supports the VISCA protocol, such as the SONY Vbox or 
V deck. This provides you with another form of output for your presenta­
tion. With this feature, your presentation can be transferred to videotape. 

Save Picture 
This is a screen capture feature that saves any images on the screen at that 
moment in a .PCX format. You need to provide a name for the screen file 
and then save the screen. This is useful for printing images of each line for 
a hard copy revision of your sequence. Save Picture will not capture the 
GUI or other images outside of TEMPRA SHOW. 

Demo Builder 
This feature allows you to put your presentations on distributable media. 
The viewer does not need the original TEMPRA SHOW program to view 
your presentation. Refer to the section on "Building Distributable Multi­
media Presentations." 
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Help 
11lis option lets you access an online context-sensitive help file provided 
with the program. Help information is listed by topic. 

Quit ([Ctrl-Q]) 
11lis exits TEMPRA SHOW to DOS or Windows. You can also use the Exit 
button or [Ctrl-Q]. 

Path 

~~11111111111111111 ~~::~~~~p:~~::~:~::~;:~ ~h~~e;~~r!:{~~ 
IBMPRA SHOW onto your hard disk, it creates directories 

to hold specific types of files. If you choose to change this directory setup, 
you can use the Path button to designate different paths. If you do change 
the paths to find your image files, for instance, be sure that all of your images 
are located in that directory. Otherwise, TEMPRA SHOW cannot call on the 
images as needed and the sequence will fail. 

TEMP RA 
The TEMPRA button starts the TEMPRA PRO or 
IBMPRA GIP image editors from within TEMPRA 
SHOW. Using the TEMPRA button allows you to 

enter and exit IBMPRA PRO or TEMPRA GIP while running TEMPRA 
SHOW. Thus, the image editing and presentation programs interface 
directly for quick accessibility. 

Word 
.,..,.... .............. ...-....,. The Word button starts your DOS text editor. If you don't 

have a text editor, you can use the one supplied with 
t:!!!!!!!!!!!!!!!!!!!!!!!!!!!!l!!I 1EMPRA SHOW. The text editor you use must be able to 
edit files in ASCII format. (ASCII format doesn't have codes in it to 
designate special format commands.) MS-DOS 5 .0 owners can use an editor 
called EDIT. EDIT produces ASCII files compatible with TEMPRA 
SHOW. 
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Audio 
The Audio button is for recording audio to disk for 
playback during your show. If you use a dedicated sound 
card such as the Sound Blaster, you can record speech or 

produce sophisticated sounds on your hard drive. 

Work ([Ctrl-G]) 
The Work button (or [Ctrl-G]) stands for "Workform, "a 

L. .. ...... ll text-based spreadsheet for creating and editing sequences. 
i''"'·'·'·'''*"·'''''·''''''' You can use the Workform as an alternative to the graphic 

interface, or move back and forth between the two interfaces. The Workform 
screen displays the individual events in the sequence so you can see 
multiple events on the screen at one time. (The graphic menu displays 
events line by line). 

Help ([F1]) 
;~===,~== The Help button brings a Help index to the screen. Use the 

'' :lJ.t~ mouse to move among Help topics and select the one you 
:< '"'''>:-:''''''''~ need. To access context-sensitive Help information, go to 

the Workform and place your cursor on the event you wish to get help 
information on and press the [Fl] key. 

External Program 
You can designate a button to appear for a program you use frequently and 
access that program through TEMPRA SHOW. It can be any program of 
your choice. This is set during installation. 
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The Event Controller contains the fields for the lines that make up a 
sequence. Information appears in the field boxes automatically, based on 
your selections from the pop-up menus as you create lines. 

Menu Position 
fii1 The Menu Position button changes the vertical position of the Event 
lM Controller. (It doesn't affect the Menu Bar.) When you select the 

Menu Size button, the Event Controller becomes a ghost box. When 
you move the mouse up and down, the Event Controller moves up and 
down. You can position the Event Controller so only certain portions of it 
show on the screen. 

Play Line ([F5]) 
riiidl The Play Line button plays only the line displayed on the Event 
,_ Controller. The menus remain on the screen while the visual 
events play in the display area. This allows you to review the event and make 
changes as necessary while creating the sequence. 

Play Sequence ([F6]) 
The Play Sequence button plays the sequence starting at the 
current line. The sequence plays in the display area between the 

Menu Bar and the Event Controller. To play the sequence with a full screen 
display and no menus, press [F6]. To play the sequence from the beginning, 
rewind to Line 1 using the Line Scroll Bar. Press [Esc] to interrupt playback 
of the sequence. If the Labels and Nexts are not matched, TEMPRA SHOW 
will alert you and the sequence will not play. 
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Insert Line ([Ins]) 
fiiijJ The Insert Line button inserts a blank line in front of the current 
,_ line and makes the current line the next one in the sequence. This 
pushes all subsequent lines down one. You can use the Insert Line button 
to make room for an event you want to add. 

Delete Line ([Del]) 

U:J:::1 :J:j:·I ~:n~e~:t~~:~~~~~~~ :~e;~~!: ~;~~gli~~/;~~u::~b~~~~ 
delete the line and its events. You can cancel the deletion. 

Line Scroll Bar 

The Line Scroll Bar moves through lines in the sequence (similar to 
rewinding and fast-forwarding). The arrow buttons on each side of the Line 
Scroll Bar move the sequence one line at a time. You can place the cursor 
inside the Line Scroll Bar to the approximate location of the line you want 
and press Select to move to that position. When you move through the lines 
in the sequence, the fields below display the contents of each line. You can 
also "rewind" and "fast forward" using the Line Counter. 

Line Counter 

ll~illlliillilfit~ uuu uuul ll 
The Line Counter displays the current line number. 
As you move the Line Scroll Bar, the Line Counter 

changes to reflect the number of the current line. The events in the current 
line are displayed as you select each new line. You can move to a new line 
by selecting in the Line Counter and then typing the line number you want 
in the menu that pops up and pressing [Enter]. The Line Counter displays 
Line 1 when you first run TEMPRA SHOW. 
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The Label field is used to identify an event or 
line in your show. Labels are primarily used for 
branching. Each label must have a unique name. 
TE1\1PRA SHOW distinguishes between up­
per and lower case, so the words "Start" and 

"ST ART' and "start" would be considered three differentlabels in TE1\1PRA 
SHOW. 

Type 

File 

The Type field displays the kind of event that 
occurs when the line is executed. The type 
determines if the event is video, audio, a 
sprite, text, or another event. See the unit on 
type events. 

If an event needs a file, like a screen event, 
the menu with the possible choices appears. 
Select the file you want. Some events, like 
BColor do not need a file. In this case, the 

file menu is automatically skipped. 

Method 

TIMES30B 
The Method field displays how an event 
will occur. The choices available depend 
on the event type. Text events have a selec­
tion of fonts as the Method, while Screen 

events have a selection of wipes. 
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Speed 

Sp/Dp is an abbreviation for Speed and Display. This field 
controls either one or both of these features as they are needed 
by a particular event. 

The Speed field controls the velocity at which certain events appear (it 
regulates the time you designate to an event). The range of speed is 1 
(slowest) to 99 (fastest). For instance, the speed determines how quickly or 
slowly a wipe takes effect or video is played. If your sequence is displayed 
on a computer that is faster than the computer used to create the it, the 
sequence displays quicker. 

Display 
The Display field determines what happens to an event in relation to a 
subsequent event. There are three ways of leaving the elements of your 
presentation on the screen: Temporary, Permanent, or Erase After Display. 
Permanent events become a permanent part of the screen. The Erasing 
events erase themselves and all Temporary events. This allows you to 
control what stays and what goes on the visible screen. Permanent ones stay, 
Erasing ones go, and Temporary ones can stay or go depending on the event 
that follows. 

Parameters 
The Parameters 
field contains in-

~-~~L!~~£.-~~!!__~~~----·----------··-- formation about 
the method used with a particular event, such as the colorof the background, 
the type of display mode you' re using, or the placement of video or graphic 
on the screen. The contents of this box change depending on the type of 
event. Parameters are set automatically, but can be manually changed. 
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The Wait field sets a delay between 
the lines in a sequence or stops the 
sequence for a specified time or for a 
key or mouse button to be pressed. 
You don't need to wait between lines 

and can move automatically from line to line. The default is set for no 
waiting time. 

Next 
The Next field tells TEMPRA SHOW what Label to 
look for and indicates the next line to be executed. The 
contents of the Next box correspond to the contents of 
the Label box. In order for TEMPRA SHOW to move to 
a line named in the Next box, the contents of the Label 

box must match exactly. If the Next box is empty, TEMPRA SHOW moves 
to the next line in the sequence. 

Creating Distributable 
Multimedia Presentations ____ _ 
You can use the Demo Builder button on the Disk menu to save a sequence 
you create as a self-running multimedia presentation for viewing by others 
who don't have TEMPRA SHOW. 

1. To create a copy of your presentation, select the 
Disk menu on the TEMPRA SHOW Menu 
Bar. 

2. The drop-down menu displays functions you 
can do in sequences. The Demo Builder button is 
not visible at first, so you need to scroll down the 
menu by placing the cursor in the elevator bar and 
pressing Select (left mouse button) or by pressing 
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the down arrow button beneath the elevator bar. Select the bar labeled 
Demo Builder. 

3. A menu pops up requesting the destination path (the default is the A: 
drive). 

4. After you determine the path, the Demo Batch File menu pops up for 
you to type the name you want to give the presentation. The default 
demo name is "DEMO." You can change the name by typing in the box. 

5. TEMPRASHOWautomaticallycreatesthedemofileforyou. Youmay 
need to put new diskettes in the drive as the demo is being built. You 
will be prompted to change diskettes as necessary. The number of 
diskettes you need depends on the number and size of graphics in your 
sequence. The demo is actually a batch file to start the sequence and the 
files you used to build it. 

6. To run the demo file (your presentation) on another computer from 
DOS, copy the contents from the disk(s) built by the Demo Builder to 
one directory and type the name of the presentation. 
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Making Events~~~~~~~~-
When working with the GUI, all lines 
are constructed through the Event Con­
troller. This is the set of "buttons and 
sliders" on the bottom-half of the 
screen. Using this GUI, we will con­
struct one line to help you understand 
why TEMPRA SHOW does what it 
does. Samples of the different line 
constructions are in a later section of 
this manual. 

TEMPRASHOWhasanintuitiveGUI. 
It leads you through the construction 
of a line automatically when you write 

every line the first time. When you start a line in TEMPRA SHOW, you 
usually select the Type field first. It is highlighted in red. The menu for the 
type field appears below. 

In this menu, you are asked what 
type of event you want to take place 
on this line from 21 possible event 
choices. Depending on what you 
choose at this point, TEMPRA 
SHOW determines whatotherfields 
(in the File, Method, Sp/Dp, Pa­
rameters, and Wait For) are needed 
to complete the line. On each field's 
pop-up menu, TEMPRA SHOW 
gives you a list of possibilities to 
choose from. 
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Building a Sample Line in a Presentation 
Tilis is our line example. (Tilis is only one of many possible examples.) 
When you start TEMPRA SH OW for the first time, the GUI appears and the 
Type field box is filled with a red highlight. When you are not branching, 
this is where you start most of your sequences. For this sample, we will start 
with the Label field and build a screen event to bring up an image. 

Using the mouse, move the cursor over the first box, called Label, on the 
Event Controller. Press the left mouse button to select that field. A dialogue 
box appears on your screen. You may type a label into this box or leave it 
blank. For this sample line, press [Enter] on the keyboard to leave it blank. 
The Label box on the screen changes from blue to white and the Type menu 
appears on the screen. 

Select the screen option to show a graphic on the screen. A list of potential 
image files appears for you to choose from. If you have not scanned, 
captured, or painted any images, this window will not list anything. For this 
example, we will use the tutorial images provided with the program disks. 
Since the program default is .PCX the tutorial files will be listed. 

Select a .PCX image file from the 
list. A wipe menu now appears. In 
this example, the Wipe menu deter­
mines how our image will come on 
to the screen. Select Dissolve. Scroll 
down the menu until you see that 
wipe. Dissolve is used to describe 
that this wipe brings your image 

onto the screen in a random block pattern. 

After you select the type of wipe you want to use, the 
Speed/Display (SP/DP) menu appears. From this menu, 
you determine the speed at-which this image wipes on the 
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screen. The up and down arrows near the bottom of this menu make the 
speed slower (1) and faster (99). You can also select the window where the 
numbers appear and manually fine tune your speed. Because all screen 
events are permanent (meaning they will stay on the screen until they are 
replaced by another visual event), the Permanent, Temporary, or Erase 
buttons are inactive. To move to the next menu, select "OK." 

Another menu appears on 
the screen asking how to 
show the image on the 
screen. You can show the 
image "As Is," ''Positioned," 
or "Scaled." This is part of 
the Parameters field. De­

pending on the choice you make, the parameters field shows you these 
options if they apply. Select "As is." 

This tells TE.MPRA SHOW to place the image on the screen exactly as it 
would appear in a paint program at 100% size with no special positioning. 

The next menu is the Wait menu. In this menu are four choices that tell 
TE.MPRA SHOW how to proceed to the next line. Choose "Don't Wait." 

The final menu to appear is the Next menu. This is used to control branching 
and is the counterpart to the Label (which we did not use) We will not use 
this event on this line so press [Enter]. 

You have now completed one line. On your screen is Buzz, our TE.MPRA 
mascot. To see your line run again, clear the screen by clicking on the clear 
screen button in the upper left corner of the GUI, select the line counter, go 
to line 1, select the "PLAY LINE" button. 

Each line in TE.MPRA SHOW is made the same way. The intuitiveness of 
the lines, events, and fields makes TE.MPRA SHOW a fun and creative 
program to use. Enjoy! 
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Chapter3 
The 
Workform 

The Work.form is an alternative spreadsheet style interface you can use to create and edit 
sequences. It contains all the same functions of the GUI. When you look at a sequence in the 
Workform, you'll see it's composed of lines and columns. Each column contains a specific 
field. There are 8 fields in the Workform. These are the same fields you see on the GUI. Most 
of what you need to create and edit sequences with TEMPRA SHOW can be selected from this 
work.form. 

MenuEnuy~~~~~~~~~~~~~ 
Create From the Menus 
It is possible to create and edit sequences by using the menus and entering no more than the 
sequence name from the keyboard. You must start in the Label field or the Type field for the 
automatic prompting to continue across the Workform. If you don't want to fill in a response 
to the Label or Next request, just press [Enter]. 
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Edit From The Menus 
Move the field cursor over any of the fields and press select or [Enter]. The 
menu and/or prompt originally used to create that field entry appears. Some 
fields have information that is developed through responses to a series of 
menus or prompts. When this is the case and you want to change one step 
in the series, press the [Esc] key in response to the menus/prompts whose 
entries you don't want to change. This way you can change the end position 
and keep the start the same for Sprite movement, and so on. Some Events 
have special editing menus that allow you to change only one aspect of the 
Event, so pressing [Esc] is unnecessary. 

Keyboard Entry _______ _ 
It is possible to Create and Edit sequences without most of the menus. If you 
are familiar with the system you can type Event types, file names, param­
eters, etc. directly from the keyboard. 

Create from the Keyboard 
If the field is empty, position the cursor over the field and start typing. Press 
[Enter] when the field is finished, and you get the field cursor back. Once 
you are editing you can go on right to the next field. You can go up lines and 
down. When you press [Enter] you return to the field mode where you can 
use the mouse and menus. 

Edit from the Keyboard 
If there is information in a field, you may want to modify the field without 
changing everything in it. In this case press [F3]. Now use the right and left 
arrow keys to move the small text cursor under the things you want to 
change, and your keyboard entries are put into the Workform. The Home 
key (numeric key "7") positions the cursor at the first character of the field. 
The End key (numeric key "1 ") positions the cursor at the end of the field. 
Any keyboard entry editing you do is in overwrite mode until you press the 
[Ins] key. This yields a larger cursor and put you in the Insert mode. By 
pressing the [Ctrl] key and the right arrow you can go right word by word, 
then field by field. By pressing the [Ctrl] key and the left arrow you can go 
left word by word, then field by field. 
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Using Blocks of Events ____ _ 
Using blocks allows you to insert, copy, move or delete lines of Events as 
you see fit while you are on the Workfonn. This is a way to make and save 
templates that you can use as many times as you want, in any sequence you 
want. As you become more familiar with TEMPRA SHOW, this is 
something that will be a time saver for you. 

Block Operations 
You can cut and paste part or all of your sequence to other areas or other 
sequences by making blocks. These commands can be found on the disk/ 
edit menu by hitting the [Esc] key in the Workfonn. You can also save 
blocks to files and load them into other sequences. Blocks are column 
oriented so you can cut and paste sections of event lines, or columns from 
many lines. 

Marking Blocks ([F7] - [FB]) 
Use the [F7] key to mark the start of a block. Use the [F8] key to mark the 
end of a block. To mark the whole line move the cursor to the Label field, 
press [F7] then move to the Next field, press [F8]. 

A block cannot be used as a sequence. Blocks are short sequences you use 
repeatedly in different sequences. Blocks can be moved and copied to 
different areas of the same sequence and even from sequence to sequence, 
provided the same file infonnation is present for another sequence's Path. 

Mark Block Start ([F7]) 
This menu selection is designed for Mouse users who want to run TEMPRA 
SHOW without using the Function keys. To designate the beginning of a 
block of event lines, choose this option from the disk/edit menu. The block 
then starts where the field cursor sits on the fonn. Use [F7] from the 
keyboard for the same effect. 
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Mark Block End ([FB]) 
This menu selection is designed for mouse users who wantto run TEMPRA 
SHOW without using the function keys. To designate the ending of a block 
of lines, choose this option and the block ends where the field cursor sits. 

Copy Block ([Alt-CJ) 
You can copy marked blocks throughout your sequence. The block is 
copied, starting at the event line where the field cursor sits and either 
inserting its way into the sequence or overwriting currently existing lines 
according to your choice. As long as you do not unmark those lines, you can 
keep doing this. Use [Alt-C] or the Edit menu selection to do this. 

Move Block ([Alt-M]) 
You can move marked blocks anywhere in your sequence. Use [Alt-M] or 
the Edit menu selection to do this. The block moves, starting at the event 
line where the field cursor sits and either inserting its way into the sequence 
or overwriting currently existing fields according to your choice. Once a 
block is moved it has to be remarked if you want to move it again. 

Delete Block ([Alt-DJ) 
When you have a block of event lines that you want to clear off the 
Workform, mark them and use the [Alt-D] or the Edit menu selection. 

Unmatk Block ([Alt-U]) 
Once you have a block marked you can unmark it with [Alt-U] or the Edit 
menu selection. 

Load Block ([Alt-LJ) 
When you have saved portions of a sequence as a block you can load them 
back in from disk to any sequence you have. They load in starting where 
the field cursor sits. Use [Alt-L] or the Edit menu selection. Then choose 
the block you want from the directory menu. 

Save Block ([Alt-SJ) 
When you have Event lines that you want to store on disk in their own files 
for safety or for loading into other sequences, you can do this by saving 
them with this option. Mark them, then use [Alt-S] or the the Edit menu. 
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Chapter4 
The 
Common 
Fields 

The elements presented in this chapter are used in every single line or event. Because they are 
common, they are compiled into one chapter and mentioned in detail only once in this manual. In 
the line construction sections, they will only be mentioned briefly. These elements are used in the 
same manner for every event. These commands are simple to understand and use. In the case of 
Label and Next, they are also very important. 

Label and Next_-----------

~~ 
Mathematica, Inc 

Label and Next are commands used when you branch. 
Branching is part of interactive presentation and is not 
necessary on every line. Use branching to bypass lines and 
execute a line that is not in numerical order. The Label field 
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occupies the first position on the Event Controller though it may only be used 
10 percent of the time. Very simply, the Label field identifies a line. This 
"label" is important because when you want to find a specific line, TEMPRA 
SHOW looks for the Label used to designate it. You designate this label in the 
Next field, the last position on the Event Controller. When an line is completed, 
the last thing TEMPRA SHOW looks at is the Next field. If there is a label­
name in it, TEMPRA SHOW searches for the line with thatlabel and runs that 
line instead of proceeding to the next line in numerical order. Branching can 
make your presentations interactive and exciting by giving the viewer choices 
and a feeling of participation in the sequence, not just an observer. 

Branching commands are used in the tutorial supplied with this program. 
When you were asked to name the TEMPRA mascot and were given three 
choices, the type of reaction the program gave was dependent on your answer. 
If it was wrong, TEMPRA SHOW branched to a line that told you it was 
wrong and branched again back to the question. If you got it right, TEMPRA 
SHOW branched to aline that said "You're right!" It then continued to the next 
line in the sequence and proceeded to the end of the sequence. 

Label 
Use the Label field as a line identifier for branching. Enter a name for this line 
in the Label field after selecting that field. This is optional, you do not have 
to give every line a Label, but if you everexpectto Branch to this line you must 
label it. Either type in a unique name (like "Start") and press [Enter] to create 
a label for the line, or just press [Enter] to leave this label blank. When you 
use labels, every label must be unique or TEMPRA SHOW will not be able 
to find the appropriate line to branch to and the sequence will fail. 

Next 
The Next field is the counterpart command to Label. The Next field tells 
TEMPRA SHOW what line to branch to next. That is why it comes at the end 
of each line. Unless you are branching, you can leave this field blank. 
TEMPRA SHOW will automatically go on to the next line in numerical order. 

If you are branching, put the label of the line you want to branch to in the Next 
field. When the line has completed running, it immediately jumps to the line 
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in the sequence with that label. This is why it is so important to give each line 
a very unique label. If you do not do this, and you have two lines with the same 
name, the sequence will fail because of conflicting line identifications. 

Timeout, and Ask For Label. 

Don't Wait 

The other most common field in 
TEMPRA SHOW is the Wait For 
field. This field controls what hap­
pens at the end of each line. There are 
four possible options for you to 
choose from when you reach the Wait 
For field: Don't Wait, Any Key, 

By selecting this option, you are telling TEMPRA SHOW to proceed to the 
next appropriate line. There will be no delay in the sequence. Don't Wait is also 
the default setting for this field. By not selecting anything when you getto this 
field, you are actually selecting "Don't Wait." 

(Wait For) Any Key 
When you select this option, you are telling TEMPRA SHOW not to go on to 
the next line until someone hits any key on the key board. It is a good idea to 
prompt them with a TITLE event just before this line. Once a key pressed, the 
sequence will proceed to the next appropriate line. 

Time Out 
This option stops the sequence for a set amount of 
time. When you select this option, a menu appears 
and you are asked to enter the amount of time you 
want to pass before it moves on to the next appropriate line. This scheduled 
delay can be very useful for keeping certain graphics on the screen for 
guaranteed periods of time. You can break out of a time out with a keypress. 
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Ask for Label 
If during your presentation, you need to branch out to a specific line and do 
not want to use a button event to do so, use this Wait For option. Selecting this 
option will place a prompt on your screen when the line is executed asking for 
a specific Label to be entered. At this prompt, entering a label will branch the 
sequence to this specific line and the sequence will run from that line. If nothing 
is entered, the sequence continues. 

SP/DP {Speed/Display) ____ _ 
Another common field is SP/DP 
(speed/display).Dependingontheevent 
type, you will be asked how fast you 
want (or don't want) something to 
happen or how you want it displayed. 

Speed 
When you are asked to select a speed, 

a menu appears with a prompt. By entering a number 1through99 (1 being 
the slowest, 99 the fastest) you will determine how fast a screen wipe happens, 
for example. The speed does not increase or decrease the speed of your 
computer. Delays caused by your hardware are not improved by using a faster 
Speed setting. If your sequence is displayed on a computer that is faster than 
the computer used to create it, the sequence runs quicker. 

Display 
The display field determines what happens to an event in relation to the event 
chosen. There are three ways of displaying the elements of your presentation 
on the screen: Temporary, Permanent, or Erase after Display. When 
selecting permanent, you are making that element a permanent part of you 
screen throughout the entire sequence. Erasing events erase themselves and 
all Temporary events. This allows you to control what stays and what goes on 
the visible.screen. Permanent ones stay, Erasing ones go, and Temporary 
ones can stay or go depending on following events. 

Some events require you to make a decision on only Speed or Display while 
others require decisions on both. 
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The Event 
Types 

Types~~~~~~~~~~~~~~ 
This field is very important First, it determines what sort of event is going to happen in your 
presentation (like see a visual, play music, or hear a sound). Second, it predetermines what sort 
of information is needed to satisfy the requirements of events you've selected. It will do this 
automatically if you are writing a sequence for the first time. If you are going back and editing a 
line, you will need to manually adjust the appropriate fields that affect that line. 

The types of events you can select from this menu are Screen, Sprite, Text, Title, BColor, Menu, 
Button, System, Chain, 80Mode, 80Text, 80Win, 80Menu, 80Butn, Video, Global, Draw, Music, 
Audio, MIDI, and CD ROM. 

Each of these events indicates what kind of line this is going to be. For the most part, the name of 
the event is indicative of what will actually happen on the screen or during the sequence when this 
line runs. A screen event will have something on the screen, a music event will play music, an audio 
event will play sounds or voices, etc. 
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Screen 
When you click on the type field, the first selection on the type menu is the 
screen event. Screen events are the placing of images on the screen that are 
created in TEMPRA PRO or GIF or another paint program. Titls is the merely 
a picture placed on the screen. Other things can happen simultaneously while 
this image is on the screen like music, voice overs, text or titles, and even other 
screen events. Screen events can be as large as the physical size of the screen, 
scaled to a size you specify, or positioned on the screen for effect. There are 
also a number of ways they can be brought on to the screen. You can also 
determine how long they will stay there. A Screen remains on your video 
monitor until another Screen or BColor (Background Color) Event replaces 
it. 

Sprite 
A Sprite is a small picture that can "float" over other pictures or stay in one 
place. You can draw an image in a paint program, like TEMPRA PRO, save 
it as a .PCC graphic, then use it as a Sprite, much like the "pointing hand" in 
the tutorial. Sprites are used when you want to point to something directly or 
show motion. 

Using a Sprite as a pointer or selector can add a very nice touch to your 
interactive presentations. When using a Sprite to show motion, a starting point 
and an end point are selected. The SPRITE will then "float" from point to point 
across the screen. 

Text 
Text events can be displayed in any graphic mode, font, orcolorovertheimage 
or with a frame. The text must have been created with a text editor in non­
document mode (ASCII). 

Title 
A Title event is a rapid display ofa word or words not exceeding 10 characters. 
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BColor 
BColor events are background colors that wipe on the screen. Your choice of 
colors ranges from 16 to 32,000, depending on the display mode. 

Menu 
Menu events allow the viewer to select options, specified by you, and branch 
to other parts of the sequence. 

Button 
The Button events let you create user interactivity through branching. 
Branching allows interactive control in sequences. If the viewer is given the 
choice of seeing one of many possible answers to a question, a selection 
prompts the system to branch to the material chosen. By using the Next and 
Label features, it is possible to branch to anywhere from anywhere within a 
sequence. 

System 
System events allow you to use DOS programs, batch files, and commands in 
mid-sequence, often without affecting the visible screen. 

Global 
Global events set the conditions for the entire sequence and reset previous 
global events, until you override the global within an event. For instance, you 
can set a global of .PCX files for screen images. All images files will have a 
.PCX extension. You won 'it see any images files with a. TGA extension until 
you use a Global event to select that file format. 

Draw 
Draw events let you create basic shapes, like circles or squares, either filled 
or unfilled. There is also a freehand tool. You can use the shapes to contain 
text, graphics, or other image files. 
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Music 
Music events control sound from the basic speaker found in every PC. No 
special hardware is needed to create Music events (you can create music using 
the keys on the keyboard as piano keys). 

Audio 
Audio events let you play or record sounds on the hard disk using a Sound 
Blaster card or any other supported card. 

Midi 
Midi events let you play back audio created as MIDI files (you can't record 
Midi in TEMPRA SHOW). In order to play MIDI files, you will need an 
appropriate driver for your sound board. (See the READ.ME or on-line Help 
file for installaQ.on instructions. 

CD ROM 
CD-ROM events let you play sound from standard CDs or CDROM. The 
controls provided in TEMPRA SHOW allow you to position the CD-ROM 
head to the correct position and then play the music starting at that location. 
You can select the range of music on the CD you want to play. This provides 
complete control over the starting and ending points for your music. 

Chain 
Chain events connect one sequence to another. Since a sequence can contain 
a maximum of 500 lines, Chain events let you create presentations as long as 
you need by chaining several sequences together. 

BO Mode 
80Mode events switch the display from a graphics mode to an 80 column text 
mode. 

BOText 
80Text events are the same as regular Text events, except in an 80 column 
format. No font select is available. 
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BO Win 
80Win events are much like sprites, except they use text characters rather than 
graphics. 

BOMenu 
80Menu events are the same as regular Menu events, except in an 80 column 
format. 

BOButn 
80Butn events are the same as Button events, except in an 80 column format. 

Video 
Video events serve a multitude of functions. First, they can bring animation 
to sequences with video or graphics that have been saved as flick (.FLI or 
.FLC) files. IBMPRA SHOW supports Autodesk Animator, AnimatorPro, 
and Studio 3D flick files, as well as video flick files created in Cinemaker. 
These are upto 50 frames of video saved to the hard disk. 

The second function of the Video event is to control or set the mode of your 
video display. Many times, when you are putting a sequence together, not all 
of your screen graphics may be in the same resolution format. You may have 
8-, 16-, or 24-bit images you may need to use. IBMPRA SHOW's default 
video mode is 640x480x256 (8-bit). This means you can only use 256-color 
images in this mode. If you want to use a high-color image, you can make a 
line changing the video mode to 24-bit, make a line for your image, and make 
another line changing the resolution back to your original 256.You can also 
set the display mode, fade images in and out, cycle colors, animate text, open 
video windows, and load palettes using the Video event. 

VCR 
Used in conjunction with a Video event, this event lets you bring recorded 
video into your presentations with the SONY VISCA protocol. With a SONY 
V deck, your computer can control access to any Hi-8 footage segments. With 
a SONY Vbox, your computer can control any SONY video device (Hi-8, 
8mm, or VHS) with the VISCA protocol. Camcorders, VCRs and high­
quality video decks are yours on call for presentation video. 

5-5 



Screen Event 

Chapter6 
A Screen Event 

Screen events are used to show 256-color .PCX or high color .TGA graphic files created in 1EMPRA 
PRO, 1EMPRA GIF, or another paint program. You can create or capture (with the right video input/ 
capture board) any image and bring it to illustrate bullet-points, show realistic images, and include raw 
video instantly into your sequence. Screen events can be scaled or positioned. 1EMPRA SHOW 
provides you withalargenumberof television-like "wipes"thatletyou bring you images on to the screen 
in many different and interesting ways. 

Type~~~~~~~~~~~~~~ 
To show a full frame graphic or converted digitized video image in your Sequence, select SCREEN from 
the Type Menu. This is displayed with the current palette and mode. A Screen event remains on your 
video monitor until another Screen or BColor Event replaces it 

File~~~~~~~~~~~~~~~~ 
A list of available images appears. 1EMPRA SHOW only lists the available images depending on the 
current video mode you are in. The start up mode determined when you install 1EMPRA SHOW. 
Usually it is 640 x 480 x 256. You can show other screens that were created in a different mode (320 
x 200 for instance). See the chapter on Video (Set Mode) to reset the resolution. Your choice appears 
in the File field, the highlight goes to the Method field, and the Wipe menu appears. 

Mathematica, Inc. 6-1 



Screen Event 

6-2 

1he menu that appears lists ways to bring your screen event into the presentation 
1hese "wipes" are similar in function and description to wipes used in the 
broadcasting industry. Select one of these wipes and 1EMPRA SHOW will move 
on to the next menu. 

Parameters _________ _ 
1he Parameters field is used when bringing in a Screen that is to be scaled or 
positioned. 

Asls 
This feature brings the image onto the 
video screen with the selected wipe. No 
entry appears in this column because 
this is the default The image appears 

with the upper left corner of the image in the upper comer of the visible screen. If 
your image is smaller than the physical size of the screen, you may want to scale 
or position it 

Positioned 
This selection allows you to pick a location for the image you are bringing onto the 
screen You choose a location for the placement of the upper leftcomerof theimage 
by moving the screen cursor and pressing [Enter]. 

Scaled 
This selection allows you to bring images onto the visible screen and scale them to 
the siz.e you like. You choose the area you want to scale the image to by moving 
the mouse to the lower left corner of the intended area, pressing [Enter J and then 
moving the mouse tothe upper right comer and pressing [Enter]. During the editing 
stages, you can be more precise by moving the cursor over the parameters field and 
pressing the [F3] key. You can then type the exact position you want into the field. 

Other Fields ________ _ 
Label, Wait For, Next, Speed are events common to all lines. Apply these events 
as necessary. 
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Chapter 7 
A Sprite Event 

A sprite is a picture clip. Like a mouse pointer on the screen, it can float across any image. When 
used with button events, sprites you make in TEMPRA SHOW can be used as mouse pointers for 
interaction. You can also make sprites move on their own to add motion to your presentations. 
Sprites are generally small relative to the screen size and carry a .PCC extension in the 256-bit 
mode or a .WIN extension in the 16-bit and 24-bit modes. 

Type~~~~~~~~~~~~~~ 
Select this event from the Type menu to bring a movable (or moving) graphic or converted digital 
picture clip into your sequence. 

File~~~~~~~~~~~~~~~~ 
TEMPRA SHOW lists only the image files that can be used as sprites. Any image that is small 
enough and saved as an 8-bit .PCC file can be used as a sprite. In 16-and 24-bit true-color modes, 
the file extension becomes .WIN. TEMPRA SHOW, by default, looks for a .PCCsprite file. To 
change the default, use a Global event (PCC_ WIN). Highlight a file and press [Enter]. Your choice 
appears in the File field. 
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Method _________ _ 
Wipe 
When you want to wipe the Sprite onto the screen select a Wipe from the wipe 
menu. 

Simple 
To get the Sprite to just appear without motion, select Simple. 

Scale 
Use this to scale the Sprite before you show it on the screen. This method 
allows you to make a sprite any size your Sprite buffer can hold. The size of 
the sprite buffer varies according to systems resources, if you have not set it 
with the Sprite_Buf environmental variable. After you choose the Scale 
Method, the Sprite and a screen instruction appear. As you move the mouse, 
notice the two indicators on the bottom of the screen. You can see the 
percentage of the scaling and the size of the Sprite in bytes. If you try to scale 
the sprite to a size that the system cannot accommodate, a message appears 
telling you the sprite is too large. When you press [Enter], the percentage of 
the scaling is entered into the Method column. This scaling is always 
proportional. 

Parameters _________ _ 
Once you select a sprite, it appears in the lower left comer of your screen. A 
prompt asks you to "Use your cursor keys to move the Sprite to its beginning 
position. Then Press [Enter]". If you do not see the Sprite it may be out of the 
active Viewport. Press the Space Bar to see the active Viewport as a square 
and to reveal the Sprite. Use the mouse to position the Sprite at its beginning 
position. This is the position where you want the sprite to first appear. Once 
in place, press the Select button. 

A second prompt now asks you to "Use your cursor keys to move the Sprite 
to its ending position. Then Press [Enter]". With the mouse, move the sprite 
to the ending position. The Sprite remains on your video monitor at the end 
position. Your cursor moves to the Wait For field and the Wait Menu pops up. 
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Sharp Boy says: 
Avoid leaving trails of 
sprite pieces. A sprite with 
a 1 O pixel borderwill leave 
trails if they are moved at 
speeds over 10. So if you 
want to move a sprite at 
speed 12 you should have 
a border of at least a 12 
pixels on that sprite. 
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Other Fields ________ _ 
Label, Next, Sp/Dp, and Wait For are fields common to all lines, apply them 
as necessary. For more infonnation on these fields, see the section on Common 
Fields. 

Special Features of Sprites ___ _ 
Make Sprites 
Be sure to make your Sprites with the same number of available colors as the 
images they will moved over. Sprites to be shown with 256 color images must 
bemade in the 256 color modes, 16 color images require 16 color sprites, and 
soon. 

To Make a Sprite From Scratch 
Use TEMPRA PRO, TEMPRA GIF, or your drawing program create a 
rectangle that has the only the transparent color in it (color value of 0). This 
color is black in the default palette. Draw your Sprite inside this rectangle. 
Leave "black space" around the Sprite, and save it to the disk. 

To Make a Sprite From an Existing Image 
Use TEMPRA PRO, TEMPRA GIF, or your drawing program and load an 
image. Put a 0 color (black) rectangle around the part of the image that you 
want to be a Sprite. Then erase everything in that rectangle that is not part of 
the Sprite you want to see. Erasing these really means turning all the pixels to 
colorO (black). Save the portion of the screen that is within the black rectangle. 
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Chapters 
A Text Event 

Text Events are text (from any word processing program saved as an ASCII file) that are 
displayed in TEMPRA SHOW in a variety of ways, in any graphic mode, font, color, in a frame, 
or directly over an image. 

Type~~~~~~~~~~~~~~ 
Select the Text event in the Type menu. 

A list of available Text files appears for you to select. Text files can be written in the TEXTEDIT 
utility program supplied with TEMPRA SHOW. Text is selected one line at a time, so your text 
files can be as short as one line. Text files must be saved or copied into the TXT sub directory 
in the TEMPRA directory. 

A font choice menu is the method of this event. Choose from the default, VV fonts or KST fonts. 
When you choose VV or KST fonts, you see a list of Fonts. Choose one and proceed to the 
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display menu. Choosing the Default font lets you show the font set with the 
Global event. In otherwords, the default font can be a KST or a VV font as 
long as you select that font as a default and use a Global event to use the 
default font on all Text events. 

The first decision of the dis­
play menu is the Permanent, 

.............. .. ....................... I ~~~~:£¥~:~ 
Text lin1 1 
Text fine 2 
text lut Une 

than one line, choose the line in the file to start your text display. TEMPRA 
SHOW will display the line you select and everything from that line on. Use 
the cursor keys to scroll through the file and find the line you want. 

Parameters _________ _ 
The first menu to appear is the "Allow user to operate" menu. This menu 
sets the text to display I@::::m:B.iiil!WliIIJSiii9!IIIIIII1tlt:ttI: 

:!!e~c~: ~e~s ~: t:~ i!!illilll;:1i::1:1:~iili!~:~i1!1:;1i:!!lil:l!iii:'ill:li·l:!;l:i:·111i::·1::::l:!iil!!i!·:::.:iii:!ii·i1·1111::1::1:.111i:·:~:'l!·!1:·:j:'ill:l. :II 
file within the presenta-
tion at their leisure. Se-
lecting no at this point will not let the viewer participate in this function. The 
next menu to appear asks you to draw a frame around the section of type you 
have selected. 

First, you select the typographic qualities of the selected text. Justify, 
choose the color and the draw the frame. The Parameters field is where you 
determine the color of the text and whether you want a frame around it. If 
you want a frame, then you are able to give the user the ability to operate 
the window. You set the size and location of the window. When you are 
creating the Text event for the first time, you are given all the set up choices 
in order. When you are editing, you are presented with a menu asking which 
of the options you want to modify. 
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Color 
You are asked if you want to select the color from the graphics screen. If 
so, a cursor appears that has a square border. The cursor's border color is 
the selected color. Move the cursor over the color you want to select and 
press [Enter]. If you want a color from the color menu, select no, and a color 
menu appears. Select the color you want from the small squares. 

Not Framed 
If you want the text to be written over the image without a frame, but 
written directly over the image, then answer NO to the "Framed?" 
question. 

Framed 
If you want the text in a framed window answer YES to the "Framed?" 
question. A framed window has the color attributes set with the Global 
Event. The Global values for the windows at start up are the same used by 
the Worlcform. Answer "No" and the text is placed directly over the image. 

Operate/Frame 
If you choose Framed text, this lets you allow the user to operate the text 
window, by scrolling through it with the mouse or cursor keys. It also 
allows the user to pan right and left to see long lines of text that do not fit 
into the text window. Framed text that cannot be operated only displays the 
text you choose. 

Width/Height 
Once the operation question is answered for framed windows, you must set 
the size of the windows. The text from the file is shown on the screen. Use 
the cursor keys or mouse to stretch the frame around your text. 

Justify 
You have the ability to see the text with Left or Right justification, or 
centered. Remember that TEMPRA SHOW thinks spaces are characters, 
so if you have spaces on the end of your text lines the centering will notlook 
correct. If this is the case go back in to the text file with your text editor and 
delete the spaces at the end of the lines. 
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Position 
Now that the text display options have been set, it is time to place the text 
on the screen. The Text is seen only when it is within the active Viewport. 
If you cannot see the Text to position it, press the Space bar to reveal the 
Viewport as a square, and to show your text. Your computer screen prompts 
you to "Use your cursor keys to position your Text. Then Press [Enter]." 
Notice the x,y coordinate prompt in the comer of the screen. Use your cursor 
keys to position your Text and Press [Enter]. The Text coordinates appear 
in the Parameters field. Your highlight cursor moves to the Wait For field 
and the Wait Menu pops up. 

Other Fields ________ _ 
Label, Next, and Wait For are fields common to all lines. For more 
information on those fields, see the section on common fields. 
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Chapter9 
A Title Event 

A title event is a rapid display of a word or words not exceeding 10 characters. 

Type~~~~~~~~~~~~~~ 
Select this event to place a title with the font and color of your choice in your sequence. Titles are 
not stored in their own files. They are part of your Sequence Workfonn file. This saves space on 
your hard drive. 

The cursor moves to the Method field and the Title Font Menu appears. Choose the default (set 
with the a Global event), VV font or a KST font. You see a sub menu if you did not select the default. 
Highlight a Font and press select or [Enter], and your choice appears in the Method field and the 
cursor moves to SP/DP. 
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Parameters _________ _ 
Create New Titles 
The cursor moves to the Parameters field and the prompt "Input Title" 
appears. Titles may be up to 10 alphanumeric characters in length. Type a 
Title and press select [Enter]. 

You can create Titles as long as you wish by creating subsequent Title Events 
and positioning them accordingly. If you are thinking of making a long title, 
you might want to consider using a Text event. 

You are asked to choose the color from the screen or from a palette. If you 
choose to pick a color from the screen, you see a small cursor with a colored 
box on top of your image. As you move the cursor, you see that the colored 
box changes color. Itis showing you the color of the pixel on the screen, under 
the cursor. It is this color that is the background color when you press [Enter]. 

If you choose not to pick the color from the screen, a color palette appears. 
Move the cursor over the color you want and press select or [Enter]. 

TEMPRA SHOW now clears the screen. The title, with the options you've 
specified, appears in the lower left comer. The title only shows up in the active 
Viewport. If you can not see the Title it may be because the Title is outside 
the active Viewport. Refer to the Video Event chapter if you have activated 
a Viewport. Press the Space bar to reveal the active Viewport as a square, and 
to show your title. 

Your computer screen prompts: "Use your cursor keys to position your Title. 
Then Press [Enter]". Titles only have one set of coordinates. Notice the x,y 
coordinate prompt on the graphics screen status line nearthe Viewport status 
notice. 

Use your mouse or the cursor keys to position the title and press select or 
[Enter]. The x,y coordinate prompt will change as your title moves. The title 
coordinates and color number (followed by a small letter c) appear in the 
Parameters field. 
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Editing Title Events 
When you position the field cursoroverthe Parameters field of a title event and 
press select or [Enter] you can see a menu giving you choices to edit a single 
attribute of the Title Event or all of them. 

All 
Selecting this title editing option recreates the process of making the Title as 
if you were doing it for the first time. 

Title 
Selecting this option allows you to edit only the title itself. The prompt "Input 
Title" appears. Titles may be up to 10 alphanumeric characters in length. 

Position 
Your computer screen prompts: "Use your cursor keys to position your Title. 
Then Press [Enter]". Reposition your title. 

Color 
Selecting this option lets you change only the color of the title. 

Other Fields ________ _ 
Label, File, SP/DP, Wait For, and Next are fields common to all lines. Apply 
them as necessary. For more information on these events, refer to the common 
fields section of this manual. 
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Chapter 10 
A BColor Event 

BColor events are background colors that wipe on the screen. Your choice of colors ranges from 
16 to 16.7 million, depending on the display mode. 

Type~~~~~~~~~~~~~~ 
This Event wipes a background of a single color onto screen during your sequence. When you are 
in the Type field, select BColor. Your choice of event is entered into the field. Your highlight 
cursor skips to the Method field and the new Menu appears. 

The wipe method menu appears as soon as the BColor event is selected. This menu lists the ways 
you bring your background color onto the screen. The following wipes are, for the most part, self 
explanatory and are similar to those used in the film and television industry. Select a wipe and the 
event controller automatically skips ahead to the next menu. 
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Sp/DP~~~~~~~~~-
This Speed Menu determines how fast your wipe is going to bring the 
background color onto the screen. The numbers, 1 to 99, represent the speed 
with 1 being the slowest and 99 the fastest. Select a speed. For more 
information on speed, see the common fields section on Sp/Dp. 

Parameters-----------
For this event, the Parameters field is where you select what color you want 
for your background color. You are asked if you want to choose the color 
from the screen or from a color palette. 

I -11 
If you choose to pick a color from the screen, a small cursor with a colored 
box appears on your image. Move the cursor over the color you want as your 
background color and press select. This will select that color. If you choose 
to pick the color from the color palette, a palette of colors appears for you to 
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choose your color from. With the mouse, select the color you want. Then click 
OK. You have selected your background color. This color will change if you 
bring in graphics files that have different palettes than your background color. 
The graphic file determines how many colors are available in any given 
palette. When you see a color you like in the center square, select [Okay]. 

Other Fields ________ _ 
The Label, Wait For, and Next are events common to all lines. Apply these 
events as necessary. 
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Chapter 11 
A Menu Event 

Menu events allow the viewer to select option, specified by you, and branch to other parts of the 
sequence. Select this Event to put a "pop up" menu on the screen. nus Event gives your viewer 
the ability to make choices given in the form of an item list. nus Menu can contain as many items 
as fit on the screen. Choices can be made with the cursor keys on the keyboard, a mouse, or a joy 
stick. Choices are entered with the [Enter] key, the left mouse button, or fire button on the joystick. 

Type~~~~~~~~~~~~~~ 
As the field cursor goes to the Event Type field, and the Event Menu pops up. Highlight "Menu" 
and press [Enter], and your choice appears in the Event field. 
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Parameters----------­
create New Menus 
The first choice in the Parameter field is the insertion of new lines into the fonn 
or overwrite the current lines. If you are editing a Menu, you probably want 
to choose overwrite; otherwise, choose "Insert Lines." The next thing you see 
g l1~["<'.'.'.'''''''''':·:·· is a prompt asking for the 

titleofthemenu. You may 
notice every menu in the 
TEMPRA SHOW system 

has a title telling you what the choices pertain to. This is your place to tell your 
viewers what your menu is about. 

Now a menu is on the screen. Use the mouse or cursor keys to size the window 
around the Menu. Then use the mouse or cursor keys to position that menu 
where you want it. Press select or [Enter]. Fill in the prompt and press [Enter] 
to set up the branch table. This is a process of popping between the Parameters 
field and the Next field until the Menu is set up. 

It may surprise you to see that you suddenly go to the Next column. In the 
process of defining a Menu Event, the field cursor pops between the Parameter 
and the Nextto set up a table. The table is as long as the numberof items chosen 
in the Method field. This table contains the list of choices you are giving the 
viewer in the parameters field and the Label names of the Events you want to 
branch to as a result of choosing that item in the Next field. 

Editing Menus with Prompts 
lMlfliif!lMflflliM You can edit the Menu Event by positioning the field §I ::~~:Ee!i';?°:~.:~iu~dc~:=:~;:; 

You can recreate the menu by choosing to edit all the 
aspects of the menu. 
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Title 
You can change only the title of the Menu by selecting this. 

Menu Items 
You can change only the Items listed in the Menu by selecting this. You can 
also type directly onto the Workfonn to change these entries. 

Width/Height 
You can change the size of the menu by selecting this. The border of the menu 
is moved one character at a time. The Menu appears in whatever font you have 
set in the last Global Event. 

Position 
You can change the placement of the menu on the screen by selecting 
this. To change the color of the menu you have to use the Global event. 

The Nexts are used to define where the TEMPRA SHOW control goes as a 
result of choosing one of the items on the menu list. The Next parallel to the 
choice shows which Event Label is the target of the branching. Enter the Label 
name of the Event where you want to go as a result of the choice made. The 

special line of the Menu 
Event with the title al­
lows for the added fea­
ture ofletting the viewer 
to escape from a menu. 

If the viewer presses the [Esc] key or right mouse button, while he is on a 
Menu, the system automatically branches to the Label in the Next field across 
from the Menu Title. If nothing is put in this Next field, control passes from 
the menu and the Event line directly after the Menu Event is executed. 

Other Fields ________ _ 
Label, File, and Wait For are events common to lines. 
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Chapter 12 
A Button Event 

This event allows for user input and choices made from predetermined selections from a touch 
screen, mouse, keyboard, or joystick in a branching event. 

Type~~~~~~~~~~~~~~ 
Use a Button event to allow the user to move a Sprite as a cursor across the screen as a pointer 
to button areas on the screen. The system can identify the location of the cursor once the [Enter] 
key, left mouse button, or fire button on a joy stick has been pressed. If the location of the cursor 
is within the boundary of a Button, then a Branch occurs. 

Because the Button event allows the user to move Sprites as a screen pointer, this field is where 
the name of the Sprite file is put on the form. See the Appendix for information on how to make 
a Sprite. (For touch screen users there are no files to pick.) 
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Default Cursor 
If you leave the File field blank, TEMPRA SHOW supplies a cursor for you 
to use. It is a cross, and you may find it helpful to use the cursor rather than 
supply a sprite to act as a cursor. 

Method ___________ _ 
When a user moves the pointer across the screen and presses [Enter] the system 
notes the x,y location of the pointer, and checks to see if it is within any of the 
Button areas. 

The field cursor goes directly to the Method column. Here you can pick up to 
99 Button areas that you can make active with this Event. Use the cursor keys 
and [Enter], and the form is filled in with your choice. 

Parameters _________ _ 
If you are editing an exiting Button event you will want to choose overwrite; 
otherwise, choose "Insert Lines" if you are creating a new Button event. The 
next thing you see is a message on your graphics screen asking you to put the 
pointer at the beginning position. After all, the pointer has to show up some 
place to start off. 

You have the option of putting an "R" after this position. This "R" makes the 
pointer's position relative, so every time the user/viewer comes back to this 
Event the Sprite pointer is where he left it, not where it started off. Be sure you 
save the sequence after you have set the starting position where you want it, 
and before you run the Event. The "R" modifies the position as the Sequence 
runs. 

Tell the system what label you want to branch to if the viewer presses the [Esc] 
key or right mouse button during this Event. 

It is helpful if you have the correct graphic file on the screen at this time. First 
you have to describe a safe active area. This keeps the viewer from flying the 
pointers off the perimeter of the monitor, or over a portion of the screen from 
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which you want to keep them. Set the lower left limit and then the upper right 
limit to the invisible box that is the safe active area. Now you have to delineate 
the active Button areas. This is done by positioning the Sprite at the lower left 
comer of an imaginary box that is the active Button area and pressing [Enter] 
(or the left mouse button) then moving the pointer to the upper right hand 
corner of the same imaginary box and pressing [Enter] (or the left mouse 
button.) 

When you have done this you can see the prompt for the Next field. Put in the 
Label of the Event you want to branch to when the Button is found in this 
active area. Repeat this process for each active area. 

It may surprise you to see that you suddenly go to the Next column. In the 
process of defining a Button Event, the field cursor pops between the 
Parameter and Next fields to set up a table. The table is as long as the number 
of items chosen in the Method field. Tilis table contains: the x,y coordinates 
for the active areas in the parameters field and the Label names of the Events 
in the Next field. Each of these Events Labels are the lines you want to branch 
to when that Button is selected. Fill in the prompts and press [Enter] to set up 
the branch table. This is a process of popping between the Parameters field 
and the Next field until the Button is set up. 

Next 
The Nexts are used to define where the TEMPRA SHOW system goes as a 
result oflanding in an active area. The entry in the Next field on the same line 
as the Button coordinates tells TEMPRA SHOW which Label is the target of 
the branching. Enter the Label name of the Event where you want to go as a 
result of the choice made. 

The first line of the Button Event has the added feature of letting the user 
escape from a Button. If the user presses the [Esc] key (or RIGHT mouse 
button) while he is on a Button the system automatically branches lo the Label 
in the Next field on the first line of the Event. If nothing is put in this Next field 
and [Esc] is pressed, control passes from the menu to the Event with the Label 
that matches the first Next in the Button Event. 
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Make sure all the labels in the Next fields match with Labels within the 
current Sequence. The system tells you if this is true or not when you go to 
Preview the Sequence with [F6] or when you go to save the Sequence. If you 
are using a touch screen, use the Configure option from the Main Menu to set 
the screen value in the TSHOW.CFG file to the type of screen you have. 

Other Fields ________ _ 
Sp/Dp and Wait For are fields common to all lines. Apply them as necessary. 
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Chapt~r 13 
A System Event 

Select this Event to execute programs stored on your hard drive or to call DOS programs, batch 
files, and commands mid-sequence. 

Type~~~~~~~~~~~~~-

se1ect System from the Type field, and the Event Menu pops up. Select "System" and press 
[Enter] or the left mouse button. 

Choose the amount of memory you need in the shell: ALL, 1 OOK, 200K, 300K, or 400K. 

Parameters _____________ _ 
After you have chosen the System Type, a prompt asks you to "Input DOS Parameters." The entry 
you make is executed by the computer as if you had entered it from the system prompt. After the 
program you named in the Parameter field runs, control passes to the Sequence once again. 

Other Field~------------
Label, File, SP/DP, and Next are Fields common to all lines. Apply them as necessary. 
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Chapter 14 
A Chain Event 

Type~~~~~~~~~~~~~~ 
Select this Event to make a Chain of Sequences. Each Sequence can be no more than 500 lines long. 
This is due to memory constraints. Your Show can be much longer if you Chain a number of 
Sequences together. When the Chain command is executed, the next Event you see is the first Event 
in the Sequence you Chain to. The field cursor is in the Event TYPE field, and the Event Menu pops 
up. Highlight "Chain" and Press [Enter], and your choice appears in the Event field. 

A directory menu appears. This is a menu of sequences. Choose the one you want to Chain together, 
and press [Enter]. Your choice is entered onto the screen and the field cursor goes directly over to 
the Wait For field. 

Don't Wait, Wait for Any Key, Wait for Timeout pertains to the wait that you may want to put 
in before the Chain is executed. This is different from the other W aitForwhere the waiting occurred 
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after the Event. Here execution of this Event takes program control away from 
the line, so by the time a post execution Wait For might have been executed, 
the line is long forgotten because a new sequence is now in memory. This 
feature is not frequently used. 

When a new Sequence is loaded, TEMPRA SHOW will load the paths 
associated with that sequence if the paths have been saved with the same name 
as the Sequence name. Using Chain will allow you to change paths as you run 
sequences. 

Other Fields ________ _ 
Label, Next, are Sp/Op are fields common to all lines. Apply them as 
necessary. 
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Chapter 15 

BO Mode Event 

This Event is used to switch to and from color graphics mode to 80 column color text mode. 

Type 
Select 80 Mode from the Type menu by clicking on the Type field. 

The Method field lets you tum the 80 column color text mode On, Off, or Clear. 

On 
Use this to tum the 80 column color text mode on. 

Off 
If you determine you want to turn on the VGA Graphics screen display, then tum this OFF. The 
Graphics screen will look just the same as it did when you left it. To switch to graphics mode and 
have a new Screen or BColor, simply select one of those events. Clear: Use Clear if you want to 
clear the 80 column text screen. 
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Other Fields ________ _ 
Label, Next, SP/DP, and Wait For are fields common to all lines. For more 
information on these fields, please refer to the section on common fields. 
Parameters and File do not apply in this line. 
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Chapter 16 
BO Text Event 

80 Text events are the same as regular Text events, except in the 80 column format. No 
font select is available. 

Type~~~~~~~~~~~~~~ 
Use this Event to put ASCII text files on the Screen with the color attributes defined in the 
last color change in the last Global Event. 

After you select the 80 Text type you are given a directory menu to the right of the cursor. Use 
this to select the file you want to display. Use the cursor keys to highlight your choice and press 
[Enter]. 

Sp/DP~~~~~~~~~~~~~ 
After choosing a display type, choose which line of the text file you wish to start displaying. The 
text file comes onto the screen. Scroll through the file (using the cursor keys or mouse) until you 
highlight the line you want to be the first line showing on your display screen. Press [Enter] and 
the line number is put into the form. 
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Parameters 
The parameters field is where you determine: the color of the text, and 
whether you want a frame around it. If you want a frame, then are you going 
to give the user the ability to operate the window, and the size and location 
of the window. When you are creating the Text Event for the first time, you 
are given all these choices in order. When you are editing, you are presented 
with a menu asking which of the options you want to modify. 

Position 
Use your cursor keys to position your Text. Then Press [Enter]. The Text 
coordinates appear in the Parameters field. 80 Text Events have only one set 
of coordinates. Notice the X, Y coordinate prompt in the cornerof the screen. 

Color 
This is where you choose the colorof the character (foreground color). If you 
choose to pick the color from the color menu select the color you want from 
the colors in the smaller squares. 

Width/Height 
Once the operation question is answered for framed windows you set the size 
of the windows. The text from the file is shown on the screen. Use the cursor 
keys or mouse to stretch the window to fit the text. 

Not Framed 
If you want the text to be written over the text screen without a frame, 
answer NO to the "Framed?" question. 

Framed 
If you want the text in a framed window, answer YES to the "Framed?" 
question. A window frame has the color attributes set with the global values 
defined with the last Global Event. The Global values forthe windows at start 
up are the same ones for your Workform. 

Operate/Frame 
If you choose Framed text, this lets you allow the user to operate the text 
window, by scrolling through it with the mouse or cursor keys. It also allows 
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the user to pan right and left to see long lines of text that do not fit into the 
text window. A window that cannot be operated only displays the text you 
choose. 

Justify 
You have the option of justifying the text on the left or right of the window, 
or to center the text in the window. 

Other Fields---------
Label, Next, and Wait For are fields common to all lines. Please refer to the 
common fields section of this manual. 
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Chapter 17 
BOWin Event 

This Event type is useful in displaying text windows made with the PWIN Utility. (Run this utility 
from the Subprogram selection on the Main Menu.) These windows can be made to look like 
any PC text screen in 80 column mode, so you can reproduce data entry screens for training and 
mock ups and so on. 

Type~~~~~~~~~~~~~~ 
Select 80 Win from the Type menu after selecting the Type field. 

File 
After you select the 80Win type you are given a directory menu to the right of the cursor. Use 
this to select the file you want to display. 

Sp/Dp~~~~~~~~~~~~-

Speed 
This determines how fast the *. WND moves across the screen. 
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Parameters _________ _ 
Use the cursor keys or mouse to position the 80Win. When it is where you 
want it, press select or [Enter] or the left mouse button. You can choose a 
second x,y pair if you want to move the text WNO file across the screen. 
If you do not wantitto move press [Enter] again and both x,y pairs are the same 
and the *.WNO file does not move. You can see two x and y coordinate pairs 
in the Parameters field. 

Label, Next, and Wait For are fields common to all lines. Method does not 
apply. For more information on the common fields, see the section on common 
fields. 
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80 Menu Event 

Chapter 18 
BOMenu Event 

This Event gives the you the ability to take a path represented by the item choices from a list. 
Choices can be made with the cursor keys on the keyboard, a mouse, or a joystick. Choices are 
entered with the [Enter] key, the left mouse button, or fire button on the joystick. 

Type ~~~~~~~~~~~~~~ 

Select this event from the menu that appears when selecting the type field. When the field cursor 
is in the Event TYPE field, and the Event Menu pops up, highlight "80Menu" and Press [Enter], 
and your choice appears in the Event field. 

The field cursor jumps from the Type field to the Method field. You see a menu offering 2 to 10 
items. Choose a number based on the number of choices you want to give the user/viewer. If you 
want to give him more than 10 choices, you have to go back and edit in the new number later. 
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Parameters _________ _ 
First tell the system whether you want to insert new lines into the form or 
overwrite the current lines. If you are editing an 80Menu you probably want 
to choose overwrite; otherwise choose "Insert Lines." 

The next thing you see is a prompt asking for the title of the menu. Notice every 
menu in the TEMPRA SHOW system has a title. This is your place to tell your 
user/viewer what your menu is about. 

Now a menu is on the text screen. Use the mouse or cursor keys to size the 
window around the Menu. Then use the mouse or cursor keys to position that 
menu where you want it to be seen. When this is done press [Enter]. Fill in the 
requester windows and press [Enter] to set up the branch table. This is a 
process of popping between the Parameters field and the Next field until the 
Menu is set up. 

In the process of defining an 80Menu Event, the field cursor pops between the 
Parameter and the Next to set up a table. The table is as long as the number 
of items in your 80Menu as chosen in the Method field. This table contains: 
the list of choices you are giving the user/viewer in the Parameters field, and 
the Label names of the Events you want to branch to in the Next field. 

Editing BOMenu with Prompts 
You can edit the 80Menu Event by positioning the field cursor in the 
Parameters Field and pressing [Enter]. You see a menu that allows you to 
change one aspect of the menu, or all. 

All 
You can recreate the menu by choosing to edit all the aspects of the menu. 

Title 
You can change only the title of the 80Menu by selecting this. 

Menu Items 
You can change only the Items listed in the 80Menu by selecting this. 
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Width/Height 
You can change the size of the menu by selecting this. 

Position 
You can change the placement of the menu on the Text screen by selecting this. 
To change the color of the menu you have to use the Global Event. 

Other Fields ___ _ _ _ __ _ 
Label, Next, SP/DP, and Wait For are fields common to all lines. Apply them 
as necessary. For more information, please refer to the section on common 
fields. 
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80 Butn Event 

Chapter 19 
BOButn Event 

80Butn events are the same as Button events, except in an 80 column fonnat. 

Type~~~~~~~~~~~~~~ 
A Button event has been created to allow the viewer to move a Text pointer across the text screen, 
and to use it as a pointer to square areas, 80Butns, on the screen. The system can identify the 
location of the Text pointeronce the [Enter] key, left mouse button, or fire button on a joystick has 
been pressed. If the location of the Text pointer is within the boundary of an 80Butn, a Branch 
occurs. 

When the viewer moves the text pointer across the screen and presses [Enter], the system notes the 
x, y location of the Text pointer and checks to see if it is within any of the 80Butn areas. As a 
developer you see the field cursor go directly to the Method column. Choose the numberof 80Butn 
areas to be active with this event. As you use the cursor keys and [Enter], the fonn is filled in with 
your choices. 
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Sp/DP~~~~~~~~~-
Choose a maximum speed at which you want the pointer to travel while you 
are moving the pointer with the cursor keys. 

Speed 
If the user/viewer is using a joy stick or the cursor keys to move the pointer 
and if the user/viewer keeps the pressure on the device, the pointer accelerates 
to the maximum speed indicated in the Sp/Dp field. 

Display 
You have the choice of making these Text pointers Permanent, Temporary, 
or Erasing after the key press. This is a design decision. If you want pointers 
to build upon the screen, use Permanent. If you want to Erase the pointer and 
other temporary Events, choose Erase after Displaying. If you like the effect, 
choose Temporary. 

Parameters----------
If you are editing an 80Button event, you probably want to choose overwrite; 
otherwise choose "Insert Lines." The next thing you see is a text window on 
your text screen asking you to put the Text pointer at the beginning position. 
After all, the Text pointer has to show up some place to start off. You have 
the option of putting an "R" after this position. This "R" makes the Text 
pointer position relative, so every time the viewer comes back to this event, 
the Text pointeris where he left it, not where it started off. Save your Sequence 
after you set the starting position where you want it, and before you run the 
Event. The "R" modifies the position as the sequence runs. 

Tell the system what Labeled event you want to, branch to if the user presses 
the [Esc] key or right mouse button during this event, by entering that Label 
in the first Next. 

You have to describe a Safe Active area. This keeps the user/viewer from 
flying the Text pointers into outer space, or over a portion of the screen you 
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want to keep them from. Set the lower left limit and then the upper right limit 
to the invisible box that is the Safe Active area. Now you have to delineate the 
active 80Button areas. This is done by positioning the Text pointer at the 
lower left comer of an imaginary box that is the active 80Butn area and 
pressing [Enter] (or the left mouse button), next move the Text pointer to the 
upper right hand comer of the same imaginary box and press [Enter] or the 
left mouse button. 

After you have done this you see the requester window for the Next field. Put 
in the Label of the Event you want to branch to when the text pointer is found 
in this active area. Repeat this process for each active area. 

It may surprise you to see that you suddenly go to the Next column. In the 
process of defining a 80Butn Event, the field cursor pops between the 
Parameter and the Next to set up a table. The table is as long as the number 
of items chosen in the Method field. This table contains: the x,y coordinates 
for the 80Butns in the parameters field, and the Label names of Events in the 
Next field. These are the Events you want to branch to as a result of selecting 
an 80Butn. Fill in the requester windows with the Labels of these Events and 
press [Enter] to set up the branch table. This is a process of popping between 
the Parameters field Ind the Next field until the 80Butn is created. 

Other Field-----------
Label, Next, File, and Wait For are fields common to alllines. Apply them as 
necessary. 
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Chapter20 
A Video Event 

Video events bring animation to sequences with live or recorded video or graphics that have been 
saved as "flick" (.FLC or .FLI) files. TEMPRA show supports Autodesk Animator, Animator 
Pro, and Studio 30 "flick" files, as well as video flick files created in Cinemaker from Digital 
Vision. You can also set the display mode, fade images in and out, cycle colors, animate text, and 
load different color palettes with this event. If you have a video input/capture board, like the 
SN APplus card from Cardinal Technologies, and a SONY Vbox with any SONY VI SCA device, 
You can use Video events to play live video in a window within your presentations. 

Type~~~~~~~~~~~~~~ 
The field cursor goes in the Event field, and the Event Menu pops up. Select "Video" from the 
Event menu, press [ENTER] and "Video" is entered onto your Workform. 

Use this option in conjunction with the Save Picture, Load Palette, Fade, and AAPlay options. 
Choose one of these options and a menu with a list of all applicable files appears. 
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Method 
LoadPal ~~~~~~~~~~~~~-

1lrls Method allows you to load in individual palettes that have been created 
to optimize the quality of the VGA image. The palettes are part of the images 
so you must select it from the image directory. After you select this Method, 
the field cursor goes to the File column. Select the file you want from the 
directory menu on the screen. 

CycleColor 
1lrls Method allows you to shift the colors of the image on your screen with 
the range of colors in the palette in a random fashion. 1llis Event can be used 
to create interesting psychedelic visual effects. 

Set Mode 
1llis Method allows you to use choose the video mode and use any resolution 
that is available in your video board. When selecting this option, a menu 
appears with possible video mode selections. Use a Set Mode to play small 
.FL.I files at a larger screen size. (set the mode to 320x200x256) 

Save Picture 
1llis method allows you to save all or part of what you currently have on the 
VGA Graphics screen during runtime. It goes to a file in the screen directory. 
To use Save Picture, enter a filename for a screen captured image that is 
automatically saved when the sequence is run. You then write a screen event 
line using the file name of the screen capture from the Save Picture line. When 
ever the sequence is run, it will save whatever is on the screen (like live video) 
and incorporate that fresh image directly back into the sequence at any point 
you choose. 

Fade In 
1lrls method allows you to fade an image in from black. The image that is 
brought in is designated in the File field. (1llis feature may not work on all 
VGA cards.) In order to use this the image you want to fade in has to already 
be loaded in with a Screen event. 1llis event only affects the palette of the 
image. 
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Fade Out 
Tiris Method allows you to Fade an image Outto black. The image that is faded 
out is designated in the File field, and it should be the current image on the 
graphics screen. Tiris Event only affects the palette of the image. (Tiris feature 
may not work on all VGA cards.) 

Viewport 
Tum a viewport on to create an" active zone" in your visible graphics screen. 
Tiris hole becomes the only active area on the screen. You can move Sprites 
past it, wipe images into it, etc. Everything that shows on the graphics screen 
shows up only if it is within the active Viewport. You must reset the Viewport 
to include other areas of the screen if you want to use other parts of the screen 
after you have used the Viewport once. You can tum it off with Viewoff. 

In the 16 color modes you may see that some Sprites change in screen location 
when used with a Viewport. Tiris is due to a byte boundary constraint that 
causing the bytes in the pixels to realign themselves at run-time. Adjustment 
to the viewport can accommodate this. 

ViewOff 
Tiris method is used to restore the whole graphics screen as the active screen. 
It resets the active viewport to a full screen. 

lnfowind 
Tiris method is used with a variety of Parameters to control the output of an 
IBM Infowindow. You can use it to show graphics according to the mode you 
are in. (There is no VGA in the Infowindow) You can use it to show video 
coming through the Infowindow. 

AA Play 
Tiris method is used to play * .FLI and* .FLC files made with TEMPRA PRO 
3.1, Autodesk's Animator and Animator Pro. The Animator programs are 
used to create little movies called flicks. Once they have been made you can 
show them with TEMPRA SHOW. We give you the ability to pause and 
restart the flicks while they are running. You can do this just by pressing the 
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[Space Bar]. To restart the flick, all you have to do is press the [Enter] key. 
After you select this video method, a list of the available "flick" files appears. 
These files are kept in the PIC directory. Select your* .FLI or* .FLC file from 
this directory menu. Running a * .FLI or * .FLC file will change the current 
palette to the one used in the * .FLI or * .FLC file, even after the flick has 
finished playing. To reset the video mode, use another video mode with a 
ResetPal method or select another mode with a SetMode. 

ResetPal 
This method is used to reset the palette to the TEMPRA SHOW default 
palette. 

Scroll Up 
This method is used to scroll a text file up the video screen in a framed or 
unframed colored box. Text is scrolled in the Global font. You can set the 
location and size of the window, and the color and justification of the text. 

Ticker 
This method is used to scroll text horizontally across the screen, giving a 
"ticker-tape" effect. The bar can be any place on the screen, have any length, 
and the text can be any color in the palette. The font is set with the Global Font 
method. 

Ceg Mode 
This method is used to activate the Edsun CEG/DAC Continuous Edge 
Graphics chip. The various modes are set in the Parameters field. You must 
make sure the mode you set is consistent with the CEO image you are showing. 
This setting is automatically turned off if you make any subsequent events that 
change the palette. These include color cycling, loading or resetting palettes, 
and playing * .FLI files. 

VidXXX 
The following video window events require a video overlay card (such as a 
SNAPplus or Video Blaster) to be installed. 
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Vidlive • Video Live 
The Video live method turns on live video and displays it in the last video 
window that was used If there was no video window, IBMPRA SHOW does 
not do any function. VidLive does not have any parameters. 

VidOver • Video Overlay 
The VidOvermethod places the video in overlay mode. The video coming into 
the screen is only seen when there is a transparent color on the display. 
VidOver is different from the Video Live method which places the video on 
screen on top of the graphics. VidOver does not have any parameters. 

VidNorm • Video Normal 
The VidNorm method turns off any video window that may be active. The 
display acts as if it were a normal VGA. You should use VidNorm when ever 
you need to do graphic events that do not use live video. 

VidWind ·Video Window 
The VidWind method tells TEMPRA SHOW to place a video window onto 
the screen and display the video coming into the card. The video is brought into 
TEMPRA SHOW by a compatible display card. If your computer does not 
have a compatible display card, VidWind will not function and you will 
receive an error message. 

VidGrab ·Video Grab 
The VidGrab event freezes the video coming into a video window and places 
it onto the screen. The image then becomes a part of the screen display. 
Captures can appear to be instantaneous. Depending on the type of video input 
board, the grab time can vary from 1/30th of a second to a few seconds. 

VidTcol • Video Transparent Color 
The Video Transparent Color method allows video in a video window to 
display when it is covered by a transparent color. The video coming into the 
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computer is only visible where the transparent color is on the screen. The color 
acts as if it were transparent. When a video window has be established on the 
screen and a video event using VidTcol is performed, any further events that 
bring the transparent color to the screen will bring the video to the screen 
through the transparent color. These events can be Screens, Sprites, or 
Background Color events. 

VidBW - Video Black and White 
The Video Black and White method causes the video coming into the computer 
to switch between Black and White or color. Once you have executed an event 
that changes video to black and white, executing another event that turns the 
VidBW off will return the video display to color. 

Vidlnv - Video Inverse. 
The Video Inverse method inverts the colors of the video coming into the 
display through a video window. Video inverse is similar to the VidBW 
method because it can be turned on and off. 

Sp/DP~~~~~~~~~-
speed and display only affect the following methods. 

Cycle color 
This field is used in the CycleCol method and determines how quickly you 
want the colors to change. 

AAPlay - Speed 
This field is necessary as part of a AaPlay Video Event. Use it to govern the 
speed of the "Flick" file playback. Use speed 0 to play the .FLI or .FLC at the 
speed you set in the Animator program. 

AAPlay - Display 
"Flick" files can be made Permanent, Temporary, or Erasing. This setting 
effects your current palette because * .FLI and * .FLC files have their own 
palettes. If you make this a Permanent or Temporary Event, the palette 
changes and you have to reload a new palette or use the palette from the * .FLI 
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or* .FLC file. If you choose Erasing then the old palette is restored before the 
previous screen is displayed on the visible screen. 

Scrollup - Speed and Display 
The Speed setting here is used to detennine how fast the text scrolls up the 
screen. Choose a display. 

Ticker - Speed 
The Speed setting here is used to detennine how fast the text crawls across the 
screen. Choose a display. 

Parameters _________ _ 
Parameters vary depending on each method in this event. Apply the following 
parameters as necessary according to the method chosen. 

Set Mode Parameters 
Choose from a video mode. These parameters are dependent on the memory 

to support the mode you select, the hard­
ware to support the mode you select, and an 
image to display that is compatible with the 
mode you select. 

If you do not have EMS you may get very 
slow display or other unexpected results 
from using video modes above the IBM 
standard VGA modes. 

Color Cycling Parameters 
This field is used to detennine the beginning and ending colors and for the 
cycling. Color cycling is accomplished by rapidly applying all the colors in the 
palette to the screen. Color Cycling is available on display modes with 16 or 
256 colors only. 
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When the Cycle Color menu screen is first displayed, select the c0lorto be the 
beginning color in the cycle by moving your mouse right and left. When you 
see the color you want, press select or [Enter]. Repeat the process to choose 
the ending color. Now choose the number of color shifts you want. If you have 
a range of colors to cycle that is 15b to 25e in the default palette, it talces 10 
color shifts for the colors to return to the starting place. You can proceed to 
the next event after shifting any number of times. We have supplied you with 
the option of entering a "O" if you want a complete cycle. 

The color palette is rearranged by the LoadPal and CycleCol Events. If you 
load in anew palette when there is a VGA Graphic on the screen the new palette 
changes the appearance of the VGA Graphic before the next screen can be 
loaded. If you don't do a complete cycle, the colors in later Events may not 
appear as you expect. 

Video for lnfowindow Parameter 
Select this Parameter to malce the IBM Infowindow display show Video from 
the external source it is connected to. If there is no video coming into the 
Infowindow display, executing this event blanks the screen. 

Graphics for lnfowindow Parameter 
Select this Parameter to make the IBM Infowindow display show graphics 
from the PC. You can show CGA and EGA graphics with an Infowindow, but 
you cannot show VGA. This is a limitation of the Infowindow graphics 
hardware. Be sure you have selected the coriect video mode. 

Overlay for lnfowindow Parameter 
Select this Parameter to mix computer output with video coming in from an 
external source on the IBM Infowindow display. You can show 80 column 
text, CGA, and EGA graphics with an lnfowindow, but you cannot show 
VGA. This is a limitation of the Info-window graphics hardware. Be sure you 
have selected the correct video mode. Black (color 0) is the invisible color so 
every pixel that is black becomes transparent. 
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Reset for lnfowindow Parameter 
Select this Parameter Resets the Infowindow to a default condition. The 
default condition results in: Auxiliary output enabled, Transparency disabled, 
normal palette, normal graphics and video, composite input 1 enabled, 
interlace disabled. Please refer to your Infowindow documentation for more 
infonnation on reset. 

Scroll Up 
This field is used to set up the scrolling text. There are a series of parameters 
to set in this Video Method. When you enter the Parameters field as you first 
make the Event, you go through all the choices. When you edit the Parameters 
field, you have the choice of which part of the series you want to change. 

Position Parameter 
Use the mouse or cursor keys to place the text on the visible screen. Be sure 
to keep all of the text on the screen in the active Viewport. 

Color Parameter 
Select the color for the text from the image you have on the visible screen. To 
do this, move the mouse until the cross is over the color you want. When you 
see that the square borderaround the cursor is the color you desire, press Select 
or [Enter]. You can also select the color from a color palette. 

Width/Height Parameter 
Set the Width and Height with the mouse or cursor keys by stretching the box 
around the text on the screen. While you size the box with the mouse or cursor 
keys, notice that it moves in character based increments. This allows sizing by 
number of characters wide and number of lines high. 

Frame Parameter 
At this point, choose the option to have the scrolling text appear inside a border 
or not. Scrolling text appears in a rectangle of the color set in the Global Event 
under text background. 

Justify Parameter 
You can choose to have the lines of text in your scrolling text window justified 
to the Right, Left, or Centerof the window. Please keep in mind that TEMPRA 
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SHOW thinks spaces are characters, so if the justification does not look as you 
expected, check the end of the lines of text to see that there are not trailing 
spaces in the file. 

Ticker 
This field is used to move text across the screen like a ticker tape. There are 
a series of parameters to set in this Video Method. When you enter the 
Parameters field as you first make the Event, you go through all the choices. 
When you edit the Parameters field you have the choice of which part of the 
series you want to change. 

Position Parameter 
Use the mouse or cursor keys to locate the Ticker on the visible screen. Be sure 
to keep all of the text on the screen in the active Viewport. 

Color Parameter 
Same as scroll up color selection. 

Width Parameter 
Set the Width with the mouse or cursor keys by stretching the box around the 
text on the screen. While you size the box with the mouse or cursor keys, notice 
that it moves in character-based increments. This allows sizing by number of 
characters wide. If you change fonts, you should change the width of the box. 

Frame Parameter 
You can choose to have the ticker tape appear inside a border, or not. The text 
appears in a rectangle of the color set in the Global Event under text 
background. 

CegMode 
This field is used to set which CEO mode you want to activate. This mode 
setting must work in com bi-nation with the Video mode you have set and the 
method you used to create the images. For more information on CEO modes 
and images please referto the Edsun Documentation and data sheets. The table 
for the modes follows: 
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CEO MODE CEO methoo EDP Pixel Replication 
Mode 5 Basic 8 Mode 6 Basic 8 Yes Mooe 9 Advanced 4 Mooe 10 Advanced 
4 Yes Mode 11 Advanced 4 Yes Mooe 13 Advanced 8 Mode 14 Advanced 8 
Yes Mode 15 Advanced 8 Yes 
CEO Encoding methods with 8's in the name are for 256 color VGA Video 
modes, and those with 4's in them are for 16 color modes. 

VidWind Parameters 
Tue parameters VidWind events describe the location of the video window. 
You are asked for the location of the video window as you create the event. Tue 
screen clears and asks you to place the lower right comer of the video window. 
Use the mouse to position the video window bottom left comer. You are then 
asked to move the mouse to outline the area covered by the video window. As 
you move the mouse, a rectangle appears. The rectangle shows where the video 
window is located. When the rectangle is in the proper position, pressing select 
on the mouse or the [Enter] key will place the coordinates of the video window 
into the parameters field. 

VidTCol 
You choose the transparent color as you enter the event. Your choice may be 
from the screen or from a palette. If you are using a 256 color video display, 
you should load the palette of the images you want to use before picking the 
transparent color. 

AAP/ay Parameters 
Tue Parameters field holds the location you choose to show the .FLI and .FLC 
files. When you go to position one of these files you will see a ghost box. Where 
ever you place this box is where you will see the .FLI of .FLC play. 

Other Fields---------
Label, Next, and Wait For are events common to all lines. Review the Special 
Features Section and apply these events as necessary. 
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Global Event 

Chapter 21 
A Global Event 

Global events set the conditions for the entire sequence, or until you override the global within an 
event. For instance, you can set a global of .PCX files for screen images. All images files will have 
a .PCX extension. You won't see any images files with a .TGA extension until you use a Global 
event to select that file fmmat.lf you change the video mode to 16,000 color or 16. 7 million color 
mode, TEMPRA SHOW automatically sets the file format to .TGA. 

Type~~~~~~~~~~~~~~ 
Select Global from the Type menu. 

The on1 y Global setting that requires a file is the Font setting. Once this is set to the font you want, 
all Text Events and Menu Events are shown in this font, un1ess otherwise specified. 
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Method~~~~~~~~~~­
Reset All 
This resets all global values to their defaults. 

Color 
Determine all Text display colors: Text, Border, and Highlight. You see the 
style of text that is currently active in TEMPRA SHOW while you choose 
your colors. 

Font 
Determine the font that is used to show all text, unless a new font is picked in 
the Text Event, or Title Event. The font is also used in subsequent graphics 
menus. The current Global font becomes the default font. 

Drops had 
You can set a drop shadow to appear with all the text. Choose the X and Y 
offset and color. 

Auto set 
TEMPRA SHOW automatically adjusts the screen to the right resolution for 
the chosen image. 

Auto Off 
You can tum the automatic detection of screen resolution, and palette loading 
off with this selection. 

Delay 
Detennine a delay to slow down wipes, Sprite movement, or drawing. 

Scale On 
Set this to ensure that all screen images are automatically scaled to the visible 
screen if they have the right number of colors. 

Scale Off 
Set this to tum automatic scaling off. 
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Quick On 
Set this to maximize speed of full screen display when you do not have 
sufficient memory in your computer for the mode you are using. When this is 
set, TEMPRA SHOW ignores all wipe methods and brings your Screens to the 
visible screen as fast as possible. If EMS is detected then Quick On is ignored. 

Quick Off 
Set this to tum off the above Global command. 

Back On 
Set this to let your users Back Up through the sequence by labels using the [F9] 
key. This also allows them to skip ahead with the [F 10] key. When TEMPRA 
SHOW starts, the default for this feature is "on." It must be turned off if you 
want to disable it. 

Back Off 
Set this to tum off the Back On feature. 

Style2D 
Set this to get a 2 dimensional appearance to the text frames and menus. 

Style3D 
Set this to get a 3 dimensional appearance to the text frames and menus. This 
is the default when you start TEMPRA SHOW. 

Style TL 
Set this style to get the look of the TEMPRA SHOW GUI in text frames and 
and menus. 

PIC PCX 
Set this to tell TEMPRA SHOW to look for PCX files in the Screen directory. 

PIC CEG 
Set this to tell TEMPRA SHOW to look for CEG files in the Screen directory. 
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PIC TGA 
Set this to tell TEMPRA SHOW to look for 16- and 24-bit (16.7 million 
color) TGA files in the Screen directory. 

SPR PCC 
Set this to tell TEMPRA SHOW to look for PCC files in the Sprite directory. 

SPR CLP 
Set this to tell TEMPRA SHOW to look for CLP files in the Sprite directory. 

SPR WIN 
Set this to tell TEMPRA SHOW to look for 16- and 24-bit (16.7 million 
color) WIN files in the Sprite directory. 

Parameters _________ _ 
Colors Parameters 
When you set the global color parameters you set color for: 

1. Background color. This setting controls the color of the area behind the 
text character. 

2. Foreground color. This setting controls the color of the text character 
itself. 

3. Color from the graphics screen or a color menu. If you choose to get the 
color from the screen, you are presented with a cursor that has a square 
border. The cursor's border color is the selected color. Move the cursor 
over the color you want to select and press [Enter]. If you choose to pick 
the color from the color menu select the color you want from the colors 
in the smaller squares. 

Delay Parameters 
You can set the delay to be from 0 to 999 computer cycles. We have included 
this to allow you to slow the Drawing, Wipe, and Sprite speeds if you have 
a very fast computer. 
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Dropshad Parameters 
You choose the offset of the drop shadow in the X and Y direction, then using 
the color menu, or the image itself, you select the color for the drop shadow. 

Other Fields ________ _ 
Label, Next, SP/DP, and Wait For are events common to alllines. Apply them 
as necessary. 
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Chapter22 

Draw Event 

A Draw Event 

Draw events let you create basic shapes, like circles or squares, either filled or unfilled. You can 
use the shapes to contain text, graphics, or other image files . 

Type~~~~~~~~~~~~~~ 
After clicking or pressing [Enter] on the Type field, select Draw from the Type menu. The Draw 
event lets you create your own wipes with a background brush, make colored squares, lines and 
more. This is very useful in saving disk space. It also lets you make very powerful and exciting 
visual presentations. 

This field is used to detennine which of six different types of drawing tools you want to use. 

Line 
This draws a straight line between two points. 
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Circle 
This draws an empty ellipse. 

FCircle 
This draws a filled ellipse. 

Box 
This draws an empty rectangle using two comer points. 

FBox 
This draws a filled rectangle using two comer points. 

Set Brush 
This sets the size, shape, and color of the drawing tool. 

Freehand 
This lets you draw freehand designs on the screen. 

Parameters----------
The Parameters you choose are determined by what drawing method you are 
using. You are not be asked to select any parameters unless you select the 
circle, fcircle, box, fbox, or setbrush. 

Line Parameters 
You set the beginning position and ending position of the line by clicking two 
points on the screen with the mouse, or cursor keys (to move the screen cursor) 
when prompted. 

Circle Parameters 
You set the center position by clicking on the screen with the mouse, or cursor 
keys when prompted. You size the Circle with the mouse or cursor keys, as 
well. As you move the mouse, the ellipse is drawn on the screen so you can see 
what you are doing. 
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FCircle Parameters 
You set the center position just like sizing and positioning an empty circle by 
following the prompts and using the mouse, or cursor keys, to move the screen 
cursor. As you move the mouse, the Ellipse is drawn on the screen so you can 
see what you are doing. 

Box Parameters 
You set the lower left position, and upper right position when prompted on the 
screen and using the mouse, or cursor keys to move the screen cursor. 

FBox Parameters 
You set the lower left position and upper right position just like sizing and 
positioning an empty box by following the prompts and using the mouse, or 
cursor keys, to move the screen cursor. 

Set Brush Parameters 
Use this to set the shape, color, and drawing attributes of the Brush you are 
using. You are first asked to set the brush shape (either a Circle or a square). 
The next menu that appears is the attribute menu. Of five possible choices 
listed, AND, OR, and XOR are logic term and have specific meanings in 
computer science (When using these features, experiment. Experimentation is 
the best way to understand the effects these functions have on the objects 
drawn.)The other two are Background and Set. Background draws whatever 
you have in the background buff er. Set sets the color and size of the brush. 

Other Fields 
Label, Next, and Wait For are events common to all lines. For more 
information on these events, please refer to the common events unit. 
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A Music Event 

Music events control sound from the basic speaker found in every PC. No special hardware is 
needed to create Music events (you can create music using the keys on the keyboard as piano keys). 
This event can also play music while other Events occur, and do sound effects. The music files 
are Text files; ASCII text files with a suffix .MUS These files should be located in the Audio 
directory. 

Type~~~~~~~~~~~~~~ 
When the field cursor is in the Event Type field and the menu pops up, highlight "Music" and press 
[Enter]. Your choice in the event field 

If the Music method that you specified requires a filename, you see a list of available Music files. 
If the Music file you wish is not in the directory, you have to Change the Path to find it, or make 
it with your text editor. Highlight a file and Press [Enter]. 
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Tone 

Play musical notes using the musical infonnation in the Parameters 
field. 

Playfile 
Play musical notes using the infonnation contained in a text file. 
The name of the file should be in the File column. 1his method uses 
the text file lines specified in the Parameters field. 

Kill 
Tenninate any musical notes that are being Played in the back­
ground, that is, Music being played with the MB command which 
allows the Music to play while you show other Events. 

Play a tone with a frequency for the duration given in the Parameters field. 

Tonefile 
Play musical tones using the infonnation contained in a text file. The name of 
the file should be in the File column. This method uses the text file lines 
specified in the Parameters field. 

Freq 
Sets the speaker frequency to the fre­
quency given in the Parameters field and 
durations specified in a text file. Atthe end 
of the duration, control reverts to IBMPRA 
SHOW. With Freq and Tone the speaker 
must be on or you won't hear anything. 
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Freqfile 
Set the speaker frequency to the frequencies for the durations specified a text 
file. The name of the file should be in the File column. This method uses the 
text file lines specified in the Parameters field. 
The speaker must be ON or you won't hear anything. 

Speaker 

Loop 
Set the number of times for the next background music line to repeat. A 
background music line is a single Play Parameters field or a single PlayFile 
line that contains the "MB" command. 

Parameters----------
Play Parameters 
Play musical notes using the information in the Parameters field. 

Playfile Parameters 
The Parameters field specifies the start and ending lines of the musical 
information to be played from the text file. Firsthighlightthe text line you want 
to start playing, then press [Enter]. Then highlight the text line you want to 
end playing, and press [Enter]. 

Kill Parameters 
The Parameters field does not apply to the Music event with a Kill method. 

Tone Parameters 
Play a tone with the frequency for the duration given in the Parameters field. 

Tonefile Parameters 
The Parameters field specifies the start and ending lines of the information in 
the text file to be played as tones. First highlight the text line you want to start 
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playing as tones, then press [Enter]. Then highlight the text line you want to 
end playing, and press [Enter]. 

Freq Parameters 
Set the speaker frequency to the frequency given in the Parameters field. The 
duration of the frequency, also in Parameters field, tells the system how long 
to wait before bringing control back to TEMPRA SHOW. The speaker must 
be on or you won't hear any frequencies. 

Freqfile Parameters 
The Parameters field specifies the start and ending lines of the information in 
the text file to be played as frequencies. First highlight the text line you want 
to start playing as tones, then press [Enter]. Then highlight the text line you 
want to end playing, and press [Enter]. The text file sets the speaker frequency 
to various frequencies, each for a specified duration, using the information 
contained in a text file. The duration pertains to the length of time from the 
start of the frequency to the time control returns to TEMPRA SHOW. The 
speaker must be on or you won't hear any frequencies. 

Speaker Parameters 
On 
You must tum the speaker on before you can play Frequencies. When you 
tum this on, you hear the Frequency that the speaker was set to last. 

Off 
Tum the speaker off to stop the Frequencies. 

Loop 
Set the number of times for the next background music line to repeat. A 
background music line is a Play parameters field or a PlayFile line that 
contains the "MB" command. 

Other Fields ____ ____ _ 
The Label, Next, SP/DP, and Wait For fields common to a111ines. Apply these 
as necessary. For more information on these fields, please refer to the section 
on common fields. 

TEMPRA SHOW Reference 



~::::::::m.m::::::::::::::::::::::::::w: 
~:::::;::•11:::::::::1::::::::::l 
:::::::::::11m::::::::1:::::::::::::m 

1:::::::::1118.1::::::::::::::::::::::::::::::::::::::::::@ 

Audio Event 

Chapter 24 
An AudioEvent 

This chapter does not follow the same line structure typical of the rest of this manual although it 
is very similar. The commands that are in the Audio event line are also the same commands in the 
Audio menu in the Main Menu. Audio events let you play or record sounds on the hard disk using 
a Sound Blaster card or any other supported card. 

Type~~~~~~~~~~~~~~ 
This event allows you to Record and Play sound files during a Sequence. The sound capabilities 
of TEMPRA SHOW are relative to the type of sound board you have. Once you select an audio 
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event, a menu appears with five choices. 

Play 
A menu of available audio files appears. Depending on the 
audio board and what boards and drivers you've selected in the 
CONFIGTS, only the files with the proper extensions (i.e. 
*.WAVor*.VOC) will appear. Select a file. From this point, 
TEMPRA SHOW moves on to the common elements. 
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Record 
The primary use of this feature is to provide you with a resource for your own 
audio files. Recording can also be done (probably easier) from the Audio menu 
on the Main menu at the top of the screen. Actually leaving an Audio Record 
line in your sequence is not recommended .. 

After selecting Record, the field cursor jumps back­
ward to the File field and you are asked to enter a file 
name. The next menu is a list of sound speed in terms 
of Bits Per Second (BPS). Choose from 8kHz, 16kHz, 
and 32kHz. One of these choices must be made for the 

Play Method to work. The number you choose must match the number after 
the .S _ in the name of the file you chose for the file to play correctly. kHz 
stands for kilohertz, or thousandths of cycles per second. Select a speed. After 
the Next field, TEMPRA SHOW will record your input sound source. Again, 
this is directly related to the sound board being used. 

Playasnc 
The list of appropriate files appears, again, relevant to the board type. Choose 
a sound file to Play. Playasnc audio events will play simultaneously with other 
events. When you play audio asynchronously with other events and the sound 
is "broken" or skips, set Blast_Buf in the CONFIG.SYS for smoother audio. 

Playtext 
This method allows you to create audio output from ASCII text files stored 
in your audio directory. This will electronically articulate letters and words 
with the TI Speech audio board only. 

Quiet 
Adding this line some where after a Playasnc line will instantly stop any audio 
playing. Also, selecting quiet from the audio menu in the main menu will stop 
an audio file from playing while you are writing your sequences. 

Other Fields ________ _ 
Label, Next, and Wait For are events common to all lines. 

TEMPRA SHOW Reference 



::::::::::::::::::::::::::::::::m '=f===:===; ::::=::m.11::::::::::::::::::::::::::1::::::1:::::::::::::::::::::::::: 

:::::::::::1.111n&:::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::11:::::::::::::: 

:;:::;:::111111::::=::::::::::::::::::::::::::::::::::::::::11::::::::::::~:::::::::::::~:1:::::::: 

:::::::::::11111::::::::::::!:!::::· :·::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::~:::::1;:::;: 
=::::::::::1111:::::::::::::::::=::::::::;:::,::::::::::::::::::::::::::::::::::::::::::::::::::::::rm:::::: 

:::::::::::1•11:::::::::::::::::::::,:,,::::,:,:::::;::::::::::::::::::::::::::::::::::::::::::::::~:::~;;::~:;: 

~:i 
_,_•i 
:::::::::::111::::::::::::::::::;::::::::;:::::::::::::::::::::::::::::::::::::::;::::::::;;;::;::::::::::::::::::::: 

MIDI Event 

Chapter25 
A MIDI Event 

Midi events let you play back audio created as MIDI files. In order to play MIDI files, you will 
need an appropriate driver for your sound board. 

Type~~~~~~~~~~~~~~ 
Qick or press [Enter] over the Type field and a menu appears, select MIDI. 

File~~~~~~~~~~~~~~~~ 
Play 
On selecting this option, the *.MID files in Audio directory are shown to you. Choose a MIDI 
file to Play by highlighting your choice and pressing [Enter] or double-clicking the mouse. Once 
you do this, you will automatically advance to the next menu. Please note you have to make 
your Midi files with a system other than TEMPRA SHOW before you try to play them with 
TEMPRA SHOW. 
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Play 
This Method allows you to Play an Midi file during a 
sequence. 

Stop 
This method allows you to Stop the Midi file from playing 
back during a sequence. If you have Stopped the Midi 
playback you can restart it with a separate Continue line. 

Continue 
1 ms memoo allows you to restart the playback of a Midi file that has been 
stopped with the STOP method. 

Quiet 
This method allows you to Quiet the playback of a Midi file. You cannot 
restart the playback if you have used Quiet. 

Other Fields ________ _ 
The events that do not apply to this line are SP/DP and the Parameters events. 
They have been skipped. Label, Next, and Wait For are events common to 
all lines. Apply them as necessary. 
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CD ROM Event 

Chapter26 
CD-ROM Event 

This event allows you to Play and control audio tracks recorded on a CD-ROM during a 
sequence. 

Type~~~~~~~~~~~~~~ 
Oick or press enter over the Type field and select CD-ROM. Press [Enter] in the Type field, and 
you see the menu for the Method field. 

MethO--~~~~~~~~~~~~~­
Play 
This Method allows you to Play an audio bite from a CD-ROM during a sequence. The playing 
commences where the play head is positioned. You should use the Search Method first to position 
the play head over the section of a particular track you want in your sequence. 
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Playrang 
This Method allows you to play a range of audio tracks from a CD-ROM 
during a sequence. CD-ROMS are designed so there are tracks which contain 
audio, but each track is subdivided into smaller, precisely accessible units. 
This makes for very tight editing of sound and music bites. To get to a place 
within a track, you have to locate it in terms of minutes, seconds, and frames 
(divisions of seconds). A CD-ROM may contain many tracks. Each track 
strarts at zero minutes:zero seconds:zero frames, 00:00:00. 

Seek 
You can position the play head before you choose to play. This is a good 

idea because some CD-ROM players are not very fast at finding programmed 
tracks. By pre-positioning the play head, you can get the audio to start with 
the Play Method exactly when you want it to. Remember, you can designate 
exactly where you want the play head to be positioned. To do this, tell 
TEMPRA SHOW what track number you want and how far into that track 
you want to go. 

Pause 
You can suspend the playback of audio from the CD-ROM. Once the Pause 
Method is executed you can restart the audio playback with Play or Continue. 
(Use the one that works in your CD-ROM player. They are not all the same.) 

Continue 
Once the playback of the CD-ROM audio has been Paused, you can restart 
the playback with Continue. The CD-ROM Method allows you to continue 
playing you preselected audio track from the CD-ROM. 

Stop 
Use Stop to make the playback of the CD-ROM audio stop. After you use 
this Method you need to use Play to restart the playback of audio. Most often 
you would perform a Stop, then a Seek, then a Play. You might also execute 
a PlayRang. 

Load 
Some CD-ROM players support a computer controlled Load command. If 
yours does, this method gets the disk up and running. 
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Eject 
Use this method to eject the CD-ROM. Naturally, this causes the playback 
of audio to stop, and the user can change disks at this point. Eject is the 
opposite of Load and when used together automates the users changing of CD­
ROMs. 

Parameters. __________ _ 
The following only apply when you use the PlayRang and Seek Methods. 

Play rang 
When you are using the PlayRange Method of the CD-ROM event you have 
to designate the range you wantto play. Select the track number, then the place 
on the track, i.e. seconds or frames, you to start from. These places are 
described in terms of the time ittakes to get to them from the start of the track. 
For example you can start 2 minutes, 30 seconds into the track. If you need 
to choose a place that is between the second markers select a frame. There 
are 75 frames to a second. Since you are playing a range you also have to set 
the end point for the audio to stop. This end point is also described in terms 
of tracks, minutes, seconds, and frames. 

Seek 
When you are using the Seek Method of the CD-ROM event, you have to 
designate the place on the ROM where you want to position the play head. 
Select the track number, then the place on the track you to be. These places 
are described in terms of the time it takes to get to them from the start of the 
track. For example you can start 2 minutes, 30 seconds into the track. If you 
need to choose a place that is between the second markers select a frame. Once 
the play head is positioned, you can use the Play Method and the audio will 
play from exactly where you have positioned the play head with the Seek 
Method. 

Other Fields---------
Label, Wait For, and Next are fields common to all lines. Apply these events 
as neccessary. 
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Chapter 27 
VCR Event 

Use this event to control a SONY V deck. You can play segments from Hi-8 videotapes or you can 
record your sequence directly to a Hi-8 tape for mass distribution. You must use a Video Window 
event line prior to viewing your tape. 

Type~~~~~~~~~~~~~~ 
Select VCR from the Type menu by clicking on the Type field. 

TEMPRA SHOW automatically enters "Deck l" into this field and moves on to the method field. 
If a message appears saying "O VISCA DECKS FOUND," follow the Vdeck manual to ensure 
correct cable attachment. Also, be sure that the VISCA deck protocol is selected in the 
CONFIGTS.EXE. This is in the parameters settings under VCR Type. 
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Method~~~~~~~~~~­

:::::::::::::::::::::::::::i:::ilillllll:::::::::::::::::::::::i:::::::i:::::i:::::::::;::::~:i::::::::~:: 
Once TEMPRA SHOW has "found" a VISCA deck, it 
assumes control of the deck functions. Nonnal modes of 
operation directly from the V deck are now controlled by the 
computer and TEMPRA SHOW. 

27-2 

Search 

Play 
Tirls sets the tape in motion for standard viewing. Where 
ever the tape was last stopped is what will be played. 
Parameters will not apply. 

Stop 
Use this command to stop nonnal tape operation. Param­
eters will not apply. 

Rewind 
Use this to rewind the tape. Parameters will not apply. 

Use this to find specific segments offootage to be shown. Once you have found 
the section, be sure to 
note its beginning(the 
numbers of the time 
stamp in the menu 
window). You'llneed 
to know these times if 
you intend to use a 
Play Seg type line. 

Be sure you are using video tapes that have a time code recorded throughout 
the entire length of the tape, even if you have only recorded a few minutes of 
video on a two-hour tape. If you do not, and the VIS CA device plays beyond 
your time code, the device will automatically fast-forward in search of the 
starting point of the time code. Tiris could take to the end of the tape with little 
or no time to completely rewind during the execution of a sequence. 
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Pause 
This pauses the tape. Parameters do not apply. 

Play Segment 
This method allows you to play a very precise amount of video exactly where 
you want it in your sequence. Used in conjunction with search methods, you 
can use several segments of one tape. 

Record 
This will record onto the tape any video signal coming into the V decks video 
input ports. Using IBMPRA SHOW and any video board with video out 
capability (i.e. the Cardinal SNAPplus board), you can record your se­
quences to a Hi-8 master tape for mass duplication and distribution. 

Zero_HMS 
This function returns your hours-minutes-second counter to zero. 

Parameters---------­
Search Parameters 
A V deck controller menu appears. The buttons on this menu will control the 
V deck to search the tape for a specific place or segment. To prevent delays 
in your sequence, tell IBMPRA SHOW and the V deck to search for a certain 
place on the tape well in advance of the time when you intend to play it. 

Play Segment Parameters 
AV deck controller menu appears for you tp search and find the starting point 
for the segment to be played. Find the starting place and press [Enter]. 

The next menu to appear asks you to find the ending point of the video 
segment. Find this point and press [Enter]. 

During the sequence IBMPRA SHOW will automatically search for this 
segment once the line i executed. You may want to use a search line several 
lines prior to avoid a delay in your sequence. 
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For the most part, wait for is like any other line. If you are going to play a 
segment, you must add a Time out period so IBMPRA show will not go on 
to the next line and not show the segment. The V deck will play, but you will 
not see anything. 

Common Fields--------
Label, Next, and Wait For are fields common to all lines. Apply them as 
necessary. 
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Technical 
Information 

This chapter contains infonnation on certain technical aspects of IBMPRA SH OW in respect to 
your PC. The section on CONFIGTS is especially important. Should you need to call our Tech 
Support line (1-813-682-1128) being familiar with this section can make your call to more 
efficient and effective. 

TEMPRA SHOW Configuration Program __ _ 
The CONFIGTS.EXE program is used to change the contents of the TSHOW.CFG file. The 
TS HOW. CFG file contains many of the controls that determine how IBMPRA SH OW operates. 
These controls have defaults set by Mathematica, Inc. The defaults set by Mathematica, Inc. 
should operate on most computer systems. You have to change the settings in TS HOW .CFG using 
CONFIGTS.EXE if: 

1. You have a special device attached to your computer such as a touch screen, VCR, special 
display board, audio board or other device. 

2. You add or change a device attached to your computer. 

3. You want to change the colors used on the workfonn. 

4. The current configuration produces a conflict and IBMPRA SHOW does not work properly 
or does not work at all. 
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TEMPRA SHOW reads the TSHOW.CFG file when TEMPRA SHOW is 
run. The TSHOW.CFG file tells TEMPRA SHOW the devices attached to 
your computer and any other specific infonnation needed. If that infonnation 
is incorrect, TEMPRA SHOW may have erratic results or may stop running 
completely. IfTEMPRA SHOW does not run, you should check the contents 
ofTSHOW.CFG for conflicting infonnation. For example, having two serial 
port devices set to use the same serial port will cause TEMPRA SHOW 
problems. 

You may view the TSHOW.CFG file by "typing" it to your screen or printing 
it. To print this file, be certain you are in the directory with TEMPRA SHOW. 
At the DOS prompt type: Print TSHOW. CFG and press [Enter] 

When DOS asks the device name, press enter to use the standard printer 
(PRN). The printer prints a complete list of the contents of TSHOW.CFG 
including all the values set. 

The selections available in CONFIGTS.EXE may not be appropriate to all 
versions ofTEMPRA SHOW. Some functions and devices are not supported 
but do have choices presented to you in CONFIGTS. These devices and 
settings were used in earlier versions or are being held for latter versions. 

To start CONFIGTS.EXE, be certain you are in the directory containing 
TEMPRA SHOW (\TEMPRA) and type: CONFIGTS and press [Enter] 

The opening menu of CONFIGTS.EXE appears on your screen. The five 
choice available are: 

Colors 
Parameters 
Load Setup 
Save Setup 

View Setup File 
Quit 

You may move though the list by using the up and down arrow keys or by 
using a mouse. If you use a mouse, the left button acts as if it were the enter 
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key and the right mouse button acts as if it were the Escape key (Esc). Selecting 
Colors allows you to change the colors on your workform. Parameters 
changes the parameters and settings used by TEMPRA SHOW when it first 
starts and while it runs. Load Setup loads the copy of TSHOW.CFG that is 
on your hard disk and Save Setup saves it back to your hard disk. 

The View Setup File option displays the TSHOW.CFG on your screen. Quit 
stops the CONFIGTS program and returns you to DOS. You can run the 
CONFIGTS program from within TEMPRA SHOW by selecting configure 
while in the work.form menu. When you quit CONFIGTS you return to 
TEMPRA SHOW if that is where you started. 

Colors 
The Colors selection leads to a menu where you may adjust the colors used in 
the work.form. You may not adjust the colors used on the Graphical User 
Interface (GUI). The colors that are used on the workform when TEMPRA 
SHOW starts have been selected to provide a easily visible display. You may 
change the colors to suit your taste. 

Parameters 
The parameters menu allows changes to the devices, addresses and controls 
used by TEMPRA SHOW. CONFIGTS.EXE presents the choices as a list. 
You may move through the list using the mouse or the cursor keys. When you 
find a setting you want to change, press enter or the right mouse button to see 
the options available to you. Some options provide for a choice and some 
options ask for a specific value to be entered. 

Joystick Param 1, 2 and 3 
If you have a Joystick rather than a mouse, you may adjust the sensitivity of 
the joystick here. The parameters used are for the Kraft Joystick. The first 
parameter adjusts the wait between writing to the joystick while the second is 
the wait between reading the joystick port. The third parameter adjusts the 
wait between reading the joystick port and doing the next action. The range for 
each value is 0 to 255. The values must be typed into the box displayed. 
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Videodisk Serial Port Com Port Parameter 
(llisselectionisnotusedinthisversionofTEMPRASHOW.Itmaybeadded 
to TEMPRA SHOW in a future version. Check your supplemental documen­
tation material or contact Mathematica, Inc. technical support.) If your 
system has a videodisk and this version of TEMPRA SHOW supports a 
videodisc, you must set the serial and com port parameters. The choices for 
serial port are COMl 3FXB, COM2 2FX, COM3 2E8, COM4 2EO, orO NOT 
INSTALLED. The default is 0. The Com port parameter has a range of 0 to 
FF (Hex). Check the documentation for your videodisk for more information. 

Audio Board Type 
If your computer has an audio board, this parameter selects the type of board 
used. The choices are: 

0 No Sound Board 
1 Watson Board (old) 
2 TI-Speech Board 
3 Watsonll Board (new) 
4 Online Board 
5 Wang Freeslyle Voice 
6 Sound Blaster 
7 MicroKey 
8 MicroHelp 
9 Voyetra 

Select the type of audio board in your computer by moving the highlighted bar 
to the correct board and pressing [Enter]. 

Gain (Tl/Online) 
(For the Tl or Online audio board, you can adjust the gain setting. The range 
available is 0 to 10. 

Volume (Tl/OnlineNoyetra) 
Volume is available for sound boards that use Voyetra drivers only. For 
Voyetra the range is 0 to 127. Tl Key Option 
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Tl Key Option 
For the Sound Blaster and sound boards that use Voyetra drivers you have a 
key option. This option will cause TEivfPRA SHOW to stop playing sound 
when a key is pressed. This is used only when the Play choice is used not 
Playasync. 

Touch Screen 
For systems that have a touch screen, this parameter allows the selection of 
the type of touch screen. The choices are: 0 No Touch Screen 1 Sony PVM-
1911 2 Info Window 3 Micro Touch 4 Tektouch 5 Elographics Choose the 
screen you have attached to your computer. 

PIB 1/0 base Address PIB Segment Address 
(ThisselectionisnotusedinthisversionofTEivfPRASHOW. Itmaybeadded 
to TEivfPRA SHOW in a future version. Check your supplemental documen­
tation material or contact Mathematica, Inc. technical support.) 

Video Brightness, Hue, Contrast, Saturation 
These four parameters are used by the SN APplus and the Video Blaster image 
capture boards. You may adjust the levels of brightness, hue, contrast and 
saturation for video as it enters the board. To see what they look like, use the 
capture feature from the TEivfPRA PRO video menu. 

Watson Com Port 
This selection is not used in this version of TEivfPRA SHOW. It may be added 
to TEivfPRA SHOW in a future version. Check your supplemental documen­
tation material or contact Mathematica, Inc. technical support. 

Video Input Standard (NTSC/PAL) 
This parameter allows you to adjust the type of video that TEMPRA SHOW 
expects to receive on an image capture card such as the SNAPplus. NTSC is 
the United States standard for video while PAL is the European standard. 
RGB input can have the Sync line be separate or on the green line. This is the 
difference betweenRGB_SEP _SYNC andRGB_SYNC_GREEN. Compos­
ite and Svideo are also separate video input methods that can be NTSC or 
PAL. The choices are: 
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Ox15 RGB_SEP _SYNC NTSC 
OX25 RGB_SYNC_GREEN N TSC 
OX35 COMPOSITE NTSC 
OX45 S_ VIDEO NTSC 
Ox16 RGB_SEP _SYNC PAL 
OX26 RGB_SYNC_GREEN PAL 
OX36 COMPOSITE PAL 
OX46 S_ VIDEO PAL 

Audio INT/IMA/IRQ 
This parameter is intended for those who have a Audio board that has been 
moved to a non standard address or had other parameters changed. You may 
enter your own parameter or select one of the two provided parameters used 
with the MicroKey. 

Touch Screen Serial Port 
This parameter sets the serial port used by your touch screen. The choices start 
at COMl and go to COM4 or no touch screen. You must set the COM port to 
where your touch screen is connected. 

Touch Screen Indicator 
This indicates the results of touching the screen. The choices are: 

0 - Just Process Touch 
1 - Beep on Touch 
2 - Highlight Touch 
3 - Beep and Highlight Touch 

VCR Type 
If your computer has a Sony Visca controller, you can select this parameter. 
The choices are None or VISCA. If this parameter is set to on, TEMPRA 
SHOW can use a Sony Visca controller. 

VCR Port 
You choose the port where the VIS CA controller is located. The choices are 
Port 01 to Port 1 1. Until you save the setup, no changes made using the 
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CONFIGTS program take effect. If you are unsure about an option or do not 
know specific infonnation, you may quit CONFIGTS without making 
changes to the TSHOW.CFG file. 

Contents of the TSHOW.CFG File 

Ox70 
Ox71 
Ox4f 
Ox24 
Ox le 
Ox3e 
Ox71 
Oxl7 
Ox le 
Ox70 
Ox4f 
Ox4f 
Ox4e 
Ox71 
OxOe 
Oxl7 
Oxl7 
Oxl7 

0 
0 
0 

menu border color ] 
menu-text color l 
menu-bar color l 
request text color J 
request-border color 
request-hlight-color 
form hlTght coTor ] 
form-norm color l 
dir Eorde-color ] 
dir-text color l 
dir-bar color l 
error text color l 
error-border color 
info Tine color ] 
form-prev-color ] 
form-color l 
help-bord color ] 
help-text-color J 
0 = no jostick 5 = joystick 
0 = no jostick 80 = joystick 
0 = no jostick 150 = joystick 
videodisc serial port address (hex) 
videodisc com port param (hex) ] 

OxOOOO 
OxOOOO 

6 [ audioboard O=none l=Watson 2=TI-Speech 3=WatsonII 
4=0nline 5-Wang 6=SndBlast 7=MicroKey] 
[ ti [0-10] or online [0-7] board gain setting) 10 

127 
1 

[ ti [0-10] or online [0-7] board volume setting) 
[ audio key option O=abort any l=enable func abort 
nonfunc 2=enable func 3=no abort] 

0 [ O=no touch screen l=sony pvm-1911 2=infowindow 
3=MicroTouch 4=TekTouch] 

Ox03a8 [ PIB I/O base (hex) ] 
OxdOOO [ PIB address segment (hex) ] 

50 [ Video brightness (dee) 0-100 
50 [ Video hue (dee) 0-100 ] 
50 [ Video contrast (dee) 0-100 ] 
50 [ Video saturation (dee) 0-100 
2 [ Watson!! Com Port (1 or 2) ) 

Ox35 [video input Ox35=NTSC comp Ox45=NTSC S-Video 

1000 
-07 
OxOO 
Ox2f8 
Ox03 
OxOl 
Ox02 

Ox36=PAL comp Ox46=PAL S-Video ) 
[ EMS to Use (in K) ) 
[ Audio INT/DMA/IRQ l 
[ Videodisc Type ) 
[ Touch Screen Serial Port J 
[ Touch Screen Indication 
[ OxOl=VISCA ) 
[ PC-VCR Serial Port ) 
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Config.sys and the Autoexec.bat 
During installation, TEMPRA SHOW automatically updates and changes 
your autoexec.bat and config.sys if necessary. The following samples repre­
sent the most "vanilla" form of these two files. 

Config.sys 
BUFFERS=30 
FILES=30 
DEVICE=C:\DOS\HIMEM.SYS 
DEVICE=C:\DOS\EMM386.EXE NOEMS X=AOOO-BFFF 
l=EOOO-EFFF 
DOS=HIGH,UMB 
DEVICEHIGH=C:\DOS\SETVER.EXE 

• Buffers do not have to be set at "30" 
• Devices loaded after "DOS=HIGH,UMB" should be loaded high, but do 

not required. The statement used to load devices high should begin 
"DEVICEHIGH" 

• Loading devices "HIGH" will free up conventional memory. This is 
especially useful when driving audio boards with the Voyetra drivers. 

Autoexec.bat 
ECHO OFF 
PROMPT $p$q 
PA TH C:\;C:\DOS;C:\TEMPRA;C:\CINE; 
SETTMP-C:\ 
SET EDITOR=TEXTEDIT 
SET PROGX=CINE 
SET W MODE=SGA 2E 
SET W LINES=200 
SET BLAST BUF= 10 
SET SPRITE BUF=lO 

Several of these commands are place into the autoexec.bat during installation 
ofTEMPRASHOW.Theseinclude:SETTMPSETEDITORSETPROGX 
SET WMODE SET TEMPRA SHOW AINT 
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The remaining set commands are optional. They are used to allocate a ##K 
buffer size for audio (BLAST BUF) and for sprites (SPRITE BUF). 

Troubleshooting TEMPRA SHOW _ 
IfTEMPRA SHOW does not start properly, there are anumberof actions that 
can be taken to correct the problem. TEMPRA SHOW should start the first 
time, display the copyright information and wait for the user lo press [Enter] . 
When that does not happen, the following should allow you to find the 
problem and fix it: 

1. Check the amount of memory available. TEMPRA SHOW requires 
about 500Kb of memory in the standard DOS memory area. A total of 
525Kb is preferred. TEMPRA SHOW will also use EMS or XMS 
memory. If you have a 286 class computer, you should add a LIM type 
memory manager. On 386 and higher level processors, XMS will be 
adequate. Check for TSR programs that are not being used, device drivers 
and other programs that use memory in the 0-640K area. TEMPRA 
SHOW does not need the Smartdrive device to run. If you are still low on 
memory, you can cut down on the amount of memory used in TEMPRA 
SHOW by restricting the number of lines used in each sequence. The 
default number is 500 lines. The number of lines is limited by a set 
statement called "VVLINES . "To change to fewer lines, add a statement 
to your AUTOEXEC.BAT file that looks like this: 

SET VVLINES=lOO 

This will restrict the numberof lines to 100. Cutting down on the number 
of lines will cut down the amount of memory needed by TEMPRA 
SHOW. 

2. Be certain the type of display specified during the installation of 
TEMPRA SHOW is the correct display. This variable is set in 
AUTOEXEC.BAT and looks like this: 

SET VVMODE=VGA 13 
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If this is set incorrectly TEMPRA SH OW does not work properly. To test 
this,changetheAUTOEXEC.BATfilesothatthereisno'SETVVMODE' 
statement. An alternative way of testing is to type 'SET VVMODE=' at 
the DOS prompt and then run TEMPRA SHOW. IfTEMPRA SHOW 
runs, the problem is the set statement. To find the proper set statement, try 
different video modes from within TEMPRA SHOW. Create a set 
statement in your AUTOEXEC.BA T with the video mode that works best 
for you. 

3. The TEMPRA SHOW set up program CONFIGTS.EXE has settings in 
it that conflict with your computer. CONFIGTS.EXE changes the file 
called TSHOW.CFG. When TEMPRA SHOW starts, it reads 
TSHOW.CFG and acts accordingly. If you have changed your settings 
using CONFIGTS.EXE or the default setting provided with TEMPRA 
SHOWarenotcorrectforyourcomputer, TEMPRASHOWwillnotrun. 
To test this error, rename the file TSHOW.CFG to a file called 
XTSHOW.CFG and start TEMPRA SHOW. If TEMPRA SHOW runs, 
there is a problem with the settings in the TSHO W .CFG program. To cure 
the problem, rename the XTSHOW.CFG file to TSHOW.CFG and run 
the program CONFIGTS.EXE. In the CONFIGTS.EXE program, tum 
off all the devices that you may not need such as touch screens, PC-VCR 
or other devices. If the three steps listed above do not solve the problem, 
you may n~d to contact Mathematica, Inc. Technical support. 

More Troubleshooting _____ _ 
In the process of making sequences you may get an occasional error message. 
These messages are stored in a file called TEMPRA SHOW.ERR that is made 
while TEMPRA SHOW is running. Please have that file available when you 
call us. It will help us to solve your problem. 

Many of the problems and inconsistencies you are likely to see are a result of 
insufficient memory. 

If you are getting "File too large" messages when you are trying to load 
Sprites you are out of memory, and do not have enough room in your PC for 
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the Sprite. It is very hard to tell if your Sprite file is too large by looking at the 
size of the file as it is saved on the disk. This is because the Sprites are saved 
as compressed images, and they decompress aher they load into memory. The 
rule of thumb here is to make the Sprites for 256 color images no bigger than 
the 320x300 256 color screen. 

The Text Event Width/Height screen does not clear to reveal your graphic 
screen. This is due to lack of free memory. You are in a mode that takes up too 
much memory to allow TEMPRA SHOW to keep a good copy of your graphics 
screen in memory. 

If you get the message "Error creating mask for * .PCC" this is due to the 
video mode. The sprite you selected from the Sprite directory menu is made in 
a mode that is not the same as the current video mode. 

If you are using TEMPRA SHOW without EMS, you can get more memory 
space by reducing the number of files and buffers in your Config.sys file. We 
recommend not going below 10 files and 10 buffers. Also set your VVLINES 
and SPRITE B UF and TMP Environmental variables to maximize the system. 
Also use few if any Pennanent events. Rememberthat Super VG A modes will 
not work quickly without EMS. 

Funny or ''solarized" colors on the graphics screen. The VGA system uses 
color palettes to show the best 256 colors for your image. All images do not 
have the same colors. When the colors change from screen to screen it becomes 
necessary to provide the ability to load in a new set of 256 colors. This set of 
colors is a palette. If you load a palette for image 2 while image 1 is still on the 
screen, the colors of image 1 will go weird. To avoid this, show a color 
background (BColor), then load in the new palette. Finally load in image 2. 

Palette loading does not work. If you have an early version of PC Paint, or 
PC Paintbrush, the PCX images were not saved with their palette information. 
The solution is to go back to your old version of the paint program, and load 
in your image. When it looks right, use a new screen grab program to save the 
image with the palette in it. 
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Installing EMS. If you do have EMS please do not install it at AOOO, because 
that is where Your VGA card is. 

Can't find the file you want. Make sure the file is in the directory that the 
*.PTH file is telling IBMPRA SHOW to look in. Get to the Path menu and 
modify the path to the directory where your file is stored so IBMPRA SHOW 
can find it. 

Your paint program does not make PCC files. If you have saved a picture 
clip to be used as a Sprite in IBMPRA SHOW, and it has been saved as a PCX 
file, you have to rename it as a PCC file. Do this with the following DOS 
command: "RENAME {filename}.PCX {filename}.PCC." For example: 
RENAME FLOWER.PCX FLOWER.PCC. IBMPRA PRO and IBMPRA 
GIF save * .PCC files 

You are getting Unexpected end of file on your path files (* .PTH) or the 
configure(* .CFG) file. This happens as a result of modifications being made 
to these files with a text editor (word processor) that were not correct. Do not 
use a word processor to edit *.CFG files. 

Error messages are just numbers or don't look like English. This is 
probably a result of corruption of the MESSAGE. W file. 

EDITOR does not work. There are a number of possible causes. Your 
EDITOR environmental variable is not set. Set it by adding the following line 
to your Autoexec.bat file: 

SET EDITOR = {editor name}. 

You must also have to have the editor where you can find it. Either by setting 
the DOS path command, or by putting it into the same directory where you 
have IBMPRA SHOW. 

Another possible cause is that there is not enough room in memory for WP and 
the Editor. If this is the case you will see the DOS message: Program too big 
for memory. 
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If you have a digitizing tablet and WP does not work, this may be due to 
conflicts between the table driver and the mouse driver TEMPRA SHOW is 
expecting. If you have a MS mouse driver for the tablet use that, and you can 
drive TEMPRA SHOW with your stylus. 

Super VGA modes do not work. We do not support all super VGA boards. 
We will continue to improve the system. 

The System is slow. Without EMS TEMPRA SHOW will not be fast in 
Sprite movements or wipes. To speed up the wipes you can set the Global 
Method Quick ON. This speeds up the wipes by only using the Quick wipe. 
Be aware of the memory constraints and optimize your system with the 
environmental variables. If you have EMS and the system is slow this could 
be because you have too many Erasing or Permanent Events, use Temporary 
Events when possible. 

You can't see anything on your monochrome monitor. Please use the 
CONFIGTS program to set the workform colors so you can see the fields, 
cursor, menus, and highlight. We would like to encourage you to get a color 
monitor, so you can see the full benefit of color graphics as TEMPRA SHOW 
shows them. 

System will not Start. Be sure you have set your TMP environmental 
variable. This will let you run TEMPRA SHOW in all modes even without 
EMS. 

You are not getting prompts or error messages you can understand. Go 
to your original diskettes and reinstall the program. 

Out of Environment Space. Be sure your Shell command ends with the 
/E: 1024 option, for exarnpleShell = C:\COMMAND.COMC:VP/E: 1024. 
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Environmental Variables ____ _ 
When you installed TEMPRA SHOW, you were asked if you wanted to 
change your AUTOEXEC.BAT and CONFIG.SYS files. If you did, your 
path statement was changed to include the TEMPRA SHOW directory. 
TEMPRA SHOW also added some SET statements to your 
AUTOEXEC.BAT files. These SET statements create DOS environment 
variables. TEMPRA SHOW uses the DOS environment variables to estab­
lish its configuration every time you start TEMPRA SHOW. If you want to 
change any of these variables, use the following parameter guidelines. Check 
your DOS manual for infonnation on setting environmental variables. The 
following describe the variables you can set for TEMPRA SHOW. To set a 
specific variable, enter the value after the = sign. 

BEEP 
Sets frequency and duration of computer beep. 
(SET BEEP= 100 100) This variable set the frequency and duration of the 
computer beep you hear if you ever make a selection the system cannot 
accept. If you want to set this (optional), you must have both entries. SET 
BEEP= 100 100 sets the beep at 100 for 100 thousandths of a second. If you 
set one number, the system hangs up. 

BLAST BUF 
Sets a buffer for audio when using a Sound Blaster card. 
(SET BLAST_BUF =##)Valid entries, between 2 and 32, signify the size 
in kilobytes of the buffer. This allows audio to be played from the buffer (in 
the computer's memory) rather than from the disk, which would not be fast 
enough in some circumstances. If you have a large Blast_Buf you may not 
have room in memory for certain video modes, and the system uses the disk 
memory manager. This slows down execution. 

EDITOR 
Sets the text editor to run from TEMPRA SHOW. 
(SET EDITOR= Editor Name) This detennines the word processor used 
when you select Text Editor from the Workfonn or Word from the graphic 
Menu Bar. If you don't set an editor, TEMPRA SHOW goes to the default 
text editor. 
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TMP 
Tells which directorydisk memory resident information is stored. 
TMP (SET TMP= Drive\Directory name) determines in which directory on 
your disk memory resident information is stored. This TMP file also contains 
screen information for the Super VGA modes. This has to be stored in a file 
with a unique file name that TEMPRA SHOW makes and saves temporarily 
on the hard disk when you have a 640K machine. 

VVLINES 
Determines the number of lines in a TEMPRA SHOW sequence. 
(SET VVLINES = ##) Valid numbers are between 50 and 500. You can set 
the number of lines to suit your computer's memory. Use the same number 
when editing and running your sequences. If the number of lines in a sequence 
is more than the number of lines allowed with this setting, extra lines are cut 
off the end of the sequence. 

VVMODE 
Sets the starting graphics mode and color depth. 
(SET VVMODE=Mode) To set the 320x200 graphics mode with 256 colors, 
use the format SETVVMODE=VGA_l3. TEMPRASHOWselectsamode 
that most closely matches your display if you don't set one. The installation 
automatically sets this for you and puts this into your AUTOEXEC.BAT. 

VVMTBAUD 
Sets baud rates for MicroTouch touch screen. 
(SET VVMTBAUD=####) Valid numbers: 9600 and 4800. This sets the 
baud rate (unit of speed) for Micro Touch Touch Screen's serial communica­
tions. 

TEMPRA SHOW PAINT 
Sets TEMPRA PRO or TEMPRA GIF as external paint program. 
(SET VVP AINT=Program name) This determines what paint program is 
executed when you select the "TEMPRA" button on the Menu Bar. TEMPRA 
uses .PCX, .TOA, .WIN, and .PCC files. If you don't set this, you can't run 
anything from the "TEMPRA" button on the Menu Bar. 
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VVSPRITE BUF 
Sets the memory storage area size for sprites (picture clips). 
(SET VVSPRITE_BUF=#####) Valid numbers are between 2048 and 
64000. If you have EMS you don't need this. You can vary this to 
accommodate memory constraints in your PC. A large VVSprite_Buf allows 
you to show large image clips, but this large buffer may preclude you from 
using a number of VGA modes in conventional memory. 

PROGX 
Sets the external program for access from TEMPRA SHOW. 
(SET PROGX=Program name) This lets you access any external program 
from the TEMPRA SHOW Menu Bar. You can set any frequently-run 
program for use without leaving TEMPRA SHOW. Return to TEMPRA 
SHOW by typing EXIT and pressing [Enter]. 
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Introduction 
Thisishands-onwalk-throughtutorialgivesyouanopportunitytoexploreTEMPRASHOW. Youmay 
choose to experiment on your own, going through the events available and learning how to use them and 
what they do. The written tutorial we've designed lets you recreate an interactive sequence included with 
this program (called W1DR.SEQ). If you have already read through the user guide, you will be familiar 
with many of the terms used in this tutorial. If not, you may want to refer to it every now and then 

We suggest you read each page carefully, noting the bold-faced words, as they are key terms that relate 
to a specific event or action If you skim through the explanations, you may miss a detail that could affect 
the result of the sequence you' re creating. There are 24 lines in the sequence you will recreate. If you 're 
familiar with computers, you '11 breeze through the tutorial. If you 're new to computers, it may take a 
littlelongertocompletethetutorial, but you willgetfasterwithitas you becomefamiliarwith the process. 
It's exciting to watch the sequence as you create it and when you 're finished. This sequence was designed 
for640x480,256-colordisplaymodes.Ifyoudon'thavethisdisplaymode,yourresultswillbedifferent. 

NOTE: If you press the wrong key for a specific line or notice that the menus don't match the written 
material, we suggest you cancel out of that line, delete it, and redo the line from the 
beginning. This will help keep you in step with the tutorial. 
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1 Extt Button 7 Play Sequence Button 
2 Remove Menu Button 8 Insert Line Button 
3 Menu Bar 9 Delete Line Button 
4 Title Box 10 Event Controller 
5 Menu Size Button 11 Line Scroll Bar 
6 Play Line Button 12 Line Counter 
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Using the Tutorial ______ _ 
This hands-on walk-through tutorial lets you explore TEMPRA SHOW. It 
explains the events in a show we created, called TU1DR.SEQ, so you can replicate 
them, yet add your own creative flair. Don't worry, you can't do anything to 
''hrum'' the program. The following key points are extracted from the user guide 
as a reminder: 

• When you start each new line with either the Label or Type event, TEMPRA 
SHOWautomaticallybringsupanymenusyouneedtocompletetheevent.Ifyou 
don't need a particular menu, a message appears telling you so. 

• Use the [F6] key to play the sequence without the menus on the screen The 
sequence begins with the current line shown in the Line Counter. To start a 
sequence from the beginning, change the Line Counter to read Line 1. 

• To stop playing a sequence, press the [Esc] key. The sequence freezes and the 
menus appear on-screen 

• Select means to press the left mouse button Cancel means to press the right 
mouse button 

Tutorial Structure 
Beginning with Line l, this tutorial consists of two sections: the left-hand page 
contains a graphicversionofhowto create each line. At the top of the left-hand page 
is an objective to describe what you will accomplish in that line. At the bottom of 
the left-hand page is a sample of the Workform (the text-based interface). The right­
hand page has ste~by-step instructions of how to create the line. When you 're 
finished with the tutorial, you would have recreated the sequence you're about to 
watch! 

NOTE: As you becomes familiar with TEMP RA SHOW, you'll be able to tell 
the contents of each line just by looking at the graphic on the left-hand 
page. 

29-3 



Tutorial 

29-4 

Starting the Tutorial 
Before you begin replicating the tutorial sequence we created specifically for this 
user guide, you should play it To do this: 

1. Change to the DOS prompt by typing CD\ and pressing [Enter] (you see 
C:\> on the screen). 

2. Change to the TEMPRA directory by typing CD TEMPRA and [Enter] 
(you see C:\TEMPRA on the screen). 

3. Start TEMPRA SHOW by typing TSHOW and [Enter]. 

4. Press [Enter] when you see the copyright message. The TEMPRA 
SHOW graphic interface appears on the screen. 

5. Using the mouse pointer, select the Disk button from the Menu Bar by 
pressing the left mouse button. 

6. When the Disk menu opens, select the Load Sequence bar by pressing the 
left mouse button. 

7. Select TUTOR.SEQ to load the sequence. 

8. Press the [F6] key to start the tutorial sequence. The menus disappear and 
the sequence begins. Watch the sequence and participate in it. (This is an 
interactive sequence. You choose the correct answer to complete the 
sequence.) The sequence ends with an image of the TEMPRA product 
box. 

9. When you're finished with the sequence, press any key to return to the 
menus. 

10. You are at the end of the sequence (Line 23). To get to the first line of the 
sequence, place your cursor in the Line Counter and press Select (left 
mouse button). The Line Counter menu pops upon the screen and displays 
Line 1. Press Select again to return to the first event in the sequence. The 
Line Counter displays Line 1. 

11. Play with the Line Scroll Bar and Line Counter. Move forward and 
backward in the sequence by holding down the left mouse button as you 
move the control button inside the Line Scroll Bar. Also, try selecting the 
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arrows on either side of the Line Scroll Bar. As you move back and forth, 
the number in the Line Counter changes. The information in the fields also 
changes. 

12. To look at the Workform (text-based interface), select the Work button 
on the Menu Bar. The graphic menu disappears and the text menu appears 
on-screen. The screen shows all the events and characteristics. This 
information is the same as what is in the graphic menu, but in text form 
so you can see more of it at once. 

13. Move the mouse around (but don't hold down any of the mouse buttons). 
The highlighted bar also moves around the fields. 

14. Press Cancel on the mouse to exit the Workform and return to the graphic 
menu. The Main Menu pops up on the top left portion of the screen. Move 
the highlighted bar down to GUI and press Select. The graphic menu 
reappears on the screen. 

15. To begin recreating the tutorial sequence, select the Disk button and then 
select the New Sequence bar. (If the message "Save old sequence?'' pops 
up, select No. This shouldn't happen, but may if you change the original 
sequence somehow.) 

16. The New Sequence menu appears. Type your name in the box and press 
Select. Your name appears in the Title Box on the Menu Bar. The Line 
Counter displays Line 1, and you 're ready to start creating! 

NOTE: Since you will have some creative license when you recreate the 
sequence, the numbers in your fields may not exactly match ours. 
But they will reflect the color, positioning, etc. that you have 
chosen. 
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TEMPRA SHOW: Line 1, BCo/or Event 
Objective: Wipe a color background on the screen. 

~~~ 
11t:~~~:i'.~:'.'.'.'.'.'.~'.~~::::'.'.'.'.'.:'.:'.'.'.'.:::1.::::~~~~~~~~::::::'.:'.::'.:=:=:::::::::::::::::=:=:=:=:::=:::=:::::::::=:=:::=:=:::=:::=:=:t'~'.::=::;~:~:~~~~:::=:::::::::=:=::::::::::::'.''.:':''.'.t'.'.'.~~~:'.'.'''.'.'.'.:::111 

Line 1 completed. 

t lli~.-.1!.I·•· • 
Label Type File Method Sp/Op Parameter.9 Wa it For Next 

' Lft Rt 99 Solid 55c 1 0/18 

Line : 1 Sequence : TUTOR Fl - Help F5-Prev Line 
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Line 1 
Line 1 contains a colored background that wipes onto the screen from left to right. 

NOTE: You will not need to use the Label and Flle fields for this BColor type 
of event. 

Recreating Line 1 
1. Select the box under Type. From the pop-up menu, select BColor. 

2. The Method menu pops up. From the Wipe menu, select Lft _Rt. This wipes 
the color on the screen from left to right 

3. The SP/DP menu pops up. Press the Uparrow until the speed is 99. Select OK 
(Since all background color events are permanent, you can't choose from the 
Display field) 

4. The Parameters menu pops up. On the Choose Color From Image? menu, 
select Yes. A cross-shaped cursor with a box around appears on the screen 
Move the color pick cursor around on the screen. Notice how the box changes 
color to reflect the current color the cross is positioned over. Pick a color from 
the image and press Select. 

NOTE: If you started this tutorial without first watching TUTOR.SEQ, you 
need to choose No on Choose Color From Image? This brings ups the 
color palette for you to choose a color. See Line 2, step 4 for more 
information. 

5. The Wait menu automatically pops up. From the menu, select Wait For 
Timeout. The Seconds default is 1 (which we want), so press Select. Press 
Select again to accept the default on the 18th Seconds menu. 

6. The Next menu pops up. Press Select to accept the default 

7. The screen color changes. The Line Counter advances to Line 2. 
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TEMPRA SHOW: Line 2, BColor Event 
Objective: Wipe a color background on the screen. 

:-:·:-:::-:-:·:·:-:-:-:-:·:-:-:.·· 

~;;;i~ 
Line 2 completed. 

1:>1i1~··· • 
Label Type File Me t hod Sp/Dp Parameters Wait For Next 

BColor Lft Rt 99 Solid 55c l 0/18 

' Rt_Lft 99 solid 16c 

Line: 2 Sequence: TUTOR Fl-Help FS-Prev Line 
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Line2 
Line 2 contains a colored background that is wipes quickly onto the screen 

NOTE: You will not need to use the Label and File fields for this BColor type 
of event. 

Recreating Line 2 
1. Select the box under Type. From the pop-up menu, select BColor. 

2. The Method menu pops up. From the Wipe menu, select Rt _Lft. This wipes 
the next color on the screen from right to left. 

3. TheSP/DPmenu pops up. Press the Uparrow until thespeedis99.SelectOK. 

4. The Parameters menu pops up. On the Choose Color From Image? menu, 
select No. The color palette appears. Select any color square from the palette 
and click OK. (We used pwple, number 16.) 

5. The Wait menu automatically pops up. From the menu, select Don't Wait. 

6. The Next menu automatically pops up. Press Select to accept the default 

7. The screen color changes. The Line Counter advances to Line 3. 
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TEMPRA SHOW: Line 3, Video Event 
Objective: Load 256-color palette from an image. 

~~ 
Line 3 completed. 

l.'.il".l"lr• • 
Label Type File Method Sp/Op Parameters Wait For Next 

BColo r L!t_Rt 99 Solid 55 c l 0/1 8 

BColor Rt_ Lft 99 Solid 16c 

• :• TUTOR! LoadPal 

Line : 3 Sequence : TUTOR Fl-Help FS-Prev Line 
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Line3 
Line 1 contains a Video event In this case, it loads in a 256-color palette from an 
image, called TUTOR I. PCX. The palette prevents the introductory screen from 
changing colors during the transition to the first image. If you don't load a palette 
based on an image you will use in the sequence, 1EMPRA SHOW automatically 
loads the default palette. 

NOTE: You will not need to use the Label, SP/DP, and Parameters fields for 
this Video type of event. 

Recreating Line 3 
1. Select the box under Type. From the pop-up menu, scroll down and select 

Video. 

2. The Method menu automatically pops up. Select Load.Pal. 

3. The Files menu automatically pops up. You will select an image file on which 
to base the 256-color palette. Since the first image we use in the sequence is 
TUTORl.PCX, that should be the palette to load. Select TUTORl.PCX. 

4. The Wait menu automatically pops up. From the menu, select Don't Wait. 

5. The Next menu automatically pops up. You don't need this, so press Select to 
accept the default 

6. The menus change color to reflect the new palette. The Line Counter 
automatically advances to Line 4. 
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TEMPRA SHOW: Line 4, Text Event 
Objective: Place erasing text on the screen. 

~ 
Line 4 completed. 

1:..·J·~· •·-.--.:c•'" 
Label Tvoe File Method So/Do Parameters Wait For 

BColor Lft Rt 99 Solid SSc 1 0/1 8 

BColor Rt_Lft 99 Solid 16c 

Video TUTOR! LoadPal 

INTRO Time30B E 001 Ox 282y l53c 45w 4h nnm 2 0/18 

Line : 4 Sequence : TUTOR Fl - Help FS-Prev 

Next 

Line 
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Line4 
Line 4 contains a text file that we created in a word processor and saved as ASCII 
text files. 

NOTE: You will not need to use the Label field. 

Recreating Line 4 
1. Select the box under Type. From the pop-up menu, select Text. 

2. The File menu pops up. Select INTRO.TXT from the list. 

3. The Method menu pops up. Select KST Fonts. Select a typeface you'd like 
to use or scroll down and select Times30B (times roman 30-point bold text). 

4. The SP/DP menu pops up. Select Erase after Displaying. (We want Line 5 's 
text to appear in the same place as Line 4 's text.) 

5. Parameters pops up. For Choose Starting Line For Text, click on the first 
line in "Mathematica, Inc ... " For Allow User to Operate?, select No. For 
Draw Frame, select No. For Justify, select Middle. For Choose Color From 
Image?, select No. Select a color square from the palette and click OK. (We 
used a light blue, number 153.) 

6. Framed text appears in the top left comer. Move the frame around the text 
you want to display (in this case, "Mathematica, Inc. presents) and press 
Select. The text appears on the screen to be positioned. Move the text to the 
center of the screen and press Select. 

7. TheWaitmenupopsup.SelectWaitForTimeout. Type2onSecondsmenu. 
Press Select. Press Select again for default of 0 on 18th Seconds. 

8. The Next menu pops up. Press Select to accept the default. 

9. Text appears on-screen The Line Counter advances to Line 5. 
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TEMPRA SHOW: Line 5, Text Event 
Objective: Place permanent text on the screen. 

Line 5 completed . 

....,~.!JI·•· .,.,. 
Label Tvoe File Method Sp/Op Parameter s Wait For 

BColo r L!t_Rt 99 Solid 55c 1 0/1 8 

BColor Rt Lft 99 solid 16c 

Video TUTORl LoadPal 

Text INTRO Time30B E 001 Ox 282y 153c 45w 4h nnm 2 0/18 

TITLE Time30B E 001 Ox 28ly 153c 4lw 4h nnm 2 0/18 

Line : 5 Sequence : TUTOR Fl-Help FS - Prev 

Next ! I 
• 

Line 
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Lines 
Line 5 contains text we already typed and saved as a text file. 

NOTE: You will not need to use the Label field. 

Recreating Line 5 
1. Select the box under Type. From the pop-up menu, select Text. 

2. The File menu pops up. Select TITLE. TXT from the list 

3. The Method menu pops up. Select KST Fonts. Select a typeface you'd like to 
use or scroll down and select Times30B (which we used). 

4. The SP/DP menu pops up. Select Permanent. 

5. Parameters pops up. For Choose Starting Line For Text, click on the first 
line of"A Tempra Show tutorial.'' For Allow User to Operate?, select No. 
For Draw Frame, select No. For Justify, select Middle. For Choose Color 
From Image?, select No. In the palette, select a color square (we used the light 
blue, number 153) and OK. 

6. Framed text appears in the top left comer. Move the frame around the text 
you want to display (in this case," A Tempra Show tutorial'') and press Select. 
Move the text toward the center of the screen and press Select. 

7. The Wait menu pops up. Select Wait For Timeout. Type 2 on Seconds menu. 
Press Select. Select again for default of 0 on 18th Seconds. 

8. The Next menu pops up. Press Select to accept the default 

9. Text appears on-screen The Line Counter automatically advances to Line 6. 
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TEMPRA SHOW: Line 6, Screen Event 
Objective: Dissolve a .PCX image onto the screen. 

-~· . .~ ... 

-M Screen TUTOR1 i Dissolve 99 ~ t 

~~~t~ 
Line 6 completed. 

1.:.1····· llel 

Next I I Label Type File Method Sp/Dp Parameters Wait For 

BColor Lft_Rt 99 Solid 55c 1 0/18 

BColor Rt_Lft 99 Solid 16c 

Video TUTORl LoadPal 

Text INTRO Tirne30B E 001 Ox 282y !53c 45w 4h nnrn 2 0/1 8 

Text TITLE Tirne30B E 001 Ox 28ly 153c 4lw 4h nnrn 2 0/1 8 

.... ~ ~ TUTOR! Dissolve 99 

Line: 6 Sequence: TUTOR Fl - Help FS-Prev Line 
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Line 6 
Line 6 contains a .PCX graphic image thatis dissolved onto the screen. This image 
is a background graphic that sets the scene for Buzz, the TEMPRA toucan, to 
appear. 

NOTE: You will not need to use the Label field. 

Recreating Line 6 
1. Select the box under Type. From the pop-up menu, select Screen. 

2. The File menu pops up. Select TUTORl.PCX from the list 

3. The Method menu pops up. From the Wipe menu, select Dissolve. 

4. The SP/DP menu pops up. Set the speed at 99. Select OK to accept the speed. 

5. The Parameters menu pops up. For the Show Screen menu, select As Is. 

6. The Wait menu pops up. Select Don't Wait. 

7. The Next menu automatically pops up. Press Select to accept the default 

8. The caveman background image appears on-screen The Line Counter 
automatically advances to Line 7. 
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TEMPRA SHOW: Line 7, Screen Event 
Objective: Wipe a .PCX image on the screen . 

. ,·&~ .... i!!:[il;ljf=Y ~= 

Line 7 completed. 

1:11~· .. 1·•· . :ce" .. 

II Label Type File Method Sp/Dp Parameters Wait For Next 

BColor Lft_Rt 99 Solid SSc l 0/18 

BColor Rt_Lft 99 solid 16c 

Video TUTORl LoadPal 

Text INTRO Time30B E 001 Ox 2 82y 1S3c 4Sw 4h nnrn 2 0/18 

Text TITLE Tirne30B E 001 Ox 281y 153c 4lw 4h nnrn 2 0/ 18 

Screen TUTOR! Dissolve 99 

-: : TUTOR2 Bot_Tp 10 

Line : 7 Sequence : TUTOR Fl - Help FS-Prev Line 

TEMPRA SHOW Reference 
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Tutorial 

Line 7 
Line 7 contains a .PCX graphic image of Buzz that wipes onto the background 
cave image. 

NOTE: You will not need to use the Label field. 

Recreating Line 7 
1. Select the box under Type. From the pop-up menu, select Screen. 

2. The File menu pops up. Select TUTOR2.PCX from the list 

3. The Method menu pops up. From the Wipe menu, select Bot_ Tp. 

4. The SP/DP menu pops up. Set the speed at 10. Select OK to accept the speed. 

5. The Parameters menu pops up. For the Show Screen menu, we want the 
image to appear as it was created, so select As Is. 

6. The Waitmenupopsup. Youwanttocontinuetothenextscreenautomatically, 
so select Don't Wait. 

7. The Next menu automatically pops up. Press Select to accept the default 

8. Buzz wipes onto the caveman background on the screen The Line Counter 
automatically advances to Line 8. 
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29-20 

TEMPRA SHOW: Line 8, Text Event 
Objective: Place permanent text on the screen. 

Line 8 completed. 

.. . . . ...... ii. e1r;i1 

!I Label Type File Method Sp/Dp Parameters Wait For Next 

BColor Rt_Lft 99 Solid l6c 

Video TUTORl LoadPal 
~ 

Tex t INTRO Time30B E 001 Ox 2 82y 153c 45w 4h nnm 2 0/18 

Text TITLE Tirne30B E 001 Ox 28ly 153c 4lw 4h nnm 2 0/18 

Screen nrrau Dissolve 99 

screen T\JTCR2 Bot_Tp 10 

Ql Tirne30B p 001 Ox 47ly 153c 73w 4h nnm 

Line: 8 Sequence : TUTOR Fl - Help FS - Prev Line 

TEMPRA SHOW Reference 
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LineB 
Line 8 contains the text "What is the name of the Tempra mascot?'' You can treat 
this Text event the same as your earlier ones. 

NOTE: You will not need to use the Label field. 

Recreating Line 8 
1. Select the box under Type. From the pop-up menu, select Text. 

2. The File menu pops up. Select Ql.TXT from the list 

3. The Method menu pops up. Select KST Fonts. Select a typeface you'd like to 
use or scroll down and select Times30B (which we used). 

4. The SP/DP menu pops up. Select Permanent. 

5. Parameters pops up. For Choose Starting Line For Text, click on the first 
line in "What is the name of ... " For Allow User to Operate?, select No. For 
Draw Frame, select No. For Justify, select Middle. For Choose Color From 
Image, select Yes. A cross-shaped cursor appears on the screen. Move it 
around and click on the color you'd like the text to be. 

6. Framed text appears in the top left comer. Move the frame around the text you 
want to display (in this case, "What is the name of the TempraMascot?") and 
press Select. The text appears on the screen for positioning. Move the text 
toward the tip of Buzz's top blade (that's feather to you) so the text is visible 
even when the Menu Bar is on the screen and press Select. 

7. The Wait menu pops up. Select Don't Wait. 

8. The Next menu pops up. Press Select to accept the default 

9. Text appears on-screen. The Line Counter automatically advances to Llne 9. 
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29-22 

TEMPRA SHOW: Line 9, Sprite Event 
Objective: Move a sprite image across the screen. 

-'~'i&i"lt-~!~~il!ll•l ::.1 . _]Sprite . j H~ND . ! . .. . .. J15 E ~ :::: 

rnI::II::::I:itr:::i:::::i:::r]:ei~li~t.~iI:::=:::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::=:=::::::::::::=rn:::wmt:::::::::r::,:::=:=:=:::::: J:1~~::::::::r: 
::l.~~~-~-><--- ~~-~~Y. .. .. 1~-~~>.< ... ~~~~.Y. ...................................... 1.2 o/1a I ···· ,ii 

Line 9 completed. 

'·1•.l•t .. l!Ceh· 

Wait For Next 
1 
I Label Type File Method Sp/Op Parameters 

Video TUTORl LoadPal ...... 
Text INTRO Time30B E 001 Ox 282y 153c 45w 4h nnm 2 0/18 

Text TITLE Tirre30B E 001 Ox 28ly 153c 4lw 4h nnm 2 0/18 

Screen TUTORl Dissolve 99 

Screen TUTOR2 Bot_Tp 10 

Text Ql Tirre30B p 001 Ox 471y 153c 73w 4h nnm . - HAND Simple 15 E - 55bx 288by 142ex 288ey 2 0/18 

Line : 9 Sequence : TUTOR Fl-Help FS- J?rev Line 

TEMPRA SHOW Reference 
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Line9 
Line 9 contains a sprite that points to Buzz. This hand sprite is also the image we 
use to branch later. 

NOTE: You will not need to use the Label field. 

Recreating Line 9 
1. Select the box under Type. From the pop-up menu, select Sprite. 

2. The File menu pops up. Select HAND.PCC from the list 

3. The Method menu pops up. From the menu, select Simple (for a basic sprite 
movement). 

4. The SP/DP menu pops up. Set the speed at 15. Select Erase. Select OK. 

5. The Parameters menu pops up. Position the hand's starting point off-screen 
on the left side about eye level to Buzz. Then position the ending point near 
Buzz's eye. 

6. The Wait menu pops up. Select Wait For Timeout. Type 2 on Seconds menu. 
Press Select. Press Select again for default of 0 on 18th Seconds. 

7. The Next menu pops up. Press Select to accept the default 

8. The hand moves to the right, pointing at Buzz. The Line Counter automati­
cally advances to Line 10. 
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29-24 

TEMPRA SHOW: Line 10, Title Event 
Objective: Position a permanent title on the screen . 

. . ~ v. .. . .,:,:::: ill:~:~::: : 

fi:t~.,~.~·~·~=·=·=·=·=·=·=·=·=·=·=·=·=·=·~=~·~=~·=·=·=~=~·~=·=·=·=~·~:~;~.,., . , . , .,.,.,.,.,.,.,.,.,.,.,.,.,.,.,.,.,.,.,.,.,. , . , . , .,., . , . , . , . , . ,. ,.,J,.,.,.,.,.,.,.,.,.,.,.,.,.,.,.,.,.,.,.,.,.,.,.,.,.,.,.,.,.,.,.,.,.,.,., . , .,.,.,.,.,.,.L.,.,.,.,.,.,.,.,.,.,.,.,.,.,.,.,.J:: 
Line 10 completed. 

1ii=>tl•J1•.1• . •"" 
Label Type File Method Sp/Dp Parameters Wait For Next I 

Text INTRO Time30B E 001 Ox 282y 153c 45w 4h nrun 2 0/18 ..... 

Text TI TIE Tirre30B E 001 Ox 28ly 153c 4lw 4h nrun 2 0/18 

Screen TUTORl Dissolv~ 99 

Screen TUTOR2 Bot_Tp 10 

Text Ql Tirre30B p 001 Ox 47ly 153c 73w 4h nrun 

Sprite HAND Simple 15 E -55bx 288by 142ex 288ey 2 0/18 

- Tirre30B p 001 Rover @30x 92y 153c 

Line: 14 Sequence : TUTOR Fl-Help FS-Prev Line 

TEMPRA SHOW Reference 
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Line 10 
Line 10 contains the title that is one of the three choices to answer the previous text 
question. You can create your own title or type the one we used 

NOTE: You will not need to use the Label or Fik fields. 

Recreating Line 10 
1. Select the box under Type. From the pop-up menu, select Title. 

2. The Method menu pops up. Select KST Fonts. Select a typeface you'd like 
to use or scroll down and select Times30B. 

3. The SP/DP menu pops up. Select Permanent and click OK. 

4. Parameters pops up. In the Input Title box, type Rover (or make upyourown 
name to use- a friend, boss, family, etc.). Press Select. For Choose Color 
From Image, select Yes. A cross-shaped cursor appears on the screen. Select 
a color from the image. 

5. Text appears for positioning. Move the text toward the bottom left of the 
screen (above where the Event Controller would be so you can see the name 
when the Event Controller is on the screen) and press Select. 

6. The Wait menu pops up. Select Don't Wait. 

7. The Next menu pops up. Press Select to accept the default. 

8. Textappearson-screen. TheLineCounterautomaticallyadvancestoLine 11. 
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29-26 

TEMPRA SHOW: Line 11, Title Event 
Objective: Position a permanent title on the screen. 

Line 11 completed. 
1~· •· 1:c ..... 

Label Type File Method Sp/Op Parameters Wait For Ne xt I 
Text TI TLE Tirre30B E 001 Ox 28ly 153c 4lw 4h nnm 2 0/ 18 1 

Screen TUTORl Dissol vE 99 

Screen TUTOR2 Bot_Tp 10 

Text Ql Tirre30B p 001 Ox 47ly 153c 73w 4h nnm 

Sprite HAND Simple 15 E -SSbx 288by 142ex 288ey 2 0/18 

Title Ti rre30B p 001 Rover @30x 92y 153c 

- Tirre30B p 001 Buzz @200x 30y 153c 

Line : 11 Sequence : TUTOR Fl - Help FS - Prev Line 

TEMPRA SHOW Reference 
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Line 11 
Line 11 contains the title "Buzz." You can treat this Title event the same as the 
previous one. 

NOTE: You will not need to use the Label and File fields. 

Recreating Line 11 
I. Select the box under Type. From the pop-up menu, select Title. 

2. The Method menu pops up. Select KST Fonts. Select a typeface you want to 
use or scroll down and select Times30B. 

3. The SP/DP menu pops up. Select Permanent. 

4. Parameters pops up. In the Input Title box, type Buzz and press Select. For 
Choose Color From Image, select Yes. A cross-shaped cursor appears. 
Position over a color you want from the image and press Select 

5. Text appears on the screen for positioning. Move the text toward the bottom 
middle of the screen (about even with the first title) and press Select. 

6. The Wait menu pops up. Select Don't Wait. 

7. The Next menu pops up. Press Select to accept the default 

8. Text appears on-screen. The Line Counter automatically advances to Line 12. 
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29-28 

TEMPRA SHOW: Line 12, Title Event 
Objective: Position a permanent title on the screen. 

Label Type File 
Screen TUTORl 

Screen TUTOR2 

Text Ql 

Sprite HAND 

Title 

Title 

Method Sp/Dp Parameters 
Dissolv 99 

Bot_Tp 10 

Time30B P 001 Ox 471y 153c 73w 4h nnm 

Wait For Next 

Simple 15 E - 55bx 2BBby 142ex 2BBey 2 0/l B 

Time30B P 001 Rover @200x 92y 153c 

Time30B P 001 Buzz @200x BOy 153c 

Time30B P 001 Donatello @375x 93y 153 

Line : 12 Sequence: TUTOR Fl-Help FS-Prev Line 

TEMP RA SHOW Reference 
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Line 12 
Line 12 contains a title that is one of the three answers. You can treat this Title event 
the same as your earlier ones. 

NOTE: You will not need to use the Label and Fik fields. 

Recreating Line 12 
1. Select the box under Type. From the pop-up menu, select Title. 

2. The Method menu pops up. Select KST Fonts. Scroll down and select 
Times30B. 

4. The SP/DP menu pops up. Select Permanent and click OK. 

5. Parameters pops up. In the Input Title menu, type Donatello (or any other 
name you want to be the wrong answer) and press Select. For Choose Color 
From Image, select Yes. Using the cross-shaped cursor, select a color from 
the image. 

6. Text appears on the screen for positioning. Move the text toward the bottom 
right of the screen (about even with the other choices) and press Select. 

7. The Wait menu pops up. Select Don't Wait. 

8. The Next menu pops up. Press Select to accept the default 

9. Text appears on-screen (it may be hidden by the Event Controller). The Line 
Counter automatically advances to Line 13. 
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29-30 

TEMPRA SHOW: Line 13, Button Event 
Objective: Create a branch for interactive selection. 

Label Type File 

Screen TUTOR2 

Text Ql 

Sprite HAND 

Title 

Title 

Title 

quest . HAND 

Line 13 completed. 

Method Sp/Dp Parameters Wait For Next 

Bot_Tp 10 

Tirre30B P 001 Ox 47ly 153c 73w 4h nnm 

Simple 15 E -55bx 288by 142ex 288ey 2 0/18 

Tirre30B P 001 Rover @30x 93y 153c 

Tirre30B P 001 Buzz @200x 93y 153c 

Tirre30B P 001 Donatello @375x 93y 153c 

3 Areas 99 T 142bx 288by quest 

Line : 13 Sequence : TUTOR Fl-Help F5 - Prev Line 

TEMPRA SHOW Reference 
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Line 13 (through 17) 
Line 13 is a Button event It displays a sprite and gives the viewer control of the 
sprite. This event is a multi-line event Because there are a number of items that will 
occur during this event, it is carried over into extra lines. (Lines 13 through 17 are 
all connected to this Button event) 

NOTE: You will need all fields for this Button type of event. 

Recreating Line 13 
1. Select the box under Label. Type quest as the Label and press [Enter]. 

2. The Type menu pops up. Select Button. 

3. The F11e menu pops up. Select HAND.Pee from the list 

4. The Method menu pops up. For How Many Areas?, type 3 and press [Enter]. 

5. The SP/DP menu pops up. Set the speed at 99 and Erase. Select OK. 

6. The Parameters menu pops up. For Insert Lines For Buttons, select Insert 
Lines. The sprite appears with a message to position it at its starting point 
Move the sprite to the tip ofBuiz's beak and press Select. 

7. The Next menu pops up. For Next Label for <esc> on Button?, type quest. 
(This tells IBMPRA SHOW to go back to the question if the viewer presses 
the [Esc] key.) 

8. Another message appears in the upper leftcomerof the screen. This is for Line 
14, so tum the page and continue. 
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29-32 

TEMPRA SHOW: Line 14, Button Event 
Objective: Continue the Button event started in Line 13. 

Line 14 completed. 

".II .. . ..... · 1;le. 

Label Type File Method Sp/Dp Parameters Wait For Next I 
Text Ql Tirre30B p 001 Ox 47ly 153c 73w 4h nnm 1 

Sprite HAND Simple 15 E -55bx 288by 142ex 288ey 2 0/18 

Title Tirre30B p 001 Rover @30x 93y 153c 

Title Tirre30B p 001 Buzz @200x 93y 153c 

Title Tirre30B p 001 Donatello @375x 93y 153c 

quest Button HAND 3 Areas 99 T 142bx 288by quest 

- 68bx -25by 574by 457ey 

I 
Line : 14 Sequence: TUTOR Fl-Help FS-Prev Line 

TEMPRA SHOW Reference 
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Line 14 
Line 14 sets the area in which you can move the hand cursor. You can set a 
restrictive active area to prevent the hand from flying off the screen. Line 14 is a 
continuation of line 13 and is marked by a special symbol in the Type field on the 
graphic menu. 

NOTE: You will not need the Label, File, Method, SP/DP, Wait, and Next 
fields for this part of the Button event. 

Recreating Line 14 
1. The Parameters menu was already up while you were in Line 13. This 

contained a message to position the cursor at the lower left comer of the active 
area. Move the sprite cursor to the lower left corner of the screen and press 
Select. 

2. Another message appears in the upper left comer of the screen asking you to 
position the cursor at the upper right portion of the active area. Move the 
cursor to the upper right corner of the screen, and press Select. 

3. Another message appears (the same as in the first message above). This is 
actually the beginning of Line 15. Tum the page and continue with the Button 
event 
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29-34 

TEMPRA SHOW: Line 15, Button Event 
Objective: Continue the Button event started in Line 13. 

Jl:fr: 
-"'"'''..._...·.'"'.. Ju~r~·~~ii!! 

ll.,i:::i:::::::::::::i:::::::::]::::::::::::::,::1:i1t1tlil::::i::::;::1:::::::::::::::::::::::::::::I:::1::1~:;mi:Irn1:~;;:::::::i;:i:]1U::1II!i,i[llHi::::::~::::11M:;:;lli 
l!ll,.,:.~,.~=~·~·=·=·=·~=~.e.~,.,.,.,!.~,:!.~·=·=·=~=!·~=~=·=·=·=·=·=·=·=·=·=·=·>:·=·=·=·=·=·>:·=·=·=·=·=·=·,,·=·=·=·=·=·=·=·=·=·=·=·=·=·=·=·=·=·=·1=·=·=·=·=·=·=·=·=-=-=·=-=·=·=·=·=·=·=·=·=·=·=·=·=·=·=·=·=·=·=·=·=·=·=·=-=·=·=·=·=J·~=~-~,.~=~·=·=·=·,.:.:· 

Line 15 completed . 

.. ::M.·J·~· •· :re' ft 

Label Type File Method Sp/Dp Parameters Wait For Next I 
Sprite HAND Simple 15 E - 55bx 288by 142ex 288ey 2 0/18 1 

' ~ 
Title Tirre30B p 001 Rover @30x 92y 153c 

Title Tirre30B p 001 Buzz @200x 93y 153c 

Title Tirre30B p 001 Dcnatello @200x 93y 153c 

quest Button HAND 3 Areas 99 T 142bx 288by quest 

- 68bx - 25by 574by 457ey 

- 34bx - 25by 119ex Bley wrong 

Line : 15 Sequence : TUTOR Fl - Help F5-Prev Line 

TEMPRA SHOW Reference 
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Line 15 
Line 15 sets the active area for you to select that will branch to the "wrong' ' answer 
event. Line 15 is a continuation of Line 13 and is marlced by a special symbol in 
the Type field on the graphic menu. 

NOTE: You will not need the Label, File, Method, SP/DP, and Waitfieldsfor 
this part of the Button event. 

Recreating Line 15 
1. The Parameters menu was already up while you were in Line 14. This 

contained a message to position the cursor at the lower left comerof the active 
area The active area in this line is the location where the word "Rover" (or 
whatever word you used) is positioned. Move the cursor to the lower left 
corner of the word Rover and press Select. 

2. Another message appears in the upper left comer of the screen asking you to 
position the cursor at the upper right portion of the active area. Move the cursor 
to the upper right corner of the word Rover. Press Select. 

3. The Next menu pops up. For Area 1, type in wrong as the label. This causes 
a branch to the wrong label every time "Rover'' is selected. At the wrong label 
during the sequence, a musical tune plays and text appears to indicate the 
wrong answer has been selected. 

4. Another message appears (to determine another button area). This is actually 
the beginning of Line 16. Tum the page and continue. 
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29-36 

TEMPRA SHOW: Line 16, Button Event 
Objective: Continue the Button event started on Line 13. 

. ·~~' .. ;:;~ Jii:i:\\ 

==rll~!~!~!~!;·;!!;!;!;·;!!~!~~~iJ~ 
Line 16 completed. 

j 1;,j.:.1~·r.•.--,~lt, 

Wait For Next ! I Label Type File Method Sp/Dp Parameters 
Title Time30B p 001 Rover @30x 92y 153c 

' ~ 
Title Time30B p 001 Buzz @200x 93y 153c 

Title Time30B p 001 Donatello @200x 93y 153c 

quest Button HAND 3 Areas 99 T 142bx 288by 

- 68bx - 25by 574by 457ey 

- 34bx - 25by 119ex Sley wrong 

- 135bx 14by 288ex 78ey right 

Line : 16 Sequence: TUTOR Fl-Help FS-Prev Line 

TEMPRA SHOW Reference 
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Line 16 
Line 16 sets the active area for the viewer to select that will branch to the "right" 
answer event. Line 17isacontinuationofLine13 andis marked by a special symbol 
in the Type field on the graphic menu. 

NOTE: You will not need the Label, Fik, Method, SP/DP, andWaitjieldsfor 
this part of the Button event. 

Recreating Line 16 
1. The Parameters menu was already up while you were in Line 15. This 

contained a message to position the cursor at the lower left comerof the active 
area The active area in this line is the location where the word "Buzz' ' is 
positioned Move the cursor to the lower left corner of the word Buzz and 
press Select. 

2. Another message appears in the upper left comer of the screen asking you to 
position the cursor at the upper right of the active area. Move the cursor to the 
upper right corner of the word Buzz and press Select. 

3. The Next menu pops up. For Area 2, type in right as the label. This causes 
a branch to the right label when "Buzz'' is selected At the right label during 
the sequence, a musical tune plays and text appears indicating that the right 
answer has been selected 

4. Another message appears (to determine the third pointing area). This is 
actually the beginning of Line 17. Tum the page and continue. 
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29-38 

TEMPRA SHOW: Line 17, Button Event 
Objective: Continue the Button event started on Line 13. 

Line 13 completed. 

1•:1• .I. 1:ce, .•. 

Wait For Next 
1 
I Label Type File Method Sp/Op Parameters 

Title Time30B p 001 Rover @200x 93y 153c 

Title Time30B p 001 Donatel lo @375x 93y 153c 

quest Butt on HAND 3 Areas 99 T 142bx 288by 

-68bx -25by 574by 457ey 

- 34bx - 25by 119ex Bley wrong 

-135bx 14by 288ex 78ey right 

307bx 13by 565ex 87ey wrong 

Line : 17 Sequence : TUTOR Fl-Help FS-Prev Line 
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Line 17 
Line 17 sets the active area for the viewer to select that will branch to the' 'wrong' ' 
answerevent.Line 17is acontinuationofLine 13 andismarlced by a special symbol 
in the Type field on the graphic menu. 

NOTE: You will not need the Label, File, Method, SP/DP, and Wait fields for 
this part of the Button event. 

Recreating Line 17 
1. The Parameters menu was already up when you started Line 16. This 

contained a message to position the cursor at the lower left comerof the active 
area. The active area in this line is the location where the word "Donatello' ' (or 
whatever word you used) is positioned. Move the cursor to the lower left 
comer of the word Donatello and press Select. 

2. Another message appears in the upper left comer of the screen asking you to 
position the cursor at the upper right portion of the active area. Move the cursor 
to the upper right comer of the word Donatello. Press Select. 

3. The Next menu pops up. For Area 3, type in wrong as the label. The names 
intheLabelandNextfieldsmustmatchexactly,includingupperandlowercase 
letters. In the tutorial sequence, they are all spelled with lowercase characters. 

4. Press Cancel to return to the menus. You have completed the Button event for 
branching! The Line Counter automatically advances to Line 18. (If you 
happen to go past Line 18 when you cancel, rewind the Line Counter to Line 
18 and pick up on the next page.) 
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29-40 

TEMPRA SHOW: Line 18, Music Event 
Objective: Create a short piece of music. 

Label Type File 

Title 

quest Button HAND 

wrong··· 

Line 18 completed. 

Method Sp/Dp Parameters Wait For Next 

Tirre30B P 001 Donatello @375x 93y 153c 

3 Areas 99 T 142bx 288by 

-68bx -25by 574by 457ey 

-34bx -25by 119ex Bley wrong 

-135bx 14by 288ex 78ey right 

307bx 13by 565ex 87ey wrong 

Play t255 o2 c2 < c2 .. 

Line: 18 Sequence: TUTOR Fl-Help FS-Prev Line 
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Line 18 
Line 18 is a Music event that begins the events that occur when the viewer selects 
the "wrong'' answer. 

NOTE: You will not need to use the Files and SP/DP fields for this Music type 
of event. 

Recreating Line 18 
1. Select the box under Label. You need to assign a label to match theNextcreated 

in Lines 15and17. Lines 15and17 branch to Lines 18and19. Type wrong 
in the menu. (The spelling and case must match the Next fields in Lines 15 and 
17.) Press Select to accept 

2. The Type menu pops up. Scroll down and select Music. 

3. The Method menu pops up. Select Play, since you are going to create a few 
notes of music on the keyboard that will play during this branch. 

4. 1he Parameters menu pops up. This is where you type the music notes to play 
through the computer's speakers. The notes we created are t255 o2 c2 < c2 ... 
Type t255 o2 c2 < c2 .. in the menu and press Select. See the reference manual 
for infonnation about creating music on the computer keyboard. 

6. The Wait menu pops up. Select Don't Wait. 

7. The Next menu automatically pops up. Press Select to accept the default 

8. The "wrong'' answer music plays. The Line Counter automatically advances 
toLine 19. 
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TEMPRA SHOW: Line 19, Text Event 
Objective: Create erasing framed text. 

Sorry~ that's wrong. 
Pleaso try again. 

Line 19 completed. 

i l:ll >"<l•P • l:l•. 

Label Type File Method Sp/Dp Pararreters Wait For 

quest Button HAND 3 Areas 99 T 142bx 288by 

- 68bx -25by 574by 457ey 

- 34bx - 25by 119ex 81ey 

- 135bx 14by 288ex 78ey 

307bx 13by 565ex 87ey 

wrong M.Jsic Play +255 o2 c2 < c2 .. 

- WRON:; ~irre30B E 001 174x 276y 157c 12w Sh nfm 3 0/18 

Next 

wrong 

right 

wrong 

quest 

Line: 19 Sequence: TUTOR Fl-Help FS-Prev Line 

I 
~ 
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Line 19 
Line 19 contains the framed text" Sorry, that's wrong. Please try again.' ' This text 
event is a little different from the earlier ones. 

NOTE: You will not need to use the Label field. 

Recreating Line 19 
1. Select the box under Type. From the pop-up menu, select Text. 

2. The File menu pops up. Select WRONG.TXT from the list 

3. The Method menu pops up. Select KST Fonts. Select a typeface you want to 
use or scroll down and select Times30B. 

4. The SP/DP menu pops up. Select Erase After Displaying. 

5. Parameters pops up. For Choose Starting Line For Text, click on the first 
line of the words "Sorry, that's wrong ... " For Allow User to Operate?, select 
No. For Draw Frame, select Yes. For Justify, select Middle. For Choose 
ColorFromlmage?,selectYes.Selectacolorfromtheimageusingthecross­
shaped cursor. 

6. Framed text appears in the top left comer. Move the frame around the text 
you want to display (in this case, "Sorry, that's wrong. Please try again.'') and 
press Select. This generates a frame for the text. The frame appears on the 
screen for positioning. Move the frame to the center of the screen and press 
Select. 

7. The Wait menu pops up. Select Wait For Timeout. In the Seconds box, type 
3. Press Select. Press Select again to accept 18th Seconds default 

8. The Next menu automatically pops up. Type quest. (This branches the 
sequence back to Line 13, which is labeled quest, so you can select the correct 
answer.) 

9. Framed text appears on the screen. The Line Counter automatically advances 
to Line 20. 
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29-44 

TEMPRA SHOW: Line 20, Music Event 
Objective: Create a short piece of music. 

Label File Wait For Next 

- 68bx -25by 574by 457ey 

-34bx -25by 119ex Bley wrong 

- 135bx 1 4by 288ex 78ey right 

307bx 13by 565ex 87ey wrong 

wrong Music Play t255 o2 c2 < c2 .. 

Text WRQu; Tirre30B E 001 l 74x 276y 157c 12w Sh n 3 0/18 quest 

right • • •• Play t255 o4 c8 dB e8 f8 g 

Line: 20 Sequence: TUTOR Fl-Help FS - Prev Line 
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Tutorial 

Line20 
Line 20 is a Music event that begins the events that occur when the viewer selects 
the "right" answer. 

NOTE: You will not need to use the Files and SP/DP fields for this Music type 
of event. 

Recreating Line 20 
1. Select the box under Label. Type right in the menu. Press Select to accept 

2. The Type menu pops up. Scroll down and select Music. 

3. The Method menu pops up. Select Play. 

4. The Parameters menu pops up. Type t255 o4 c8 d8 e8 f8 gin the menu and 
press Select (these are musical notes to play during the "right answer'' event). 

6. The Wait menu pops up. Select Don't Wait. 

7. The Next menu automatically pops up. Press Select to accept the default 

8. The "right'' answer music plays. The Line Counter automatically advances 
to Line 21. 
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29-46 

TEMPRA SHOW: Line 21, Text Event 
Objective: Create erasing framed text. 

:[it!~.?. .. ~.·.;.;.~:~·~·~·.;.;.~:?:,~.:.,.·.·~·~:~.·.·.·!.·~ :.;.;.~:~~.;.;.;.;.;·.-·.·.-.-.-.·.·.·.·.· ... :·:<·'··.-.;·.·.--.• , ..... J .. ~ ...... ~<,!~:.;.-.;.;.;.;.;.;.;.;.;.;.-.-.w.-.-.;.-.;.;.·.;J;.;.;.;.;.;.;.;.·.;.·«·:.-.:<Jli 
Line 21 completed. 

Label Type File Sp/Op Pararreters Wait For Next 

- 34bx - 25by 119ex Bley 

-135bx 14by 288ex 78ey right 

307bx 13by 565ex 87ey wrong 

wrong t255 o2 c2 < c2 •• 

WRONS Tirre30B E 001 1 74x 276y 157c 12w Sh n 3 0/ 18 quest 

right Music l ay t255 o4 c8 d8 e8 f8 g 

RIGHT Tirre30B E 001 167x 301y 130c 12w 7h n 

Line : 33 Sequence: TUTOR Fl - Help FS- Prev Line 
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Line21 
Line 21 contains the framed text "That's right! Let's continue ... " You can treat 
this Text event the same as in Line 19. 

NOTE: You will not need to use the Label.field. 

Recreating Line 21 
1. Select the box under Type. From the pop-up menu, select Text. 

2. The File menu pops up. Select RIGHT.TXT from the list. 

3. The Method menu pops up. Select KST Fonts. Select a typeface you want to 
use or scroll down and select Times30B. 

4. The SP/DP menu pops up. Select Erase After Displaying. This prompts the 
text to disappear after it is displayed, rather then waiting for the next event to 
wipe it off the screen 

5. Parameters pops up. For Choose Starting Line For Text, click on the first 
line in "That's right! Let's continue .. " For Allow User to Operate?, select 
No. For Draw Frame, select Yes. For Justify, select Middle. For Choose 
Color From Image, select Yes. Using the cross-shaped cursor, select a color 
from the image. 

6. Framed text appears in the top left comer. Move the frame around the text 
you want to display (in this case, "That's right! Let's continued ... ' ') and press 
Select. Move the text to the center of the screen and press Select. 

7. The Wait menu pops up. Select Wait For Timeout. In the Seconds box, type 
3. Press Select. Select again to accept 18th Seconds default. 

8. The Next menu pops up. Press Select to accept the default. 

9. Text appears in the box. The Line Counter advances to Line 22. 
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29-48 

TEMPRA SHOW: Line 22, BColor Event 
Objective: Wipe a black background onto the screen. 

Line 22 completed . 

.... . • 
Label Type File Method Sp/Dp Pararreters Wait For Next 

-135bx 14by 288ex 78ey right 

307bx 13by 56Sex 87ey wrong 

wrong Pl ay t255 o2 c2 < c2 .. 

WRO~ Tirre30B E 001 l 74x 276y 157c 12w Sh nfrr 3 0/18 quest 

right Music Play t255 o4 cB dB eB fB g 

Text RIGHT Tirre30B E 001 167x 30ly 130c 12w 7h nfrr 

end :·-···· IBox_CXlt 99 Solid Oc 

Line : 22 Sequence: TUTOR Fl-Help FS-Prev Line 

I 

TEMPRA SHOW Reference 



Mathematica, Inc. 

Tutorial 

Line22 
Line 22is a BColor eventthatchanges the background color to black as a transition 
to the final image screen. 

NOTE: You will not need the File field for this BColor type of event. 

Recreating Line 22 
1. Select the box under Label. Type end. 

2. The Type menu pops up. Select BColor .. 

3. The Method menu pops up. From the Wipe menu, select a wipe you want to 
try or select Box_ Out (this makes a wipe that spirals from the center of the 
screen to the outside). 

4. The SP/DP menu pops up. Set the speed at 99. Select OK to accept the speed. 

5. The Parameters menu pops up. On the Choose Color From Image? menu, 
select No. The color palette appears. Select the black square (0) and then OK. 

6. The Wait menu pops up. Select Don't Wait. 

7. The Next menu automatically pops up. Press Select to accept the default 

8. The screen color changes to black. The Line Counter advances to Line 23. 
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29-50 

TEMPRA SHOW: Line 23, Video Event 
Objective: Run an animated .FLI file. 

lc1'1?i<S" SHOW .· 

:~ Uideo AaPlay I 

= Line 23 completed. 

Label Wait For Next 

- 135bx 14by 288ex 78ey right 

307bx 13by 565ex 87ey wrong 

wrong lay t255 o2 c2 < c2 .. 

WRONG Tirre30B E 001 174x 276y 157c 12w Sh n quest 

right Music lay t255 o4 c8 d8 e8 f 8 g 

Text RIGHT Tirre30B E 001 167x 30ly 130c 12w 7h n 

TOOC"AN2 play 95 83bx 364by 

Line: 22 Sequence: TUTOR Fl-Help FS-Prev Line 
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Line23 
Line 23 is a Video event that plays an animated flick (.FLI) file of Buzz. 

NOTE: You will not need the Label field for this Video type of event. 

Recreating Line 23 
1. The Type menu pops up. Select Video. 

2. The Method menu pops up. Select Aaplay at the bottom of the menu. 

3. The F1les menu pops up. Select TOUCAN2.FLI from the menu. 

4. The SP/DP menu pops up. Set the speed at 95. Select OK to accept the speed 

5. The Parameters menu pops up. A ghost rectangle appears for you to position 
the viewing window on the screen Move the rectangle to the center of the 
screen and press Select. 

6. The Wait menu pops up. Select Don't Wait. 

7. The Next menu automatically pops up. Press Select to accept the default 

8. The animated file ofBuzz spinning plays. The Line Counter advances to Line 
24. 
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TEMPRA SHOW: Line 24, Screen Event 
Objective: Wipe a .PCX image on the screen. 

lc1'1?i<~" · SHOW .... 

ii; 

W!'~·~·~;~~·-
1=: Screen SLIDE20 Dissolve 99 tt 

=~~ 
Line 24 completed. 

:£ ·~.:.1:..· •-.-..;[•. 

I Label Type File Method Sp/Dp Pararreters Wait For Next 

wrong Play t255 o2 c2 < c2 •• 

WRONS Tirre30B E 001 174x 276y 157c 12w Sh nfrr 3 0/18 quest 

right Music Play t255 o4 cB dB eB f 8 g 

Text RIGHT Tirre30B E 001 167x 301y 130c 12w 7h nfrr 

end OColor Box C>..lt 99 Solid Oc 

Video TOUCAN2 ~play 95 83bx 364by 

- - SLIDE20 Dissolve 99 any key 
I 

Line : 24 Sequence : TUTOR Fl - Help FS-Prev Line 
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Line24 
Line 24 is a Screen event with a .PCX image of the IBMPRA product box. This 
is similar to the other image files you loaded earlier. 

NOTE: You will not need the Label and Parameters fields for this type of 
Screen event. 

Recreating Line 24 
1. Select the box under Type. From the pop-up menu, select Screen. 

2. The File menu pops up. Select SLIDE20.PCX from the list 

3. The Method menu pops up. From the Wipe menu, select a wipe you' dlike to 
try or just select Dissolve. 

4. The SP/DP menu pops up. Set the speed at 99. Select OK to accept the speed 

5. The Parameters menu pops up. For the Show Screen menu, select As Is. 

6. The Wait menu pops up. Select Wait For Any Key. ('This prompts the 
sequence to start over again when the viewer presses a key on the keyboard or 
presses Select on the mouse.) 

7. The Next menu automatically pops up. Press Select to accept the default 

8. An image of the product box dissolves onto the screen The Line Counter 
automatically advances to Line 25. 

9. To watch the sequence you just created rewind to Line 1 and press [F6]. 

Congratulations! 

You have completed the tutorial. Have fun with TEMPRA! 

The staff of Mathematica, Inc. 
Committed to Imaging Excellence 
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Keyboard Functions 
INTERFACE KEY MEANING 
GraphicJWorkform Home Go to beginning of line 
Graphic!Workform End Go to end of line 
Graphic!Workform Left ftlrow Move left 
Graphic!Workform Right ftlrow Move right 
Graphic!Workform Up ftlrow Move up 
GraphicJWorkform Down Arrow Move down 
Workform Pg Up Go up a page 
Workform PgDn Go down a fiage 
GraphicJWorkform Ctr~PgUp Go to top o form 
Graphic!Workform C~PgDn Go to bottom of form 
Graphic!Workform Ctrl-Rt ftlrow Word/field right (character edit) 
GraphicJWorkform Ctrl-Lft ftlrow Word/field left (character edit) 
Graphic!Workform Esc Escape current choice 
Graphic!Workform Enter Accept current choice 
Graphic!Workform Ins Insert line 
Graphic!Workform Ctrl-BkSp Blank line 
Graphic!Workform Del Delete line 
Workform F1 Help Index 
Workform F2 Text editor 
Graphic!Workform F3 Edit field 
Graphic!Workform F4 Search/Replace 
Graphic!Workform F5 Preview line 
Graphic!Workform F6 Preview from line 
Workform F7 Mark block begin 
Workform Fa Mark block end 
Workform Alt-C C~yblock 
Workform Alt-D Deeteblock 
GraphicJWorkform Alt-G Goto line 
Workform All-H Hide Help info 
GraphicJWorkform Alt-I Information on system state 
GraphicJWorkform Alt-K Delete text to right of cursor 
Workform Alt-L Load block 
Workform Alt-M Move block 
Workform Alt-S Sort Directory (directory shows) 
Workform Alt-S Save block (cursor shows) 
GraphicJWorkform Alt-T Toggle touch screen and mouse 
Workform Alt-U Unmark block 
Graphic!Workform Alt-X Toggle Output Screen 
Graphic!Workform Ctrl-A Audio Menu 
Graphic!Workform Ctr~D Disk/Print Menu 
Graphic!Workform Ctrl-G Toggle between GUI/Text interface 
Graphic!Workform Ctr~L Load a Sequence 
Graphic!Workform Ctrl-Z DOS Shell (type EXIT to return) 
Graphic!Workform Ctr~N Start New Sequence 
Graphic!Workform Ctrl-P Path Menu 
Graphic!Workform Ctrl-Q Quit 
Graphic!Workform Ctrl-S Save a Sequence 
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80 Butn 5-5 80 Text type 16-1 

80 Butn Display 19-2 80 Video 5-5 

80 Butn Event 19-1 80Win 5-5 

80 Butn Method 19-1 80 Win event 17-1 

80 Butn Parameters 19-2 80 Win file 17-1 

80 Butn Speed 19-2 80 Win parameters 17-2 

80 Butn Type 19-1 80 Win speed 17-1 

80Menu 5-5 80 Win type 17-1 

80 Menu event 18-1 80Mode 5-4 

80 Menu method 18-1 Aaplay 20-3 

80 Menu parameters 18-2 Aaplay display 20-6 

80Menu type 18-1 Aaplay speed 20-6 

80 Mode event 15-1 Ask for label . 4-4 

80 Mode method 15-1 Audio 5-4 

80Mode type 15-1 Audio INT/IMA/IRQ - Configts.exe 28-6 

80 Text 5-4 Audio board type - Configts.exe 28-4 

80 Text display 16-1 Audio button 2-6 

80 Text event 16-1 Audio event 24-1 

80 Text file 16-1 Audio play 24-1 

80 Text parameters 16-2 Audio playasnc 24-2 

80 Text speed 16-1 Audio playtext 24-2 
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Index 

Audio quiet 24-2 Button method 12-2 

Audio record 24-2 Button parameters 12-2 

Audio type 24-1 Button type 12-1 

Autoexec.bat 28-9 CD-ROM 5-4 

Autooff- global 21-2 CD-ROM Event 26-1 

Autoset - global 21-2 CD-ROM Method 26-1 

Back off- global 21-3 CD-ROM Parameters 26-3 

Back on - global 21-3 CD-ROM Type 26-1 

Background color 10-1 CEO mode 20-4 

Bcolor 5-2 Chain 5-4 

Bcolor 10-1 Chain event 14-1 

Bcolor SP/DP 10-2 Chain file 14-1 

Bcolor color 10-2 Chain type 14-1 

Bcolor method 10-1 Chain wait for 14-1 

Bcolor parameters 10-2 Clear screen button 2-3 

Bcolortype 10-1 Color - global 21-2 

Block operations 3-3 Colors - Configts.exe 28-3 

Blocks of events 3-3 Common fields 4-1 

Button 5-3 Common fields - Label 4-1 

Button event 12-1 Common fields - Next 4-1 

Button file 12-1 Common fields -Type 4-1 
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Config.sys 28-8 Disk button - Save sequence 2-4 

Configts.exe 28-1 Disk button - View directory 2-4 

Contents - Configts.exe 28-7 Display 2-10 

Copy block 3-4 Display 4-4 

Creating From Menus 3-1 Distributable presentations 2-11 

Delay - global 21-2 Don't wait 4-3 

Delete block 3-4 Draw 5-3 

Delete file 2-4 Draw and 22-3 

Delete line 2-8 Draw background 22-3 

Demo Builder 2-11 Draw box 22-2 

Demo Builder 2-4 Draw circle 22-2 

Disk button 2-3 Draw event 22-1 

Disk button - Demo builder 2-3 Draw event method 22-1 

Disk button - Help 2-6 Draw event type 22-1 

Disk button - Load sequence 2-3 Draw filled box 22-2 

Disk button - New sequence 2-3 Draw filled circle 22-2 

Disk button - Print sequence 2-4 Draw line 22-1 

Disk button - Print sequence 2-4 Draw or 22-3 

Disk button - Quit 2-5 Draw parameters 22-2 

Disk button - Rename sequence 2-4 Draw parameters box 22-3 

Disk button - Save picture 2-4 Draw parameters circle 22-2 
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Draw parameters filled box 22-3 Event Controller - Play line 2-7 

Draw parameters filled circle 22-2 Event Controller - Play sequence 2-7 

Draw parameters line 22-2 Event Controller - Sp/DP 2-10 

Draw parameters set brush 22-3 Event Controller - Speed 2-10 

Draw set brush 22-2 Event Controller - Type 2-9 

Draw xor 22-4 Event Controller - Wait 2-11 

Dropshadow - global 21-2 Event Types 2-1 

Edit From Menus 3-2 Exit button 2-2 

Editing title events 9-3 External program button 2-6 

Event Controller 2-7 Fade in 20-2 

Event Controller - Delete line 2-8 Fade out 20-3 

Event Controller - Display 2-10 Failures 28-10 

Event Controller - File 2-9 File 2-9 

Event Controller - Insert line 2-8 Font - global 21-2 

Event Controller - Label 2-9 Function keys 1-8 

Event Controller - Line counter 2-8 GUI 2-2 

Event Controller - Line scroll bar 2-8 Gain - Configts.exe 28-4 

Event Controller - Menu size 2-7 Global event 21-1 

Event Controller - Method 2-9 Global file 21-1 

Event Controller - Next 2-11 Global method Pic_ceg 21-3 

Event Controller - Parameters 2-10 Global method Pic_pcx 21-3 
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Global method Pic_tga 21-4 Global parameters colors 21-4 

Global method Spr_clp 21-4 Global parameters delay 21-4 

Global method Spr_pcc 21-4 Global parameters drop shadow 21-5 

Global method Spr_ win 21-4 Global type 21-1 

Global method autooff 21-2 Global 5-3 

Global method autoset 21-2 Graphic user interface 2-2 

Global method back off 21-3 Help 2-5 

Global method back on 21-3 Help button 2-6 

Global method color 21-2 How to do line construction 2-12 

Global method delay 21-2 Insert line 2-8 

Global method dropshadow 21-2 Installation 1-4 

Global method font 21-2 Introduction 1-1 

Global method quick off 21-3 Joystick parameters - Configts.exe 28-3 

Global method quick on 21-3 Keyboard 1-6 

Global method reset all 21-2 Keyboard Entry 3-2 

Global method scale off 21-2 Label 2-9 

Global method scale on 21-2 Label 4-1 

Global method style 20 21-3 Label 4-2 

Global method style 30 21-3 Line counter 2-8 

Global method style TL 21-3 Line scroll bar 2-8 

Global parameters 21-4 Live video 20-4 

Mathematica, Inc. Index - 5 



Index 

Load block 3-4 Midi file 25-1 

Load palette 20-2 Midi method 25-2 

Load sequence 2-3 Midi type 25-1 

Making a sprite 7-3 Minimum disk space 1-4 

Making Events 2-13 Minimum memory 1-4 

Mark block 3-3 Mouse 1-8 

Mark block - end 3-3 Move block 3-4 

Mark block - start 3-3 Music 5-3 

Menu 5-3 Music event 23-1 

Menu Bar 2-2 Music file 23-1 

Menu conventions 2-1 Music freq 23-2 

Menu conventions terminology 2-1 Music freq file 23-3 

Menu Entry 3-1 Music kill 23-2 

Menu Event 11-1 Music loop 23-3 

Menu event method 11-1 Music method 23-2 

Menu event parameters 11-2 Music play 23-2 

Menu event type 11-1 Music parameters 23-3 

Menu position 2-7 Music playfile 23-2 

Method 2-9 Music speaker 23-2 

Midi 5-4 Music tone 23-2 

Midi event 25-1 Music tone file 23-2 
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Scrollup speed 20-6 Style TL - global 21-3 

Search- VCR 27-2 System 5-3 

Search - parameters - VCR 27-3 System event 13-1 

Setting environmental variables 1-7 System method 13-1 

Speaker 23-3 System parameters 13-1 

Speed 2-10, 4-4 System requirements 1-4 

Spr_clp - global 21-4 System type 13-1 

Spr_pcc - global 21-4 TGA files 21-3 

Spr_ win - global 21-4 TI key option - Configts.exe 28-5 

Sprite 5-2 Technical information 28-1 

Sprite event 7-1 Technical support 1-4 

Sprite event File 7-1 TEMPRA button 2-5 

Sprite event method 7-2 Text 5-2 

Sprite event parameters 7-2 Text based interface 3-1 

Sprite event type 7-1 Text color 8-2 

Sprite special features 7-3 Text event 8-1 

Sprite trails 7-3 Text event Display 8-2 

Starting the tutorial 29-6 Text event Parameters 8-2 

Stop- VCR 27-2 Text event SP/DP 8-2 

Style 2D - global 21-3 Text event Speed 8-2 

Style 3D- global 21-3 Text event file 8-1 
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Text event method 

Text event type 

Text framed 

Text height 

Text justify 

Text not framed 

Text not operate 

Text position 

Text width 

Ticker speed 

Time out 

Title 

Title box 

Title event 

Title method 

Title parameters 

Title type 

Touch screen - Configts.exe 

Trouble shooting 

Mathematica, Inc. 

8-1 

8-1 

8-3 

8-3 

8-3 

8-3 

8-3 

8-3 

8-3 

20-6 

4-3 

5-2 

2-3 

9-1 

9-1 

9-1 

9-1 

28-5 

28-7 

Tutorial 

Tutorial structure 

Type 

Type - 80 Butn 

Type - 80 Menu 

Type - 80 Text 

Type - 80 Video 

Type- 80 Win 

Type - 80Mode 

Type-Audio 

Type - Bcolor 

Type - Button 

Type - CD-ROM 

Type - Chain 

Type-Draw 

Type - Global 

Type-Menu 

Type - Screen 

Index 

29-1 

29-5 

2-9, 4-1, 5-1 

5-5 

5-5 

5-4 

5-5 

5-5 

5-4 

5-4 

5-3 

5-3 

5-4 

5-4 

5-3 

5-3 

5-3 

5-4 

5-3 

5-2 

Index - 9 



Index 

Type - Sprite 5-2 VCR parameters play segment 27-3 

Type - System 5-3 VCR parameters search 27-3 

Type -Text 5-2 VCR parameters wait for 27-4 

Type -Title 5-2 VCR port - Configts.exe 28-6 

Type-VCR 5-5 VCR type 27-1 

Unmark block 3-4 VCR type - Configts.exe 28-7 

Using the keyboard 1-8 Video 5-5 

Using the mouse 1-8 Video - Configts.exe 28-5 

Using the tutorial 29-5 Video SP/DP 20-6 

VCR 5-5 Video event 20-1 

VCR event 27-1 Video file 20-1 

VCR file 27-1 Video method Video black and white 20-6 

VCR method 27-2 Video method Video grab 20-5 

VCR method- pause 27-3 Video method Video inverse 20-6 

VCR method - play 27-2 Video method Video normal 20-5 

VCR method - play segment 27-3 Video method Video overlay 20-5 

VCR method - record 27-3 Video method Yid transparent color 20-6 

VCR method- rewind 27-2 Video method Video window 20-5 

VCR method - search 27-2 Video method CEG mode 20-5 

VCR method - stop 27-2 Video method aaplay 20-4 

VCR method - zero HMS 27-3 Video method fade in 20-3 
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Video method fade out 20-3 Wait - Ask for label 4-3 

Video method infowind 20-4 Wait - Don't wait 4-3 

Video method loadpal 20-2 Wait -Time out 4-3 

Video method resetpal 20-4 Wait - Wait for any key 4-3 

Video method save picture 20-2 Wait for and chain 14-2 

Video method scrollup 20-4 Wait for any key 4-3 

Video method set mode 20-2 Watson com port - Configts.exe 28-5 

Video method ticker 20-4 Welcome 1-1 

Video method vidlive 20-5 Windows 3.0/3.1 1-5 

Video method view port 20-3 Word button 2-5 

Video parameters 20-7 Work button 2-6 

Video parameters color cycling 20-6 Work.form 3-1 

Video parameters infowindow 20-8 Workform - create from menus 3-1 

Video parameters setmode 20-7 Workform - edit from the menus 3-2 

Video type 20-1 Workform - keyboard 3-2 

Videodisc type-Configts.exe 28-4 Zero HMS - VCR 27-3 

View directory 2-4 and 22-3 

Volume - Configts.exe 28-4 disk button - Delete file 2-4 

WIN files 21-4 or 22-3 

Wait 2-11 video input standard - Configts.exe 28-5 

Wait 4-3 xor 22-3 
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